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1.  Copyright Notice
© Copyright 2021 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
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JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

1.1.  Third party license information

This product includes OpenImageIO.
    
        BSD 3-Clause License

Copyright (c) 2008-present by Contributors to the OpenImageIO project. All Rights
 Reserved.

Redistribution and use in source and binary forms, with or without modification, are
 permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
 conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of
 conditions and the following disclaimer in the documentation and/or other materials
 provided with the distribution.

Neither the name of the copyright holder nor the names of its contributors may be used to
 endorse or promote products derived from this software without specific prior written
 permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
 EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
 OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
 SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
 INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
 PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
 INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
 LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
 OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

6



1Dynamic Content Essentials

This product includes OpenJDK.
 
The GNU General Public License (GPL)

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share
and change it.  By contrast, the GNU General Public License is intended to
guarantee your freedom to share and change free software--to make sure the
software is free for all its users.  This General Public License applies to
most of the Free Software Foundation's software and to any other program whose
authors commit to using it.  (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not price.  Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish),
that you receive source code or can get it if you want it, that you can change
the software or use pieces of it in new free programs; and that you know you
can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny
you these rights or to ask you to surrender the rights.  These restrictions
translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for
a fee, you must give the recipients all the rights that you have.  You must
make sure that they, too, receive or can get the source code.  And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2)
offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author's protection and ours, we want to make certain that
everyone understands that there is no warranty for this free software.  If the
software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.  We
wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification
follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice
placed by the copyright holder saying it may be distributed under the terms of
this General Public License.  The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any
derivative work under copyright law: that is to say, a work containing the
Program or a portion of it, either verbatim or with modifications and/or
translated into another language.  (Hereinafter, translation is included
without limitation in the term "modification".) Each licensee is addressed as
"you".

Activities other than copying, distribution and modification are not covered by
this License; they are outside its scope.  The act of running the Program is
not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by
running the Program).  Whether that is true depends on what the Program does.
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1. You may copy and distribute verbatim copies of the Program's source code as
you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License
and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may
at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus
forming a work based on the Program, and copy and distribute such modifications
or work under the terms of Section 1 above, provided that you also meet all of
these conditions:

    a) You must cause the modified files to carry prominent notices stating
    that you changed the files and the date of any change.

    b) You must cause any work that you distribute or publish, that in whole or
    in part contains or is derived from the Program or any part thereof, to be
    licensed as a whole at no charge to all third parties under the terms of
    this License.

    c) If the modified program normally reads commands interactively when run,
    you must cause it, when started running for such interactive use in the
    most ordinary way, to print or display an announcement including an
    appropriate copyright notice and a notice that there is no warranty (or
    else, saying that you provide a warranty) and that users may redistribute
    the program under these conditions, and telling the user how to view a copy
    of this License.  (Exception: if the Program itself is interactive but does
    not normally print such an announcement, your work based on the Program is
    not required to print an announcement.)

These requirements apply to the modified work as a whole.  If identifiable
sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate
works.  But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise the
right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the
Program (or with a work based on the Program) on a volume of a storage or
distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under
Section 2) in object code or executable form under the terms of Sections 1 and
2 above provided that you also do one of the following:

    a) Accompany it with the complete corresponding machine-readable source
    code, which must be distributed under the terms of Sections 1 and 2 above
    on a medium customarily used for software interchange; or,

    b) Accompany it with a written offer, valid for at least three years, to
    give any third party, for a charge no more than your cost of physically
    performing source distribution, a complete machine-readable copy of the
    corresponding source code, to be distributed under the terms of Sections 1
    and 2 above on a medium customarily used for software interchange; or,

    c) Accompany it with the information you received as to the offer to
    distribute corresponding source code.  (This alternative is allowed only
    for noncommercial distribution and only if you received the program in
    object code or executable form with such an offer, in accord with
    Subsection b above.)

The source code for a work means the preferred form of the work for making
modifications to it.  For an executable work, complete source code means all
the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation
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of the executable.  However, as a special exception, the source code
distributed need not include anything that is normally distributed (in either
source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the source
code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as
expressly provided under this License.  Any attempt otherwise to copy, modify,
sublicense or distribute the Program is void, and will automatically terminate
your rights under this License.  However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the Program
or its derivative works.  These actions are prohibited by law if you do not
accept this License.  Therefore, by modifying or distributing the Program (or
any work based on the Program), you indicate your acceptance of this License to
do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program),
the recipient automatically receives a license from the original licensor to
copy, distribute or modify the Program subject to these terms and conditions.
You may not impose any further restrictions on the recipients' exercise of the
rights granted herein.  You are not responsible for enforcing compliance by
third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues), conditions
are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the
conditions of this License.  If you cannot distribute so as to satisfy
simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all.
For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through
you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply and
the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or
other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software
distribution system, which is implemented by public license practices.  Many
people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot impose that
choice.

This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain
countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that
distribution is permitted only in or among countries not thus excluded.  In
such case, this License incorporates the limitation as if written in the body
of this License.

9. The Free Software Foundation may publish revised and/or new versions of the
General Public License from time to time.  Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems
or concerns.

Each version is given a distinguishing version number.  If the Program
specifies a version number of this License which applies to it and "any later
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version", you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation.
If the Program does not specify a version number of this License, you may
choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs
whose distribution conditions are different, write to the author to ask for
permission.  For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this.
Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible
use to the public, the best way to achieve this is to make it free software
which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program.  It is safest to attach
them to the start of each source file to most effectively convey the exclusion
of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.

    One line to give the program's name and a brief idea of what it does.

    Copyright (C) <year> <name of author>

    This program is free software; you can redistribute it and/or modify it
    under the terms of the GNU General Public License as published by the Free
    Software Foundation; either version 2 of the License, or (at your option)
    any later version.

    This program is distributed in the hope that it will be useful, but WITHOUT
    ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
    FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public License for
    more details.

    You should have received a copy of the GNU General Public License along
    with this program; if not, write to the Free Software Foundation, Inc.,
    51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it
starts in an interactive mode:

    Gnomovision version 69, Copyright (C) year name of author Gnomovision comes
    with ABSOLUTELY NO WARRANTY; for details type 'show w'.  This is free
    software, and you are welcome to redistribute it under certain conditions;
    type 'show c' for details.

The hypothetical commands 'show w' and 'show c' should show the appropriate
parts of the General Public License.  Of course, the commands you use may be
called something other than 'show w' and 'show c'; they could even be
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mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school,
if any, to sign a "copyright disclaimer" for the program, if necessary.  Here
is a sample; alter the names:

    Yoyodyne, Inc., hereby disclaims all copyright interest in the program
    'Gnomovision' (which makes passes at compilers) written by James Hacker.

    signature of Ty Coon, 1 April 1989

    Ty Coon, President of Vice

This General Public License does not permit incorporating your program into
proprietary programs.  If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library.  If this is what you want to do, use the GNU Library General Public
License instead of this License.

"CLASSPATH" EXCEPTION TO THE GPL

Certain source files distributed by Oracle America and/or its affiliates are
subject to the following clarification and special exception to the GPL, but
only where Oracle has expressly included in the particular source file's header
the words "Oracle designates this particular file as subject to the "Classpath"
exception as provided by Oracle in the LICENSE file that accompanied this code."

    Linking this library statically or dynamically with other modules is making
    a combined work based on this library.  Thus, the terms and conditions of
    the GNU General Public License cover the whole combination.

    As a special exception, the copyright holders of this library give you
    permission to link this library with independent modules to produce an
    executable, regardless of the license terms of these independent modules,
    and to copy and distribute the resulting executable under terms of your
    choice, provided that you also meet, for each linked independent module,
    the terms and conditions of the license of that module.  An independent
    module is a module which is not derived from or based on this library.  If
    you modify this library, you may extend this exception to your version of
    the library, but you are not obligated to do so.  If you do not wish to do
    so, delete this exception statement from your version.
    
------------------------------------------------------------

This product includes zlib.

 (C) 1995-2017 Jean-loup Gailly and Mark Adler

  This software is provided 'as-is', without any express or implied
  warranty.  In no event will the authors be held liable for any damages
  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,
  including commercial applications, and to alter it and redistribute it
  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not
     claim that you wrote the original software. If you use this software
     in a product, an acknowledgment in the product documentation would be
     appreciated but is not required.
  2. Altered source versions must be plainly marked as such, and must not be
     misrepresented as being the original software.
  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly        Mark Adler
  jloup@gzip.org          madler@alumni.caltech.edu
    
------------------------------------------------------------

This product includes curl.

      COPYRIGHT AND PERMISSION NOTICE

      Copyright (c) 1996 - 2020, Daniel Stenberg, <daniel@haxx.se>, and many
      contributors, see the THANKS file.
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      All rights reserved.

      Permission to use, copy, modify, and distribute this software for any purpose
      with or without fee is hereby granted, provided that the above copyright
      notice and this permission notice appear in all copies.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
      FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
      NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
      DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
      OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
      OR OTHER DEALINGS IN THE SOFTWARE.

      Except as contained in this notice, the name of a copyright holder shall not
      be used in advertising or otherwise to promote the sale, use or other dealings
      in this Software without prior written authorization of the copyright holder.
    
------------------------------------------------------------

This product includes patented technology.

      This product and use of this product is under license from Markzware
      under U.S. Patent No. 5,963,641.
    
------------------------------------------------------------

This product includes lzw-ab.

    Copyright (c) David Bryant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of Conifer Software nor the names of its contributors
      may be used to endorse or promote products derived from this software
      without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
    AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
    IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
    ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
    DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
    SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
    CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
    OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
    OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenJPEG.

        The copyright in this software is being made available under the 2-clauses
        BSD License, included below. This software may be subject to other third
        party and contributor rights, including patent rights, and no such rights
        are granted under this license.
       
        Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
        Copyright (c) 2002-2014, Professor Benoit Macq
        Copyright (c) 2003-2014, Antonin Descampe
        Copyright (c) 2003-2009, Francois-Olivier Devaux
        Copyright (c) 2005, Herve Drolon, FreeImage Team
        Copyright (c) 2002-2003, Yannick Verschueren
        Copyright (c) 2001-2003, David Janssens
        Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
        Copyright (c) 2012, CS Systemes d'Information, France
       
        All rights reserved.
       
        Redistribution and use in source and binary forms, with or without
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        modification, are permitted provided that the following conditions
        are met:
        1. Redistributions of source code must retain the above copyright
           notice, this list of conditions and the following disclaimer.
        2. Redistributions in binary form must reproduce the above copyright
           notice, this list of conditions and the following disclaimer in the
           documentation and/or other materials provided with the distribution.
       
        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
        AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
        IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
        ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
        LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
        CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
        SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
        INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
        CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
        ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
        POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes FreeType.

    Portions of this software are copyright (C) 2014 The FreeType
    Project (www.freetype.org) licensed under the Freetype License.
    All rights reserved.
    
------------------------------------------------------------

This product includes QtCopyDialog.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).
      All rights reserved.

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes QtMigration.

        Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
            of its contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."
    
------------------------------------------------------------
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This product includes QtService.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes QtSingleApplication.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies). All rights
 reserved.

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

    
------------------------------------------------------------

This product includes QtSql.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
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      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes Qt.

       The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).
     
------------------------------------------------------------

This product includes svgio.

 Copyright Oleg Maximenko 2014.
 Distributed under the Boost Software License, Version 1.0.
    
------------------------------------------------------------

This product includes appleseed.
The MIT License (MIT)

Copyright (c) 2010-2013 Francois Beaune, Jupiter Jazz Limited
Copyright (c) 2014-2019 The appleseedhq Organization

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.
    
------------------------------------------------------------

This product includes bcd.
        
    Copyright (c) 2017 Malik Boughida and Tamy Boubekeur. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors
   may be used to endorse or promote products derived from this software
   without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

You are under no obligation whatsoever to provide any bug fixes, patches, or
upgrades to the features, functionality or performance of the source code
("Enhancements") to anyone; however, if you choose to make your Enhancements
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available either publicly, or directly to the authors of this software, without
imposing a separate written license agreement for such Enhancements, then you
hereby grant the following license: a non-exclusive, royalty-free perpetual
license to install, use, modify, prepare derivative works, incorporate into
other computer software, distribute, and sublicense such enhancements or
derivative works thereof, in binary and source code form.
    
------------------------------------------------------------

This product includes glad.

        The MIT License (MIT)

Copyright (c) 2013-2018 David Herberth

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in
the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so,
subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes murmurhash3.
MurmurHash3 was written by Austin Appleby, and is placed in the public domain. The author
 hereby disclaims copyright to this source code.
------------------------------------------------------------

This product includes Botan.

      Copyright (C) 1999-2020 The Botan Authors
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are met:

      1. Redistributions of source code must retain the above copyright notice,
        this list of conditions, and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions, and the following disclaimer in the
        documentation and/or other materials provided with the distribution.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
      AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
      LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
      CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
      SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
      INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
      CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
      POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes pugixml.

      MIT License

      Copyright (c) 2006-2019 Arseny Kapoulkine

      Permission is hereby granted, free of charge, to any person
      obtaining a copy of this software and associated documentation
      files (the "Software"), to deal in the Software without
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      restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the
      Software is furnished to do so, subject to the following
      conditions:

      The above copyright notice and this permission notice shall be
      included in all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
      EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
      OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
      NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
      HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
      WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
      FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
      OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes GLEW: The OpenGL Extension Wrangler Library.

The OpenGL Extension Wrangler Library
Copyright (C) 2002-2007, Milan Ikits <milan ikits[]ieee org>
Copyright (C) 2002-2007, Marcelo E. Magallon <mmagallo[]debian org>
Copyright (C) 2002, Lev Povalahev
All rights reserved.

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, 
  this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, 
  this list of conditions and the following disclaimer in the documentation 
  and/or other materials provided with the distribution.
* The name of the author may be used to endorse or promote products 
  derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Mesa 3-D graphics library
Version:  7.0

Copyright (C) 1999-2007  Brian Paul   All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL
BRIAN PAUL BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2007 The Khronos Group Inc.
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Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and/or associated documentation files (the
"Materials"), to deal in the Materials without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Materials, and to
permit persons to whom the Materials are furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Materials.

THE MATERIALS ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
MATERIALS OR THE USE OR OTHER DEALINGS IN THE MATERIALS.
  
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (c) 1998-2017 The OpenSSL Project.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in
         the documentation and/or other materials provided with the
         distribution.

      3. All advertising materials mentioning features or use of this
         software must display the following acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

      4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
         endorse or promote products derived from this software without
         prior written permission. For written permission, please contact
         openssl-core@openssl.org.

      5. Products derived from this software may not be called "OpenSSL"
         nor may "OpenSSL" appear in their names without prior written
         permission of the OpenSSL Project.

      6. Redistributions of any form whatsoever must retain the following
         acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit (http://www.openssl.org/)"

      THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
      EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
      ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
      NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
      LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
      STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
      OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
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      modification, are permitted provided that the following conditions
      are met:
      1. Redistributions of source code must retain the copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.
      3. All advertising materials mentioning features or use of this software
         must display the following acknowledgement:
         "This product includes cryptographic software written by
         Eric Young (eay@cryptsoft.com)"
         The word 'cryptographic' can be left out if the rouines from the library
         being used are not cryptographic related :-).
      4. If you include any Windows specific code (or a derivative thereof) from
         the apps directory (application code) you must include an acknowledgement:
         "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

      THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
      ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
      FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
      DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
      OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
      OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
      SUCH DAMAGE.
    
------------------------------------------------------------

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
      All Rights Reserved.
      
      This software is based in part on the work of the Independent JPEG Group.
------------------------------------------------------------

This product includes tesseract.

  Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0
    
------------------------------------------------------------

This product includes cereal.

    Copyright (c) 2014, Randolph Voorhies, Shane Grant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:
        * Redistributions of source code must retain the above copyright
        notice, this list of conditions and the following disclaimer.
        * Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions and the following disclaimer in the
        documentation and/or other materials provided with the distribution.
        * Neither the name of cereal nor the
        names of its contributors may be used to endorse or promote products
        derived from this software without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL RANDOLPH VOORHIES OR SHANE GRANT BE LIABLE FOR ANY
    DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
    ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  
------------------------------------------------------------

This product includes robin-map.

    MIT License

19



1 Dynamic Content Essentials

    Copyright (c) 2017 Tessil

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in all
    copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
    SOFTWARE. 
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes libpng.

      Copyright (c) 2000-2002 Glenn Randers-Pehrson

      The PNG Reference Library is supplied "AS IS".  The Contributing Authors
      and Group 42, Inc. disclaim all warranties, expressed or implied,
      including, without limitation, the warranties of merchantability and of
      fitness for any purpose.  The Contributing Authors and Group 42, Inc.
      assume no liability for direct, indirect, incidental, special, exemplary,
      or consequential damages, which may result from the use of the PNG
      Reference Library, even if advised of the possibility of such damage.
      There is no warranty against interference with your enjoyment of the
      library or against infringement.  There is no warranty that our
      efforts or the library will fulfill any of your particular purposes
      or needs.  This library is provided with all faults, and the entire
      risk of satisfactory quality, performance, accuracy, and effort is with
      the user.
    
------------------------------------------------------------

This product includes OpenShadingLanguage.

BSD 3-Clause License

Copyright (c) 2009-2019 Sony Pictures Imageworks Inc., et al.
All Rights Reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:
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1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes libxml2.

    Copyright (C) 1998-2012 Daniel Veillard.  All Rights Reserved.

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is fur-
    nished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
    NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
    ColourKit Profiler Suite (www.colourprofiling.com)
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
    SWOP(R) are all registered trademarks of IDEAlliance(C).
    
------------------------------------------------------------

This product includes PANTONE Color Libraries.
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    PANTONE® and other Pantone trademarks are the property of Pantone LLC.
    Pantone is a wholly owned subsidiary of X-Rite, Incorporated.
    
------------------------------------------------------------

This product includes gSOAP.

      EXHIBIT B.
      
      Part of the software embedded in this product is gSOAP software.
      Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen,
 Genivia inc. All Rights Reserved.

      THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
 OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
 MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
 THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
 OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
 ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
 NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
 ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes llvm.

      University of Illinois/NCSA
      Open Source License

      Copyright (c) 2003-2019 University of Illinois at Urbana-Champaign.
      All rights reserved.

      Developed by:

          LLVM Team

          University of Illinois at Urbana-Champaign

          http://llvm.org

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal with
      the Software without restriction, including without limitation the rights to
      use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
      of the Software, and to permit persons to whom the Software is furnished to do
      so, subject to the following conditions:

          * Redistributions of source code must retain the above copyright notice,
            this list of conditions and the following disclaimers.
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          * Redistributions in binary form must reproduce the above copyright notice,
            this list of conditions and the following disclaimers in the
            documentation and/or other materials provided with the distribution.

          * Neither the names of the LLVM Team, University of Illinois at
            Urbana-Champaign, nor the names of its contributors may be used to
            endorse or promote products derived from this Software without specific
            prior written permission.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      CONTRIBUTORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS WITH THE
      SOFTWARE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (c) 1998-2017 The OpenSSL Project.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in
         the documentation and/or other materials provided with the
         distribution.

      3. All advertising materials mentioning features or use of this
         software must display the following acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

      4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
         endorse or promote products derived from this software without
         prior written permission. For written permission, please contact
         openssl-core@openssl.org.

      5. Products derived from this software may not be called "OpenSSL"
         nor may "OpenSSL" appear in their names without prior written
         permission of the OpenSSL Project.

      6. Redistributions of any form whatsoever must retain the following
         acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit (http://www.openssl.org/)"

      THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
      EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
      ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
      NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
      LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
      STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
      OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:
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      1. Redistributions of source code must retain the copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.
      3. All advertising materials mentioning features or use of this software
         must display the following acknowledgement:
         "This product includes cryptographic software written by
         Eric Young (eay@cryptsoft.com)"
         The word 'cryptographic' can be left out if the rouines from the library
         being used are not cryptographic related :-).
      4. If you include any Windows specific code (or a derivative thereof) from
         the apps directory (application code) you must include an acknowledgement:
         "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

      THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
      ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
      FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
      DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
      OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
      OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
      SUCH DAMAGE.
    
------------------------------------------------------------

This product includes xxHash.

    xxHash Library
    Copyright (c) 2012-2014, Yann Collet
    All rights reserved.

    Redistribution and use in source and binary forms, with or without modification,
    are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice, this
    list of conditions and the following disclaimer.

    * Redistributions in binary form must reproduce the above copyright notice, this
    list of conditions and the following disclaimer in the documentation and/or
    other materials provided with the distribution.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
    ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  
------------------------------------------------------------

This product includes lz4.

        Copyright (C) 2011-present, Yann Collet.

        BSD 2-Clause License (http://www.opensource.org/licenses/bsd-license.php)

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:

            * Redistributions of source code must retain the above copyright
        notice, this list of conditions and the following disclaimer.
            * Redistributions in binary form must reproduce the above
        copyright notice, this list of conditions and the following disclaimer
        in the documentation and/or other materials provided with the
        distribution.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
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        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes ICU.

      Copyright (c) 1995-2014 International Business Machines Corporation and others
      All rights reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal in the
      Software without restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
      to permit persons to whom the Software is furnished to do so, provided that the
      above copyright notice(s) and this permission notice appear in all copies of the
      Software and that both the above copyright notice(s) and this permission notice
      appear in supporting documentation.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
      SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
      CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
      WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
      CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
      WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes JBIG2Lib.

    Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
    
------------------------------------------------------------

This product includes PCRE.

  Copyright (c) 1997-2016 University of Cambridge
  All rights reserved.

  Copyright(c) 2010-2016 Zoltan Herczeg
  All rights reserved.

  Copyright(c) 2009-2016 Zoltan Herczeg
  All rights reserved.

  Redistribution and use in source and binary forms, with or without
  modification, are permitted provided that the following conditions are met:

      * Redistributions of source code must retain the above copyright notice,
        this list of conditions and the following disclaimer.

      * Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions and the following disclaimer in the
        documentation and/or other materials provided with the distribution.

      * Neither the name of the University of Cambridge nor the names of any
        contributors may be used to endorse or promote products derived from this
        software without specific prior written permission.

  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
  AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
  IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
  ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
  LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
  CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
  SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
  INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
  CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
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  ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
  POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes QtSvg.

      The Qt Toolkit is Copyright (C) 2015 Digia Plc and/or its subsidiary(-ies).
    
------------------------------------------------------------

This product includes Little CMS.

    Little CMS
    Copyright (c) 1998-2011 Marti Maria Saguer

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes ZXing C++ Library.

      --------------------------------------------------------------------------------
      NOTICES FOR C++ Big Integer Library
      --------------------------------------------------------------------------------

      I, Matt McCutchen, the sole author of the original Big Integer
      Library, waive my copyright to it, placing it in the public domain.
      The library comes with absolutely no warranty.
  
------------------------------------------------------------

This product includes XercesC.

    NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this
 case for the Apache Xerces distribution.

    This product includes software developed by
    The Apache Software Foundation (http://www.apache.org/).

    Portions of this software were originally based on the following:
     - software copyright (c) 1999, IBM Corporation., http://www.ibm.com.
    
------------------------------------------------------------

This product includes leptonica.

 -  Copyright (C) 2001-2016 Leptonica.  All rights reserved.
 -
 -  Redistribution and use in source and binary forms, with or without
 -  modification, are permitted provided that the following conditions
 -  are met:
 -  1. Redistributions of source code must retain the above copyright
 -     notice, this list of conditions and the following disclaimer.
 -  2. Redistributions in binary form must reproduce the above
 -     copyright notice, this list of conditions and the following
 -     disclaimer in the documentation and/or other materials
 -     provided with the distribution.
 -
 -  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
 -  ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
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 -  LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
 -  A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL ANY
 -  CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
 -  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
 -  PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
 -  PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
 -  OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
 -  NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
 -  SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes FCollada.

      Copyright 2006 Feeling Software. All rights reserved.

      Copyright 2005-2006 Feeling Software and
      Copyright 2005-2006 Autodesk Media Entertainment.

      Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy
      of this software and associated documentation files (the "Software"), to deal
      in the Software without restriction, including without limitation the rights
      to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the Software is fur-
      nished to do so, subject to the following conditions:

      The above copyright notice and this permission notice shall be included in
      all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
      NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
      THE SOFTWARE.
    
------------------------------------------------------------

This product includes tessdata.

 Inc. Licensed under the Apache License, Version 2.0
    
------------------------------------------------------------

This product includes XMP Toolkit.

      Copyright (c) 1999 - 2010, Adobe Systems Incorporated
      All rights reserved.

      Redistribution and use in source and binary forms, with or
      without modification, are permitted provided that the following
      conditions are met:

      * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
      * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the documentation
      and/or other materials provided with the distribution.
      * Neither the name of Adobe Systems Incorporated, nor the names of its
      contributors may be used to endorse or promote products derived from this
      software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
      CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
      EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
      PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
      PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
      LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
      NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
      SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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------------------------------------------------------------

This product includes openexr.

      Copyright Contributors to the OpenEXR Project. All rights reserved.

      Redistribution and use in source and binary forms, with or without modification,
 are permitted provided that the following conditions are met:

          * Redistributions of source code must retain the above copyright notice, this
 list of conditions and the following disclaimer.

          * Redistributions in binary form must reproduce the above copyright notice,
 this list of conditions and the following disclaimer 
            in the documentation and/or other materials provided with the distribution.

          * Neither the name of the copyright holder nor the names of its contributors
 may be used to endorse or promote products derived from this software 
            without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
 EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
      THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
 DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS 
      BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
      GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
 CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
 THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.    
    
------------------------------------------------------------

This product includes Bonjour SDK.

   Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.
  
   Redistribution and use in source and binary forms, with or without 
   modification, are permitted provided that the following conditions are met:
  
   1.  Redistributions of source code must retain the above copyright notice, 
       this list of conditions and the following disclaimer. 
   2.  Redistributions in binary form must reproduce the above copyright notice, 
       this list of conditions and the following disclaimer in the documentation 
       and/or other materials provided with the distribution. 
   3.  Neither the name of Apple Computer, Inc. ("Apple") nor the names of its 
       contributors may be used to endorse or promote products derived from this 
       software without specific prior written permission. 
  
   THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY 
   EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
   WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
   DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
   DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
   (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
   LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
   ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
   (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
   SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------
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2.  About Dynamic Content Essentials
The ‘Dynamic Content Essentials for Illustrator’ bundle offers basic Dynamic Content functionality.

It combines the following plug-ins:

• Dynamic Content on page 30

• Dynamic Art on page 104

• Dynamic Barcodes on page 116 in an unlicensed mode. See Using Dynamic Barcodes in Unlicensed
Mode on page 118
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3.  Dynamic Content

3.1.  Welcome to the Dynamic Content User Guide

Welcome to the Esko Dynamic Content user documentation. This User Guide will provide you with all
the knowledge and skills you need to integrate the Dynamic Content plug-in into your daily workflow.

3.2.  Getting Started

To introduce you to the concept of Dynamic Content, follow the five simple steps below to create
dynamic links between an Adobe Illustrator document and a very basic, non-IPC simple XML file.

1. In the Sample Files folder on the installation disk image you will find an Illustrator file called:
Esko Connect More.ai. Open the sample file with Adobe Illustrator and:
a) note the two text objects that are present in the design: Link Statement1 here and Link

Statement2 here.
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b) choose Windows > Esko > Dynamic Content > Dynamic Content.

The Dynamic Content palette appears.
 

 
2. Generate a dynamic link with an XML file:

a)
click the Add XML file… button.

b) browse for the GettingStarted.xml file included on the Sample Files folder on the
installation disk image.

3. Link the text objects with the XML elements:
a) select the text box containing Link with Statement1.
b) in the Dynamic Content palette, expand GettingStarted.xml and the body entry, and select

the entry Statement1.
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c) Click the Make Dynamic Object button.
d) Repeat for Statement 2.

4. Change the text style using the normal Illustrator text tools:

After linking an XML element to a text object, its contents are protected from accidental changes,
but you can still select text with the text tool and change its style (e.g. assign another typeface or
text color).

5. Change the XML file.

To experience the dynamic behavior of the link that you established between the Illustrator text
object and the XML file, go ahead and:

a) open the GettingStarted.xml file in a text editor of your choice (e.g. TextEdit on Mac OS, or
Notepad on Windows).

b) change the content of the first text statement. For example, change Connect to Esko into
Connect with Esko. If you have not changed your preferences from the default, the plug-in will
detect your changes to the linked XML file, and it will ask you to update the artwork.
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3.3.  Dynamic Content Basics

In this section, you will learn the basic concepts of the Dynamic Content plug-in, and experience a
simple, typical workflow that guides you through your first steps in Dynamic Content.

3.3.1.  Introducing Dynamic Content

Esko's Dynamic Content for Adobe
®

 Illustrator
®

 brings the power of XML-based automation to Adobe
®

Illustrator
®

 CS5, CS5.1, CS6 and CS7 on Mac and Windows.

Why Dynamic Content?
Esko Dynamic Content allows packaging designers to add externally maintained content elements such
as legal copy or nutritional information to a packaging design. This solves an increasingly common
problem in the designer's day to day work: human error in copied content.

The ever growing number of stock keeping units that are brought onto the market by brand owners has
resulted in an explosive growth in the volume of artwork that needs to be created for all the packaging
of each unit. At the same time, the designs themselves become more and more complex in their
competition for the consumer's attention.

Many designs share pieces of content. Some content is mandatory, required by regulatory instances
such as the FDA, EMEA, or national bodies. Other content simply recurs on different variants of a
shared design.

The end result is the same: an increasing number of human interactions, often of the "copy-paste"
type, that at the same time increases the risk of errors slipping into the design. Errors in artwork are
wasteful, generating rework, delays in product launches and sometimes even requiring product recalls.
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Benefits of Using Dynamic Content
The Dynamic Content plug-in helps automate the insertion and updating of externally maintained
content into a design. This prevents a number of common problems, and it saves valuable production
time by eliminating repetitive manual tasks.

Some typical problems prevented by a Dynamic Content workflow:

• Typing errors;
• Wrong versions of copy text or barcodes are used in the final design;
• Cut-and-paste errors (e.g. when copy text is provided in a Microsoft Word document or PDF, and the

designer has to manually copy this into the Illustrator document);
• Text overflows;
• Shared elements on design variants are not synchronised.

Because Dynamic Content allows you to keep this mandatory or shared content separated from the
Illustrator document, it also eliminates repetitive and time consuming updates: simply modify the
external XML file to update the text, barcodes, and nutrition tables on the design. Review cycles have
never been this easy.

A Typical Workflow in Dynamic Content
A typical Dynamic Content-based design workflow includes an exchange of information between brand
owners and designers. Often, the content to be used in a design will change multiple times during the
design and production process, and it is in these cases that Dynamic Content will prove its worth.
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A sample workflow for the use of Dynamic Content could be the following:

Stage Description

1 The brand owner’s marketing department draws up the text that needs to appear on the
packaging design. The text is entered into a PDF form or a content management system,
which can export an XML file.

2 The brand owner sends the PDF form or XML file containing the text to the designer.

3 The designer produces a packaging design in Adobe Illustrator and links the text elements
from the XML file to text objects in the Illustrator template. In the GS1 workflow, the
designer can generate the "Response" XML and send it back to the brand owner. This
Response message tells the brand owner what items were used in the artwork and how
many times.

4 Later, the brand owner makes changes to the text, produces a new XML file and sends this
to the designer.

5 The designer replaces the original XML file on his disk with the new version. Dynamic
Content automatically detects the changes, and immediately alerts the designer. It clearly
shows exactly what has changed, and where.

6 Based on the alerts displayed in Dynamic Content, the designer can very quickly accept
automatically updated text, or make any required formatting changes. There is no need for
copying, pasting, or any other manual and error-prone operations, and Dynamic Content
alerts the designer to problems such as text overflow.

7 Thanks to Dynamic Content, stages 4 - 6 can occur repeatedly without losing time or
introducing errors.

XML Basics
XML stands for Extensible Markup Language, and it is a markup language similar to HTML. However,
where HTML describes the layout of a web page, XML markup describes the contents and the structure
of a document.

Below is an example of a basic XML document:

<?xml version="1.0" encoding="UTF-8"?> 
<body> 
<p> This is a very cool product! </p> 
</body>

XML documents are often used to exchange data or textual content.

In the context of the Dynamic Content plug-in, XML is a useful format because:

• it separates content- the text itself- from layout and presentation, which will be defined by
Illustrator text objects.

• it describes and contains the structure of the text that must be used on a design.
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For more information on the XML format, please refer to the Appendix “An Introduction to XML”.

3.3.2.  Step 1: Create an Adobe Illustrator Template

Before you can start linking XML-sourced content into your work, you need to prepare a design in
Adobe Illustrator.

We will refer to the Illustrator design as the "template", which will later hold the placeholder text objects
in which you will later insert text from an XML file.

Dynamic Content allows you to use your complete Illustrator toolset as usual:

1. Create a design in Adobe Illustrator.
2. Create Text objects using the Illustrator tools, including:

• the Type Tool
• the Area Type Tool
• the Type on a Path Tool
• the Vertical Type Tool
• the Vertical Area Type Tool
• the Vertical Type on a Path Tool
• Threaded text

Note:

Dynamic Content also supports Right-To-Left text in Middle-Eastern languages.

3. Create nutrition tables using the Esko Dynamic Tables plug-in, if required for the design.
4. Create barcodes using the Esko Dynamic Barcodes plug-in, if required for the design.
5. Add the text objects, tables, barcodes, Illustrator symbols, and external images to the Dynamic

Art palette. If you do, it will be much easier for the person linking the XML content to find linkable
objects. Proceed as follows:
a) Choose Window > Esko > Dynamic Art to display the Dynamic Art palette.
b) Select all the Dynamic Art objects you created in the previous steps, and click New Dynamic Art

on the Dynamic Art palette.
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Dynamic Art automatically fills any empty text objects with Lorem ipsum text.

Note:

Dynamic Content will apply the last style in the Illustrator text object to any text that is linked from
the XML file. For objects that contain different styles or formats, only the last style will be retained.

If this is a multilingual product and you will be using variable locale mapping (initially configured in the
Properties dialog for a text object on the Dynamic Art palette; see the Dynamic Art User Guide for more
information), set the locale variables before adding the XML content file.

Map Locale Variables (only for IPC XML standard)
If you are using locale variables to define the language of the text objects’ content, define the variables
before adding the XML content file.

1. On the Dynamic Content palette’s fly-out menu, choose Variable Locale Mapping.
2. In the Locale Variable Mapping dialog box, click in the Language column next to the first variable

you defined and choose the desired language from the list. Do the same thing in the Country
column and click OK. Repeat for the other variables.
 

 

When you auto link, Dynamic Content compares the locale of an XML element to the value of the locale
variable of a text object, and if they match, it fills the text object with content from the XML element.

3.3.3.  Step 2: Link the XML file to the Illustrator document

Once your basic design or template is complete, you have to link the XML file with your source text to
the Illustrator template. You can do this automatically or manually.

Automatic linking is possible if there is only one corresponding entry in the XML file for each type of
dynamic object in the Illustrator document. You must link manually if there are more entries for each
type of dynamic objects in the XML file than there are placeholders in the Illustrator document.

Using the option Display Options > Highlight Dynamic Objects from the fly-out menu, you can add a
highlight frame to the dynamic object. This highlight frame will display additional information about the
dynamic object. See Highlighting the dynamic object on page 41
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Automatic linking
To automatically link the dynamic items in the Illustrator document to the elements defined in the XML
file, do the following:

1. Choose Window > Esko > Dynamic Content.
The Dynamic Content palette appears.

2. Choose Add XML... from the fly-out menu of the Dynamic Content palette.
The Open XML File dialog box appears.

3. Browse to the XML file you want to link to the design.
4. Select the XML file and click Open.

The XML file is now linked to the Illustrator document, and the XML file appears in the Dynamic
Content palette.

5. If the data in the XML file and the number and type of dynamic objects match, Illustrator will ask if
you want to link all the dynamic items.
Click OK to start the auto link process.

 

 
6. Click OK again to start the auto link.

 

 
7. Illustrator will auto link as many items as it can. A status dialog may appear if some items could not

be linked. Click OK to dismiss it.
 

 

After the auto link completes, review the status in the Dynamic Art palette. Items successfully linked
will have an XML label next to them. You will have to manually link those items that did not automatically
link..
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Resuming automatic linking
If you canceled an auto link, you can resume it by doing the following:

1. Select the text items to auto link to the XML file you have already added to the Illustrator document.
2. In the Dynamic Art palette’s menu, click Auto Link.

 

 
3. Illustrator will ask you to confirm the auto link. Click OK to continue.

 

 
4. Illustrator will auto link as many items as it can. A status dialog may appear if some items could not

be linked. Click OK to dismiss it.

After the auto link completes, review the status in the Dynamic Art palette. Items successfully linked
will have an XML label next to them. You will have to manually link those items that did not automatically
link.

Manual linking
To manually link the data in the XML file to the dynamic object placeholders, do the following:

1. Choose Window > Esko > Dynamic Content.
The Dynamic Content palette appears.

2. Choose Add XML... from the fly-out menu of the Dynamic Content palette.
The Open XML File dialog box appears.

3. Browse to the XML file you want to link to the design.
4. Select the XML file and click Open.

The XML file is now linked to the Illustrator document, and the XML file appears in the Dynamic
Content palette.
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Link XML Elements to Illustrator Objects
In this step, you link the XML elements from the source file to the individual Illustrator text objects,
barcodes and nutrition tables in the design.

Before you can execute this task, you must have linked an XML file to the Illustrator design. This means
that at least one XML file must show up in the Dynamic Content palette.

1. In the Dynamic Art palette, select the object you want to link to XML content: either click on the far
right of the object’s entry in the palette, or click Select and zoom to object.

Depending on the type of XML file you linked to the Illustrator document, you can work either in
Smart View or Advanced View. For GS1 and IPC XML files, the default is Smart View. Other XML
flavors can only use the Advanced View. The steps below assume you are using the Smart View on
an IPC XML file.

Depending on the type of object you selected in the Dynamic Art palette, the Dynamic Content
palette now displays only those elements from the XML file that can be linked to your selected
object.

2.
In the Dynamic Content palette, click on the Make Dynamic Object icon  corresponding to the
XML element that contains the text you want to replace in the Illustrator template.
Alternatively, you can use the keyboard shortcut Shift+Alt+9 on Windows or Shift+Command
+9 on Mac OS to attach the element to the Illustrator object.

The object on the Illustrator canvas is now a dynamic object - its text contents are dynamically

retrieved from the linked XML file. This is indicated in the Dynamic Content palette by the 
status icon.
 

 

Linking XML Elements to Illustrator Objects in the Advanced View

In this step, you link the XML elements from the source file to the individual Illustrator text objects,
barcodes and nutrition tables in the design.

Before you can execute this task, you must have linked an XML file to the Illustrator design. This means
that at least one XML file must show up in the Dynamic Content palette.
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Depending on the type of XML file you linked to the Illustrator document, you can work either in Smart
View or Advanced View. For GS1 and IPC XML files, the default is Smart View. Other XML flavors can only
use the Advanced View.

The steps below assume you are using the Advanced View.

1. In the Dynamic Art palette, select the object you want to link to XML content: either click on the far
right of the object entry in the palette, or click Select and zoom to object.

2. In the Dynamic Content palette, select the XML element that contains the text you want to replace
in the Illustrator template.

3. Select the corresponding object in your Illustrator design.

Note:  If you added the dummy objects to the Dynamic Art palette, the fastest way to work is to
select the Dynamic Art object in the list in the Dynamic Art palette, and then click Select and zoom
to object.

4.
Click Make Dynamic Object  in the Dynamic Content palette.
Alternatively, you can use the keyboard shortcut Shift+Alt+9 on Windows or Shift+Command
+9 on Mac OS to attach the element to the Illustrator object.

The Illustrator objects have been replaced with a Dynamic Object. Also, the status icon  appears in
the XML tree indicating that the element has been attached to an object in the Illustrator document.
 

 

Highlighting the dynamic object
Using the option Display Options > Highlight Dynamic Objects from the fly-out menu, you can add a
highlight frame to the dynamic object.

The color of the highlight frame depends on the XML source and is set in the XML Info dialog. See
Viewing XML Information on page 60
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The highlight frame header shows the link source: the Copy Element Name, Instance ID and Locale ID
in GS1 mode, or the Copy Element Name and Locale in IPC mode.

 

 

When the dynamic object contains two link sources, both are shown. In case it contains more than two,
the first link is shown and the number of additional links is shown.

 

 

The highlight frame can also indicate if a dynamic object is split or threaded. Split text is indicated on
the frame bottom (e.g. [1/2] and [2/2]), while threaded text is indicated on top, next to the link (see
example underneath).

 

 

3.3.4.  Step 3: Work with Changes in XML Content

Once the XML file has been linked to the Illustrator document, Dynamic Content will automatically
notify you of any changes that are made to the contents of the XML file in external applications.

When changes in the XML file are detected, the XML Changed dialog box appears, and you will be given
two options. You can either:

• Update the Illustrator document now; or
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• Cancel the update, in which case you will have to deal with the changed content later. The XML Not

Up to Date  status icon then appears next to the XML file in the XML Tree until you resolve the
version difference.

Note:  Following the instructions below, you will make manual changes to the XML content. In a real-
world production scenario, the changes will of course be induced by the brand owner, for example by
sending you a new version of the XML file.

1. Open the XML file you used earlier in a text or XML editor and change the text of the XML element
you attached to Illustrator text.

2. Save the XML file.
Make sure that you overwrite the file that you linked to the Illustrator design.

3. Open the Illustrator design, or switch back to Illustrator if you still have it open.
The XML Changed dialog box appears.
 

 
4. Click Update Now.

The Dynamic Objects in the Illustrator document are updated to reflect the changes in the XML file.

The linked elements in which a change was detected are marked with a Check Alert .
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5. Select the XML element in the tree that was changed and click Zoom and Select Art  in the

Dynamic Content palette.
The corresponding Dynamic Object on the Illustrator artboard is now selected, the view centers on
the object and Illustrator zooms into it.

6. Check whether the changes in content have caused any design problems such as text overflow

or faulty text styling (highlighted by a special Check Alert ), or other issues and correct them if
necessary.

7. Click Clear Check Alert   to remove the Check Alert from the selected element, indicating that
you have checked this update and that the design is once more error-free.

3.3.5.  Creating Design Variants (Line Extensions)

A typical use case for the Dynamic Content plug-in in the packaging industry is creating variants of a
design, sometimes called "line extensions".

For example, based on an original packaging design, you can create variants for different language
groups, or for different sizes. To create a design variant:

1. Create the base design by linking XML elements to the Illustrator objects using Dynamic Content.
2. Make a copy of the XML file you used in the original design and make any required changes in this

copy.
For example, you could change the text of the element containing the package quantity (e.g. for a
box of diapers, change the CopyElement "Quantity" from 36 to 72).

3. Re-link the new XML file, which has the same structure but different contents, to the Illustrator
design.

4. Save the Illustrator file as a new design variant file.
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Tip:  You can copy and paste dynamic objects between different Illustrator files as long as you make
sure that the same XML file is linked to them. After copying an object, you can use the Relink XML
feature to link the copied content to the variant XML file.

XML Linking Strategies for Design Variants
There are three main linking strategies that you can use for working with design variants or line
extensions: one XML file per stock keeping unit (SKU), multiple XML files for each SKU, and a single
XML file for multiple SKUs.

Overview
 

 

The strategies in detail

Strategy Description

One-to-one

One XML file per SKU

Each design variant is linked to an external XML
file that contains all the information. This is the
least complex way to handle design variants, but
it requires the brand owner to provide common
data in each of the XML files (repetitions of the
same data in different XML files).

Many-to-one

Multiple XML files per SKU

At least two XML files are linked to every design
variant: one file unique to that variant, and
one file that contains all common elements.
While this eliminates the duplication of data,
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Strategy Description

this situation can potentially be dicult and
confusing for operators to manage.

One-to-many

One XML file for all SKUs

In this workflow, a single XML file would contain
all information for all extensions of a line. The
advantage here is that the common data is stored
only once.

3.3.6.  Relink text elements to different languages

If you have a multilingual XML file, you can relink linked GS1 or IPC Copy elements to different languages
contained in the XML content file.

To relink linked GS1 or IPC Copy elements, do the following:

1. Select one or more elements to relink.
2. On the fly-out menu of the Dynamic Content palette, choose Relink Selected Dynamic Objects.
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3. In the Relink Selected Dynamic Objects dialog, select Target Language and choose the new
language setting from the drop-down list. Only those languages available in the XML content file
appear in the list.
 

 
4. Click OK to relink the elements.

The elements change to the language you specified.

3.4.  Viewing XML Content in Dynamic Content

In this section you will learn how to interpret all the information displayed in the Dynamic Content
palette, including how to manipulate an XML tree structure, what each of the icons and alerts means,
and what the functions are of the buttons on the palette.

3.4.1.  The Dynamic Content Palette

The main work area of Dynamic Content is the Dynamic Content palette. The palette contains
information about the XML files that have been linked to the current Illustrator document. The Dynamic
Content palette can operate in two view modes: Smart View and Advanced View. Much like any other
Illustrator palette, Dynamic Content also has a fly-out menu.

Smart View
The Smart View of the Dynamic Content palette provides a simple-to-use view on the linked XML files.
It hides much of the underlying XML and its complexity, and is ideal for quickly linking XML elements to
placeholder objects.

Note:  Smart View only works on GS1 and IPC XML files. When you add an IPC XML file to a document,
Smart View is automatically enabled.
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Components of the Smart View:

• A. The Find box, which works much like Spotlight on the Mac - simply type in (part of) a word to
filter the list of elements “as you type”. Only the available XML files are searched and only matching

elements are displayed. The Find function is case-insensitive. Click the Reset Search  button to
remove the filter.

• B. The Element List, which displays the XML elements that can be linked to your current selection in
the Illustrator document. If you have a text object selected, only CopyElements will be listed, but if
you select a barcode created with Dynamic Barcodes, only the BarCode elements in the GS1 or IPC
XML will be listed.

• C. The View buttons, which allow you to switch between Smart View and Advanced View.

Advanced View
The Advanced View of the Dynamic Content palette consists of two panes, surrounded by a top and
bottom row of buttons. In the Advanced View, you can make full use of the advanced features of
Dynamic Content, and work with any type of XML.

Two panes
For ease of reference, the top pane is called the XML Tree and displays the structure of the XML file.
The Preview pane at the bottom can be hidden if desired, and resized to fit more or fewer XML content.
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Components of the palette
• A. The Find box, which works much like Spotlight on the Mac - simply type in (part of) a word to

filter the list of elements “as you type”. In Advanced View, this searches case-insensitively in every
element in all available XML files. All the elements are displayed; use the Next and Previous buttons

to jump between matching elements. Click the Reset Search  button to remove the filter.
• B. The top toolbar, which offers quick access to the Reflow Text, Synchronize, Add XML and Add

Filter commands.
• C. The Filter toolbar, which allows you to filter the content displayed in the XML Tree pane.
• D. The XML Tree, which displays the content found in the linked XML file(s).
• E. The Preview pane, which displays the text content of the selected element in the XML Tree.
• F. The bottom toolbar, which offers quick access to the Clear Check Alert, Select and Zoom to

Dynamic Object, Insert Element in Dynamic Object and Make Dynamic Object commands.
• G. The View buttons, which allow you to switch between Smart View and Advanced View.

Understanding the XML Tree
The XML tree pane contains a view on the internal structure of the linked XML file(s). Every node in the
file (including elements and attributes) is visualized in the XML tree as an entry that can be expanded or
collapsed.

Which nodes are displayed?
The XML tree displays:

• the XML file(s) linked to the Illustrator design, as the root node(s) in the XML tree;
• the XML elements in each XML file, as expandable entries under the root node (XML file);
• any XML attributes for every XML element, preceded by a “bullet” symbol. Attributes can be hidden

from the XML Tree to simplify the view by choosing Hide Attributes from the fly-out menu.
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Note:

The structure displayed in the XML tree can be simplified by applying one or more filters. See Filter
options for the XML tree for more information.

Icons in the XML Tree

The XML tree displays different types of objects: one or more linked XML files, as well as the XML
elements, XML attributes, and XML text elements that these files contain. Each of these objects is
represented by an entry in the tree structure, and each type of object has its own icon.

Table: XML tree icons

The following table lists all the icons displayed in the XML tree structure view of the Dynamic Content
palette.

Icon Description

 , XML file; not changed in Dynamic Content / changed in Dynamic Content

 , 
Read-only XML file; not changed in Dynamic Content / changed in Dynamic Content

 , XML node element containing text inside; placed (linked) / not placed

 , XML node element directly containing text; placed (linked) / not placed

XML node element, which contains no text inside

XML attribute

XML text element (has no icon)
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Element Status Icons

The elements in the XML tree can be marked with one or more status icons, that show whether
the content has been changed inside Dynamic Content, or externally in the XML file. The icons are
displayed on the right side of the elements themselves, and in two columns: primary and secondary
icons.

Table: Primary status icons

The following table lists all the status indicator icons displayed in the XML tree structure view:

Icon Description

The contents of this XML element have been changed in the source XML file.

Note:

When at least one XML element in the file is marked with this status icon, the icon
also appears next to the XML file name in the Dynamic Content palette.

The contents of this XML element have been changed in the source XML file to
such an extent that some text styling or additional formatting that was applied
by the user (e.g. color, size, font, soft returns, hyphens or spaces) could not be
retained.

Note:

When at least one XML element in the file is marked with this status icon, the icon
also appears next to the XML file name in the Dynamic Content palette.

The contents of this element have been changed in the Dynamic Content plug-in.
This status icon disappears when you save or close the XML file.

Note:

When at least one XML element in the file is marked with this status icon, the icon
also appears next to the XML file name in the Dynamic Content palette.

The element has a complex status, combining two types of changes:

• The contents of this XML element have been changed in the source XML file.

• The contents of this element have been changed in the Dynamic Content plug-
in. This status icon disappears when you save or close the XML file.

The element has a complex status, combining two types of changes:

• The contents of this XML element have been changed in the source XML file to
such an extent that some text styling or additional formatting that was applied
by the user (e.g. color, size, font, soft returns, hyphens or spaces) could not be
retained.
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Icon Description

• The contents of this element have been changed in the Dynamic Content plug-
in. This status icon disappears when you save or close the XML file.

Table: Secondary status icons

Icon Description

The XML file was changed externally and has not yet been synchronized with the
document.

The XML element itself is not linked, but at least one of its child elements is. Click
to select all objects linked to children.

The XML element is linked to a Dynamic Object. Click to select linked object, Alt
+Click to select and zoom.

The XML element is linked to a Dynamic Object and the attached text object has
text overflow. Click to select linked object, Alt+Click to select and zoom.

The XML element is linked to a Dynamic Object and the object is selected. The
background color corresponds to the selection color of the corresponding layer. Alt
+Click to zoom.

The same as above and the object has text overflow. Alt+Click to zoom.

, 
The XML element is linked / not linked and has at least one child which is linked and
selected.

The same as above and the object has text overflow.

Indication of the number of occurrences

In a GS1 XML file, elements can contain the element "expectedNumberOfOccurrences", which indicates
how many times a particular unique element (identified by the Copy Element Type, Locale ID and
Instance ID) should occur in the artwork.

The Advanced View gives an indication of the number of occurences. It will show the difference
between the expected number of occurrences and the actual amount, or a check if these numbers are
the same. If the Show nominal values for the number of occurrences option is enabled in the Dynamic
Content Preferences, the actual number is shown instead. See Dynamic Content Preferences on page
94

Next to the number, a color code is used as well:

• If the actual number is lower than the expected number, the number is shown in red.
• If the actual number is the same as the expected number, the number is shown in green.
• If the actual number is higher than the expected number, the number is shown in orange.
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The Preview Pane

At the bottom of the Dynamic Content palette is the Preview pane. The Preview pane displays the
content of the element that is selected in the XML Tree, including the text of all its child elements.
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Technically speaking, the Preview pane shows the concatenation of all text in the sub tree rooted at the
XML element that is currently selected.

The text that is displayed can be used for standard copy and paste purposes, but this pane is not
designed for editing.

Its function is mainly to help the user to link the appropriate XML elements to text objects in the
Illustrator design.

Note:

To hide or display the Preview pane, choose Hide/Show Preview in the fly-out menu.

Drag the border between the XML Tree and the Preview pane up or down to resize the Preview pane.

The Fly-out Menu
The Dynamic Content palette has a fly-out menu which offers access to a variety of commands. The
commands you will use most often are also directly accessible from the palette buttons to speed up
your daily work.

Accessing the fly-out menu
To open the fly-out menu, click the expand icon in the upper right hand corner of the Dynamic Content
palette.

 

 

Fly-out Menu Command Reference
This topic lists all the commands on Dynamic Content's fly-out menu, along with a brief description of
their functions.

Command Description

Add XML Adds a new XML file in the Dynamic Content palette.

Note:

You can add multiple XML files to a single Illustrator document to
combine elements from all different XML files in a single design.
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Command Description

Add XML from WebCenter... If the Webcenter Connector plug-in is available, this option will open
its dialog to browse for the XML content within WebCenter projects.

If the CHILI Plug-in is available, it will allow to browse for CHILI
Publisher related files on WebCenter. The selected file is added, and
works as any other linked XML.

Relink XML... Replaces an existing XML file link by a new one.

Note:

This operation cannot be undone.

Relink XML from WebCenter If the WebCenter Conector plug-in is available, this command,
similar to Relink XML, replaces the selected XML file, but browses
WebCenter projects instead of local files. In addition, if the CHILI
Plug-in is available, it allows to browse for CHILI Publisher-related
files on WebCenter.

Remove XML Removes the selected XML file from the Dynamic Content palette.
Dynamic Objects that refer to XML elements in a file that is removed
will be converted to regular Illustrator text objects.

Note:

This operation cannot be undone.

XML Source > New XML… Creates a new XML file according to the GS1 or IPC XML schema. The
XML file's format depends on the settings in the Preferences. See
Dynamic Content Preferences on page 94

XML Source > New
Element…New Element…

Appends the text of the selected Illustrator text object(s) to the
current XML file as an XML element in the GS1 or IPC format,
according to the settings in the Preferences.

XML Source > Edit Element… Opens a basic XML editor in which you can edit the contents of the
selected XML element. The editor displays all the text inside the
selected XML elements: all child elements in the tree structure are
included and editable.

XML Source > Save XML As… Saves the current XML to a new file according to the GS1 or IPC
XML schema. The XML file's format depends on the settings in the
Preferences. See Dynamic Content Preferences on page 94

XML Source > Revert XML Replaces the contents of the selected XML file in Dynamic Content
by the current version on disk, i.e. this clears all changes made inside
Dynamic Content.
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Command Description

Export Artwork Response... This works only with GS1 or IPC XML files.

Exports the selected XML file as a report file that can be used for
electronic verification of the linked state of the content by the
content creator. The exported XML file has the same structure and
content as the original GS1 or IPC XML file and will add, in the case
of the IPC standard, a "LinkedState" attribute to each CopyElement,
Barcode and NutritionFacts element that occurs in the IPC-XML file. 

The value of the attribute will be set as follows:

"LinkedToArtwork": Indicates that the CopyElement, Barcode or
NutritionFacts element is linked to a text, barcode or table object in
the artwork.

"NotLinkedToArtwork": Indicates that the CopyElement, Barcode
or NutritionFacts element is not linked to any text, barcode or table
object in the artwork.

In the case of GS1 file will export the "BMS Artwork Content
Response" XML file. The file is based on the GS1 BMS standard
(see http://www.gs1.org/gsmp/kc/ecom/xml/).

The file indicates e.g. :

• by the  changedByRecipient  tag by the linked element can show
whether the content of the element was changed inside the
Dynamic Content plug-in

• the actualNumberOfOccurrences element informs
about the number of really placed instances of the
same content (the intended number is indicated by the
expectedNumberOfOccurrences element of the source file)

Variable Locale Mapping... Allows editing the mapping of Locale variables, set in the artwork
template previously by the Dynamic Art plug-in. Here is possible to
map the Locale variables to the actual locales valid for the current
document and remove existing mapping. This is only applicable for
IPC XML standard.

Synchronize XML Synchronizes all the external XML files with the corresponding
content used in Dynamic Content. Note that the synchronization
works in both directions: import modifications to external XML files
and export changes done using "Edit Element" in Dynamic Content
back to the external XML files. In case there would be conflicts, the
user will be prompted to choose the behavior.

XML Info... Displays the XML Information dialog box, which shows basic
information on the selected XML file, and allows you to make the XML
file “Read Only”.
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Command Description

Make Dynamic Replaces the contents in the selected Illustrator object with the
contents of the selected XML element, creating a Dynamic Object.

Release Converts the selected Dynamic Object(s) into a regular Illustrator
text object(s). Note that this permanently removes the link to the
XML content.

Release and Convert Converts the selected Dynamic Object(s) into a Dynamic Art
placeholder. The original Dynamic Content link information is
transformed to Dynamic Art link information. Note that this
permanently removes the link to the XML content.

Relink Selected Dynamic
Objects

Relink Selected Dynamic Objects operates on all selected dynamic
objects that are already linked to XML file A and will attempt to re-
link all of these objects to selected XML file B. Select both the linked
objects to re-link (in the Illustrator document window) and the target
XML file to re-link these objects to (in the Dynamic Content palette).
For each of the selected objects, the function will attempt to find
the corresponding element to re-link to in the target XML file. In
case an appropriate new XML element can be found for each of
the selected objects, then they will all be re-linked to the new XML
file.This function may be useful when creating line-extensions or
design variants based on content provided in different XML files.
Objects that are linked to XML elements in the content file for the
first variant (e.g. strawbery.xml) can then be re-linked to the content
file for another variant (e.g. banana.xml).

Relink Selected Dynamic Objects also allows you to change the
language of a linked dynamic object if you are working with a
multilingual GS1 or IPC XML content file. See Relink text elements to
different languages on page 46 for more information.

Format Dynamic Text Displays the Dynamic Object Properties dialog box, which allows you
to fine-tune how multiple elements in a single Dynamic Object are
formatted.

Style Mapping… Opens the Style Mapping dialog box, in which you can assign named
character and or paragraph styles to selected XML elements. It
also allows you to specify which XML tags should be interpreted as
paragraphs (i.e. will be followed by a "hard return").

Dynamic Text > Insert at Start Inserts the contents of the selected XML element at the top of the
Dynamic Object in the Illustrator design.

Dynamic Text > Insert at
Cursor Position

Inserts the contents of the selected XML element at the place of the
text cursor within the Dynamic Object in the Illustrator design.  If
the cursor is located inside the word, the content is inserted in the
closest space to avoid splitting words.
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Command Description

Dynamic Text > Insert at End Appends the contents of the selected XML element at the end of the
Dynamic Object in the Illustrator design.

Split Text Splits the contents of a XML element into multiple text objects. Click
inside the initial linked text object at the desired split position and
then click Split Text. The result will be two text objects linked to the
same XML element but each will contain only part of the element. If
the XML changes, Dynamic Content will try to maintain the split at its
original position, but if the content is significantly different, you may
need to merge the text elements and split them again.

Merge Text Merges previously-split dynamic text items back together. Click
inside one of them and click Merge Text on the Dynamic Content
palette’s fly-out menu.

Locate > Locate Element Locates the XML element associated with the selected Dynamic
Object in the Dynamic Content palette. If the XML tree structure was
collapsed, it is now expanded in order to reveal the associated XML
element.

Locate > Select Object Selects the Dynamic Object(s) on the Illustrator artboard that are
attached to the selected XML element.

Locate > Find in XML… Displays the Find dialog box, in which you can search the text
content of the linked XML file.

Clear "Check" Alert Removes the Check Alert from the current element. When the
contents of the external XML file change, the changes are indicated
in Dynamic Content by Check Alerts.

Clear All "Check" Alerts Removes the Check Alerts for all XML elements in the XML file.

Display Options > Highlight
Dynamic Objects

Highlights all Dynamic Objects in the Illustrator document.

Display Options > Hide/Show
Attributes

Displays or hides the XML attributes of the elements in the Dynamic
Content palette.

Display Options > Hide/Show
Preview

Displays or hides the Preview pane in the Dynamic Content palette.

The Toolbars: Button Reference
The buttons on the Dynamic Content toolbars (in Advanced View) allow you to quickly execute the most
common operations in a Dynamic Content workflow. This section details each of the buttons on the
two toolbars and their functions.
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Top toolbar

Table: Buttons on the top toolbar

Button Description

Add XML File.

Adds a new XML file in the Dynamic Content palette.

Reflow Text

Enables the Reflow Text mode, which allows you to transform (scale, rotate, etc.) the
Dynamic Object without deforming the text.

Caution:

Take care when using this mode. It should be turned off as soon as you finish
transforming the Dynamic Object with Illustrator’s tools. While this mode is
enabled, a number of essential Dynamic Content features will not work on this
object .

Synchronize

Synchronizes all the external XML files with the corresponding content used in Dynamic
Content. Note that the synchronization works in both directions: import modifications
to external XML files and export changes done using "Edit Element" in Dynamic Content
back to the external XML files. In case there would be conflicts, the user will be
prompted to choose the behavior.

Find

In Advanced View, enables you to find a piece of text in the XML file. For example, typing
“chocolate” will list all copyelements that have “chocolate” in the XML text in all available
XML files. In Smart View, it searches only the content currently available in the Smart
View window of the palette.

Add Filter

Adds a new view filter to the Dynamic Content palette.

Remove Filter

Removes the corresponding filter from the Dynamic Content palette.

Bottom toolbar

Table: Buttons on the bottom toolbar

Button Description

Clear Check Alert. Depending on the current selection, this button:
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Button Description
• Removes the Check Alert from the current element. When the contents of the

external XML file change, the changes are indicated in Dynamic Content by Check
Alerts.

• Removes the Check Alerts for all XML elements in the XML file.

Select and Zoom to Dynamic Object. This button:

• Selects the Dynamic Object(s) on the Illustrator artboard that are attached to the
selected XML element.

• Zooms to the selected Dynamic Objects on the artboard.

Insert Element in Dynamic Object. Inserts the contents of the selected element in the
XML tree into the selected Dynamic Object on the artboard. The content of the current
element is appended at the end of the Dynamic Object.

Tip:

To insert an element at the top of a Dynamic Object, use the Insert at Start command in
the fly-out menu or Alt+Click this button.

Replaces the contents in the selected Illustrator object with the contents of the
selected XML element, creating a Dynamic Object.

Note:

If an Illustrator text object contains multiple styles (fonts, text sizes, ...) Dynamic
Content will only retain the formatting of the last style found in the text object.

3.4.2.  Viewing XML Information

You can use the XML Info... fly-out menu command to view essential characteristics of the selected
XML file in the XML tree.

• The XML Information dialog box displays the file Size, Location on disk, Created and Modified date,
and similar basic information about the XML file.

• In addition, it also lists the current Content Status, which informs you about the relationship
between the text in the XML file and the linked text in your Illustrator design.

• The XML info shows whether the XML file is taken as a file conforming to any of the supported
standards (GS1 or IPC). This can be important for other productivity enhancers of the Dynamic
Content plug-in, e.g. for Automatic Linking.

• You also can set the highlight color by clicking Select Color.
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• You can use the XML Information dialog box to make the XML file read-only on disk.

• Finally, you can use the Select Color button to change the color used to highlight elements from
this particular XML file (both in the XML Tree and on the Illustrator canvas).

1. Select an XML file in the XML tree.
2. Do one of the following:

• choose XML Info... from the fly-out menu of the Dynamic Content palette.
• double-click the XML file node in the XML tree.

The XML Information dialog box appears.
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3.4.3.  Filter Options for the XML Tree

The Add Filter button  on the Dynamic Content palette allows you to filter the list of elements that
are displayed in the XML tree. You can choose to use a standard, built-in filter, or create your own filter
based on an element name, an attribute name, or an attribute value.

Example: combining multiple filters

The following example of a filter shows only those elements that have been updated in the source
XML file. In addition, it does this in a simplified view based on the IPC schema.
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Tip:

This filter can function as a "to-do" list of elements that need to be checked as a result of an update
of one or more external XML files.

Applying a Filter to the XML Tree
You can create a filter to display only those elements in the linked XML files(s) that are of interest to
you. Dynamic Content’s filter option also allows you to simplify what is displayed in the XML tree based
on a combination of multiple filters.

Multiple filters work in a cumulative manner, using an “AND” logic.

Note:

When combining filters, keep in mind the cumulative effect. For example, applying a filter based on
the Element Name “CopyContent” and then adding another Element Name filter “CopyElement” will
display an empty palette (because there can be no elements that have both the names “CopyContent”
and “CopyElement” at the same time).

1. Create a character style in Adobe Illustrator and map it to text objects, then select one or more text
objects.

2.
On the top toolbar of the Dynamic Content palette, click  Add Filter.

The filter options appear on the palette, just below the top toolbar.
3. Select a filter type from the Filter Type list.

For detailed descriptions of the filter types, see Filter Options in Detail.
4. Do one of the following:

• If you selected the Element Name or Attribute Name filter type, choose an Element or Attribute
Name from the Filter list.
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• If you selected the Attribute Value Contains filter type, enter one or more attribute values in the
Filter box.

The XML tree is filtered according to your criteria.
5. If necessary, proceed by adding or removing additional filters. You can:

•
click  Add Filter to add another filter.

•
click  Remove Filter to remove a filter.

• switch each filter on or off by (de)selecting the check box preceding it.

Filter Options in Detail
A number of filter types can be activated and combined. This topic describes the details of each filter
type.

The filter type... Applies the following filter...

Simplified View on XML Schema Filters the XML tree based on the standard GS1
or IPC XML format. This will display only the
CopyElement elements that contain the actual
text that will be used in your design.

Element Name Filters the XML tree to display only elements
matching the name you select from the Filter
details list.

Attribute Name Filters the XML tree to display only elements with
attributes matching the attribute name you select
from the Filter details list.

Attribute Value Contains Filters the XML tree to display only elements that
have an attribute whose value matches the text
you enter in the Filter details box.

Multiple keywords can be entered
using the following format:
"keyword1","keyword2","keyword3”

Example: Entering "en-us","en-uk" will display
only those elements that have at least one
attribute with a value containing the strings "en-
us" or "en-uk".

Used Elements Filters the XML tree to display only elements that
have been linked to Illustrator text objects.

Unused Elements Filters the XML tree to display only elements that
have not yet been linked to Illustrator text objects.

Elements with Updated Text Filters the XML tree to display only elements that
have been modified in the source XML file.
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The filter type... Applies the following filter...

Tip:

This filter can function as a "to-do" list of elements
that need to be checked as a result of an update of
one or more external XML files.

Elements with Text Overflow Filters the XML tree to display only elements that
have been modified in the source XML file to such
an extent that it has caused text overflow in the
Illustrator design.

Elements with Text Removes any element that does not contain any
text element in its sub-tree. This filter hides any
elements in the XML file purely for structural
reasons which do not contain any text appearing
in the artwork.

Not Synchronized Elements Filters the XML tree to display only those linked
barcode / image / table elements which couldn't
be regenerated due to a data error, for example an
incorrect check digit in the barcode code.

GS1 Instance ID Filters the XML tree to display only elements
with  the GS1 instanceSequence  matching the
value you select from the Filter detail list. The list
contains only instanceIDs present in the GS1 XML
files(s) actually loaded. Use in combination with
'Simplified View On GS1-XML Schema' filter only.

GS1 Locale Filters the XML tree to display only elements
with the GS1 localeSequence matching the value
you select from the Filter detail list. The list
contains only locales present in the GS1 XML
files(s) actually loaded. The localeSequence
numbers are translated using the Artwork Content
Locale mapping present in the GS1 XML file(s). Use
in combination with 'Simplified View On GS1-XML
Schema' filter only.

GS1 Element Type Filters the XML tree to display only elements
of the type you select from the Filter detail list.
The possible values are  Copy Element  for text
content,  Data Carrier  used usually for barcodes,
  Graphic Element  for images and symbols
and  Structured Copy Element  used usually
for Nutrition tables. Use in combination with
'Simplified View On GS1-XML Schema' filter only.

GS1 Approved Filters the XML tree to display only elements with
the GS1 Approved status matching the value you
selected from the Filter detail list. The values
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The filter type... Applies the following filter...
are True and False. Use in combination with
'Simplified View On GS1-XML Schema' filter only.

GS1 For Placement Only Filters the XML tree to display only elements with
the GS1 forPlacementOnly status matching the
value you selected from the Filter detail list. The
values are True and False.   Use in combination
with 'Simplified View On GS1-XML Schema' filter
only.

GS1 Element With Notes Filters the XML tree to display only elements with
any content in the 'Notes' tag.  Use in combination
with 'Simplified View On GS1-XML Schema' filter
only.

GS1 Element Type Code Contains Filters the XML tree to display only elements with
the GS1 <structuredCopyElementTypeCode>
tag matching the value you enter to the filter's
detail. Example: If you enter "brand", the list will
contain 'BRAND_NAME' and 'SUB_BRAND_NAME'
elements only. Use in combination with 'Simplified
View On GS1-XML Schema' filter only.

3.4.4.  Manipulating the XML Tree

Once you have linked an XML file into the Dynamic Content palette of your Illustrator document, you
can use the XML tree in the palette to navigate and even edit the contents of the XML file.

Proceed as follows to view and manipulate the XML tree.

1. In the Dynamic Content palette, click the arrow preceding the topmost XML element.
This is the root element in your file.
The XML tree expands one level down the hierarchy, and the elements in your XML file become
visible.

2. Click the Add filter button.

The Filter list appears.
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3. Select an option from the Filter list.

For example, you can select the Simplified View on XML Schema / IPC-XML filter type to view only
the text contents of an IPC XML file.

The list of XML elements in the palette is filtered to match your criteria.

 

 
4. Click the Find button to open the Find dialog box.
5. Enter a search term in the Find dialog box and click Next.

The first XML element matching your search term is selected in the XML tree. The Find dialog box
shows how many more occurrences of the search term were found in the linked XML file(s).
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Also, note that the text of the selected element is now displayed in the Preview pane of the Dynamic
Content palette.

You have performed some basic operations on the XML tree that will help you speed up your work in
Dynamic Content: navigating the tree structure, filtering the list of elements, and searching for text in
the XML files are all very common operations.

3.5.  Managing Changes to the XML Content

One of the main reasons for using Dynamic Content is that it allows you to deal with changes in textual
content of your designs more eciently and more quickly. This section examines how you manage
changes to the XML content of your designs using Dynamic Content.

The changes in your design can be of two types:

• the external XML file can change, for example if the brand owner sends you a new version of the
copy content and you want to update your design accordingly; or

• you can manually edit the copy content in Illustrator, and apply those changes to the external XML
file.

In short, changes can be applied in both directions: XML to Illustrator, or Illustrator to XML.

3.5.1.  How Dynamic Content Deals with Changes

As soon as the content of the linked XML file(s) is changed, Dynamic Content will warn you of these
changes. If you did not have the Illustrator design open at the time of the changes, you will be notified
the next time you open the file. This behavior is governed by the Always Mark and Update Changed
Dynamic Objects Without Asking option in the Preferences dialog.
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Changes in the XML file
When changes in the XML file are detected, the XML Changed dialog box appears, and you will be given
two options. You can either:

• Update the Illustrator document now; or
• Cancel the update, in which case you will have to deal with the changed content later. The XML Not

Up to Date  status icon then appears next to the XML file in the XML Tree until you resolve the
version difference.

 

 

If you do click Update Now, the text inside any Dynamic Objects is updated with the new XML content.

Every element that experiences these changes is marked with a Check Alert in the XML tree.

Changes inside Dynamic Content
You can also make changes to the XML content inside Illustrator by using the Edit Element command
on the Dynamic Content fly-out menu.

Any changes you make in Illustrator using Dynamic Content are not automatically applied to the

source XML document. Instead, they are marked in the XML tree with the  status icon so you have
the chance to review these changes before applying them to the linked XML file using the 
Synchronize command.

3.5.2.  Approving Changes in the External XML File

To approve changed content, you have to review the Dynamic Objects that have undergone content
changes.

1. Open the Illustrator file for which one or more of the linked XML files have been modified externally.

Once the Illustrator document opens, the XML Changed dialog box appears.
2. Click Update Now to apply the changes to the Illustrator document.

Any Dynamic Objects that are linked to XML elements that have been changed in the XML file are
automatically updated to match the new XML content.

Every XML element that has been modified is marked with a  Check Alert in the XML tree.
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Note:

Elements that have been modified to such an extent that one or more Dynamic Objects have lost

formatting are marked with a different  Check Alert. These elements will require your special
attention to solve formatting issues in your final design.

3. Review each of the Check Alerts:
a) Select an element with a Check Alert in the XML tree;
b) Click the Select and Zoom to Dynamic Object button on the bottom toolbar of the

Dynamic Content palette.

The Dynamic Objects that have been modified are now visible and selected on the Illustrator
artboard.

c) Make any changes to the Dynamic Objects that are needed as a result of the updated text.
d) Click the Clear Check Alert button on the bottom toolbar of the Dynamic Content palette to

remove the Check Alert from this element, then proceed to the next element until there are no
more Check Alerts in the XML tree.

Tip:

Add a filter of the type “Elements with Updated Text” to display only those elements that require
your attention after a change in the XML file.

3.5.3.  Applying Text Edits in Illustrator to the XML File

If you have edited the text of one or more XML elements using the Edit Element command on the
Dynamic Content fly-out menu, you will have to decide whether or not you want to apply those changes
to the external XML file.

1. Open the Illustrator file that contains text edits that have not yet been applied to the XML file.
2.

Review each of the text edits by selecting the elements that are marked by a  Check Alert, and

then clicking the Select and Zoom to Dynamic Object button on the bottom toolbar.
3. Make any required changes to the design or to the text.
4. Click the  Synchronize button on the top toolbar to apply the text edits to the XML file.

3.5.4.  Creating New XML Files in Illustrator

Dynamic Content allows you to create new XML files with the GS1 or IPC XML schema directly from
within Illustrator, based on the text you may already have in your designs. Typically, you will use this
feature to convert existing, legacy designs into XML-driven, Dynamic Content designs.

New XML
Use the New XML... command on the Dynamic Content fly-out menu to create a new (empty) XML file.
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1. Choose New XML... from the fly-out menu.

• When using IPC standard, the  New XML dialog box appears. Fill in all the fields. The metadata
section of your XML file will be filled in based on the information you supplied.
 

 
• When using GS1 standard, the GS1 file is created with default values in its header, without asking

the user.

You can set the IPC or GS1 standard in the Preferences. See Dynamic Content Preferences on page
94

2. Click OK.
A new XML file based on the standard IPC or GS1 schema is created.

Add Illustrator Text to the XML
Use the New Element command on the Dynamic Content fly-out menu to add text content from
selected Illustrator text objects to the linked IPC XML file. This also converts the selected Illustrator
objects into Dynamic Objects.

The Illustrator document must be linked to an IPC-based XML file.

1. Select one or more Illustrator text objects.
2. Choose New Element from the fly-out menu.

The New Element dialog box appears.
3. When using the IPC XML standard:
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a) Choose a CopyElement type from the Element Type and Element Subtype lists.
b) If necessary, select the language (locale) of the element content from the Locale lists.
c) Enter the identification code of the design (e.g. POA1) in the Artwork ID box.
d) If you want to map the text styles in the selected Illustrator text object to XML tags inside the

CopyElement, enable the Map Text Styles to Tags option.
Dynamic Content will attempt to preserve the formatting of the original text by inserting
additional XML tags, which are automatically mapped to the text styles that were applied to the
Illustrator text object.

4. When using the GS1 XML standard:
 

 
a) Choose an Element Type Category and an Element Type.
b) Define the Instance Sequence. This allows to identify different elements of the same Type.
c) Define the Locale Sequence. The POA header defines a number for each language. The Locale

Sequence in each element refers to that mapping
5. Click OK.

The new content is added to the internal representation of the XML file. When using the
Synchronise function, the new content is written to the external XML file.

3.6.  Editing Dynamic Objects

This section examines the editing features in Dynamic Content.

The following editing operations are available in Dynamic Content:

• You can edit the text of an XML element directly inside Illustrator. Also, you can transform the
Illustrator text boxes that are the basis of the Dynamic Objects.

• You can insert a specified set of special characters (such as spaces, hyphens or tabs) in a Dynamic
Object to improve the text layout.

• You can insert text from additional XML elements in an existing Dynamic Object, either by
appending it at the end or by inserting it at the start of the existing text content.

• Fit Text Frame to Contents (Auto-grow) or Fit Contents to Text Frame (copy-fitting). See Fit Text
Frame to Contents / Fit Contents to Text Frame on page 76

72



3Dynamic Content Essentials

• You can edit the properties of dynamic barcodes and nutrition tables using the Dynamic Tables and
Dynamic Barcodes plug-ins.

3.6.1.  What is a Dynamic Object?

A Dynamic Object is an Illustrator text object that has been linked to an XML element using the Dynamic
Content plug-in.

Dynamic Content encapsulates the original text object in the Dynamic Object, and in the process it
prevents a number of changes from being made: you can no longer use the standard Illustrator Text
tools to modify the contents of a Dynamic Object.

3.6.2.  Which Standard Illustrator Edits Are Allowed?

A Dynamic Object is protected from text edits using the Illustrator Text tools. However, you can still
modify the text of a Dynamic Object to a certain extent.

The following edits remain possible:

• You can move, rotate or scale the Dynamic Object using the standard Illustrator transform tools.

• You can change the formatting (e.g. the font family or alignment properties) of the text by applying
text styles in Illustrator. To do this, use the controls on the Type palette in Illustrator.

• You can change the color of the text.

Note:

When you scale a Dynamic Object, its text content is scaled as well. To allow the text box to “reflow” as
per the standard Illustrator behavior, click the Reflow Text button on the top toolbar before making any
changes.

Example: font changes to a Dynamic Object

In the following example, a Dynamic Object was selected and the font used for the text was changed
using the Type palette in Illustrator. Note that changes like this may cause text overflow problems.
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3.6.3.  Inserting Additional XML Elements in a Dynamic Object

Once a Dynamic Object has been created, you can add additional content (from other XML elements)
to this same object. New content can be added either to the end of the content (Insert at End) or, if
needed, before the beginning of the existing content (Insert at Start).

Note:

This feature applies to a single Dynamic Object. You can therefore have a Dynamic Object that is linked
to XML Element A, and another Dynamic Object in the same design that is linked to both XML Element A
and Element B.

1. Select a Dynamic Object on the Illustrator artboard.
2. In the XML tree, select the XML element that you want to add to the Dynamic Object
3. Do one of the following:

• To append the text of the new XML element at the end of the Dynamic Object, click the 
Insert Element in Dynamic Object button on the bottom toolbar of the Dynamic Content palette.
Alternately, use Insert at End on the Dynamic Content fly-out toolbar.

• To insert the text of the new XML element in between two XML elements linked to the single
Dynamic Object, place the Type Tool cursor between the two linked elements, and use the Insert
at Cursor Position option on the Dynamic Content fly-out toolbar.

• To insert the text of the new XML element at the start of the Dynamic Object, Alt+Click the 
Insert Element in Dynamic Object button on the bottom toolbar of the Dynamic Content palette.
Alternately, use Insert at Start from the Dynamic Content fly-out menu.

The new XML content is added to the Dynamic Object.

Tip:

You can define how the different XML elements should be combined in the Dynamic Objects by using
the Format Dynamic Text command in the fly-out menu.

3.6.4.  Formatting Multiple Elements in a Single Dynamic Object

In the Format Dynamic Text dialog box, you can view information on the XML elements linked to the
selected Dynamic Object, and you can define exactly how these XML elements should be combined in
the object.

Tip:

You can also use the Format Dynamic Text command to insert a text prefix before the XML element
content (e.g. to add "Ingredients: " before the ingredients list), even without adding multiple elements
to a single Dynamic Object. You can also add a sux in the same way.

1. Select a Dynamic Object on the Illustrator artboard.
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2. Choose Format Dynamic Text on the Dynamic Content fly-out menu.

The Format Dynamic Text dialog box appears.

 

 
3. Make any needed changes to the formatting of the elements in the Dynamic Object:

If you want to... Then...

Insert text or special characters before one or
more elements

Select the element(s) in the list and type the
desired prefix in the Prefix field.

Insert text or special characters after one or
more elements

Select the element(s) in the list and type the
desired prefix in the Sux field.

Treat all elements as part of the same block of
text, without paragraphs

Deselect the Preserve Paragraphs option.

Change the order in which the elements
appear in the Dynamic Object,

Select the element(s) you want to move, and
click the Move Up or Move Down buttons.

Remove blank spaces in the elements, Enable the Remove Leading, Trailing and
Duplicate Spaces option. This removes any
undesirable whitespace characters from the
XML before the text is displayed in the Dynamic
Object. Additional whitespace characters are
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If you want to... Then...
sometimes added by XML editors in an effort to
make the XML more legible for human readers.

4. Click OK.

3.6.5.  Fit Text Frame to Contents / Fit Contents to Text Frame

In the Format Dynamic Text dialog, you can view information on the XML elements linked to the
selected Dynamic Object, and set automatic modification of the Dynamic Object size or the text size
within the Dynamic Object.

 

 

The Fit Text Frame to Contents (Auto-grow) and Fit Contents to Text Frame (Copy-fitting) options
allow setting the options for future use in Dynamic Content. They can only be set if Assign multiple
XML Attributes is enabled. You can choose to fit the text frame to the contents, or fit the contents to
the text frame. Combining the two is not possible.
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Fit Text Frame to Contents

If you use Fit Text Frame to Contents, the text box will grow to fit the actual text content, coming from
the XML source. The text box size will be adapted every time the XML source changes.

This option is useful when you're not sure what amount of text will come from the XML, and you want to
avoid text overflow.

• The Direction defines in what direction the text box can grow: down, up, to the left or to the right.

• Using Minimum Height and Maximum Height (or width, depending on the direction) you can define
the minimum and maximum size for the text box.

Note:  This option is only available for Area Text objects, so not for Text on Point or Text on Path

Fit Contents to Text Frame

If you use Fit Contents to Text Frame, the font size will change to fit the text frame.

This option is useful when the space for the text is limited, and font size changes are allowed by the
design rules.

• The Minimum Text Size and Maximum Text Size define the minimum and maximum font size to be
used.

Note:  This option is only available for Area Text objects and Text on Path, so not for Text on Point.

3.6.6.  Editing the Text of an XML Element

You can edit the text of a Dynamic Object by using the Edit Element command on the fly-out menu. This
will change the contents of the linked XML file itself. Of course, Dynamic Content marks these changes
so you can review them before they are applied to the external XML file.

The Edit Element dialog box displays the text of the selected XML element. The XML tags from the
linked XML file are displayed as square brackets [ ]. This makes it easier to focus on editing the text
without worrying about XML structure and syntax.
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Note:

The square brackets ( [ ] ) in the Edit Element dialog box represent XML opening and closing tags. To
type a square bracket in the text of your design, use the following codes: &left; for “[“ or &right; for “]”.

1. Select the XML element for which you want to edit the text content in the XML Tree.
2. Choose Edit Element... in the fly-out menu of the Dynamic Content palette.

The Edit Element dialog box appears.
3. Make changes to the text where needed.
4. Click OK to apply the changes to your design.

The new text is used in any Dynamic Objects linked to the XML element you edited, and the XML

element itself marked with a  Check Alert icon in the XML Tree.

However, the new text is not yet saved in the linked XML file. To save your edits:

• Click the  Synchronize button on the top toolbar. This will save your edits into the currently
linked XML file.

• Alternatively, choose Save XML As... from the fly-out menu to save the new content into a new XML
file.

The Edit Element Dialog Box in Detail
The Edit Element dialog box displays all the text of the selected XML element and its children.

The XML tags from the linked XML file are replaced by square brackets [ ]. This makes it easier to focus
on editing the text without worrying about XML syntax.

The option Show elements as story formats the content in the editing area in a more user-friendly
manner. If you disable this option, every element starts on a new line in the editing area.

Note:

The square brackets ( [ ] ) in the Edit Element dialog box represent XML opening and closing tags. To
type a square bracket in the text of your design, use the following codes: &left; for “[“ or &right; for “]”.

The square brackets “[]” cannot be deleted, because they represent the structure of the XML tree.
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3.6.7.  Making minor layout edits

The text of a Dynamic Object is protected from direct editing using the Illustrator Type tools (Type tool,
Area Type Tool, ...). However, you can use the Type tools to make minor layout edits in a very strictly
defined number of cases.

Text in a Dynamic Objects cannot be edited using the Type tools because this would go against the
basic workflow principle of Dynamic Content: to make sure that your design remains synchronized with
the external content and only displays text sourced from the linked XML file(s).

If you do try to edit a Dynamic Object, you will find that you can only insert a limited number of layout
characters (i.e. tab, line break, ...) and that all other edits will be blocked.

Figure 1: The Illustrator Type tools can only be used to insert layout characters

• You can insert the following special characters:

This character... Can be inserted...

a whitespace character • after an existing whitespace character in the XML content;

• after a manually added hyphen.

a hyphen ( - ) character • inside an existing word in the XML content;

• after a manually added whitespace character.
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This character... Can be inserted...

a slash ( / ) character • before or after existing space, tab, paragraph or a line break in
the XML content;

• after a manually added hyphen character.

a tab character • after any whitespace character (existing or manually added);

• after a manually added hyphen character, if that is not already
followed by a manually added whitespace.

a new paragraph (return)
and a line break (shift
+return) character

• after any whitespace character (existing or manually added);

• after a manually added hyphen character, if that is not already
followed by a manually added whitespace.

3.6.8.  Releasing a Dynamic Object to regular text

You can easily convert a Dynamic Object back into a regular Illustrator text object. To do this, either use
the Release or the Release and Convert command on the fly-out menu of the Dynamic Content palette.
Release completely removes the XML link information from the text, while Release and Convert
converts the text to a Dynamic Art placeholder, maintaining the link information.

Designers who do not have access to the Dynamic Content plug-in can choose to convert the Dynamic
Objects (which retain their special, protected status even when opened on a workstation without
Dynamic Content) back into regular text objects using the Illustrator command Object > Expand....

This allows them to work on the design and make changes where needed, but it also breaks the
Dynamic Content workflow.

Note:

When you release a Dynamic Object using one of the two available methods, the link to the XML
element(s) is permanently broken. Releasing a Dynamic Object using Release and Convert only keeps
the link information for future use as a Dynamic Art template.

• To release a Dynamic Object, select it on the Illustrator artboard and:

• Choose Release  from the Dynamic Content fly-out menu; or
• Choose Release and Convert from the Dynamic Content fly-out menu; or
• Choose Object > Expand... from the Illustrator menubar.

3.6.9.  Exchanging Dynamic Content Documents

If you have to send an Illustrator document that contains linked objects that were created by the
Dynamic Content plug-in to someone who does not have the plug-in, you have two options.

• You can release the Dynamic Objects back to normal Illustrator objects before sending the
document to the recipient. Select all the linked objects and then choose the Release command on
the fly-out menu.
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The document no longer contains any Dynamic Objects and all links to the XML file(s) have been
removed.

• You can send the Illustrator document to the recipient without removing the Dynamic Objects.

If the recipient... Then (s)he ...

does not need to edit the text in the Dynamic
Objects

can work with the Illustrator document without
noticing any difference with a regular Illustrator
document.

needs to edit the text of a Dynamic Object has to use the Expand command on the Object
menu in Illustrator.

Note:  Take care when using the Expand
command in Illustrator. If you apply the
command to other objects in your design
(e.g. blends, text, ...) it can cause unexpected
changes in your design. For this reason, it is
often advisable to release the Dynamic Objects
before sending it to any recipients who do not
have access to the Dynamic Content plug-in.

3.7.  Styling your Dynamic Objects

There are two approaches to styling the Dynamic Objects in your design: manual styling and automated
styling (Style Mapping). In this section you will learn how to apply both these methods, how to solve
common problems such as text overflow, and more.

3.7.1.  Two Approaches to Text Styling

The two approaches for styling your Dynamic Objects each have their specific use cases. Obviously,
the automated method will save you time in certain situations, but it can only be used eciently if
your source XML file contains presentation-related information. This section further explores the
differences, and explains exactly how to apply both the manual and automated styling methods.

What Is Manual Styling?
The easiest - but not always the most ecient - approach to styling the text in your Dynamic Objects is
to use the Character and Paragraph palettes in Illustrator.

In other words, applying the manual method - sometimes called the “template-based” styling approach
- means that you must select every Dynamic Object in the design and apply the appropriate style
formats manually.

Alternatively, of course, you can set up your design with properly styled “dummy text” boxes even before
you create Dynamic Objects. In this case, the Dynamic Content plug-in will apply the last style found in
the Illustrator object to the text in the new Dynamic Object.
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When a Dynamic Object contains multiple styles, Dynamic Content will attempt to preserve these
styles whenever the content is updated. In some cases, when there are major changes to the content
of a Dynamic Content, this will prove impossible. To alert you to this possible loss of formatting, a

special  Check Alert will appear in the XML Tree for the affected elements.

Note:

For more information, please refer to the Adobe Illustrator Help in the Type chapter.

What Is Style Mapping?
Style Mapping allows you to automate the formatting of your Dynamic Objects to a very high degree.
You apply Style Mapping by linking XML elements to named styles in Illustrator

Mapping Elements to Styles
Using the Style Mapping dialog box, you define the relationship between the XML elements in the linked
XML file(s) and named Character and Paragraph Styles in your Illustrator design. Once this relationship
has been defined, every Dynamic Object that incorporates a specific XML element will automatically be
formatted with the corresponding Paragraph and/or Character Styles.

Style Hierarchy
Styles in Adobe Illustrator apply to text objects in a specific order. This is of particular importance
when defining Style Mappings, as you will be setting up both Paragraph Styles (e.g. for a ‘p’ tag in the
XML file) as well as Character Styles (e.g. for a ‘bold’ tag in the XML file).

Style types have a built-in hierarchy, with the last level overruling all the preceding information:

1. First, the named Paragraph Style is applied.
2. Any Character Styles applied to a specific section in a paragraph overrule the formatting of the

Paragraph Style.
3. Finally, local overrides overrule the Character Style. An override occurs when you manually change

a property (i.e. change the font size) in the Character palette without updating the Character Style
itself.

An Example of Style Mapping
In the following example, we will use some HTML content from a web page that we saved in XML
format, link it to our design in Illustrator, and then apply Style Mapping to automatically recreate the
styling from the original web page.
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Step One: Preparing the Files
First, we save the snippet of HTML (actually it is XHTML, a special flavor of HTML that conforms to the
XML standard) as an XML file, so we can link to our design using Dynamic Content.

 

 

Then, we prepare some named styles in our Illustrator design: the Paragraph Styles ProdListPara and
ProdListHeader, and the Character Style ProdName.

As you can see, the Illustrator text box already contains some dummy text that enables us to test these
styles.
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Step Two: Linking the XML File

In this second stage, we link the XML file to the Illustrator using the Add XML File command. Then we
convert the text object into a Dynamic Object by linking it to the <body> element.

The result: we lose all of our carefully applied styling. A warning message informs us that not all the
style information could be retained during the conversion. Not all is lost, however, as we will restore the
styling using Style Mapping.
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Step Three: Setting Up Style Mapping
In this third and final step, we use Style Mapping... command on the fly-out menu to define the
relationships between the predefined Styles on the one hand, and the XML elements on the other.

In this example, we link the <p> tag (which is the basic xhtml paragraph) to the ProdListPara Paragraph
Style in Illustrator. The <strong> tag is also defined as a paragraph, this time using the ProdListHeader
style, creating a nice title for the product list.

Finally, we link the <a> element to the ProdStyle Character Style, adding some color to the design.

Tip:

If you just need to emphasize certain elements within the document by formatting them in bold, italic
or underlined text, you can use the Character Styling options Bold, Italic or Underline.
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The final result
Once we apply the Style Mapping to our design, the Dynamic Object is automatically formatted
correctly. As you can see, in text-heavy designs, this can be a huge timesaver.
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Applying Style Mapping
To apply Style Mapping to your document, you need to first define the named Character and Paragraph
Styles that you will be using, and then set up the relationships between these styles and the XML
elements using the Style Mapping command in Dynamic Content.

For more information on Character and Paragraph Styles in Illustrator, please consult the Illustrator
Help in the Type section.

Creating a Basic Style Mapping Rule
In this task, you will set up a basic Style Mapping rule.

1. Choose Style Mapping... in the fly-out menu.

The Style Mapping dialog box appears.

 

 
2. Select the element in the Element List that you want to associate with an Illustrator named style.

Click the Show All button if you want the Element List to display all elements in the linked XML files.
Otherwise, only the elements currently in use will be listed.

3. Enable the Preview option to immediately see the results of any mappings you make on the
artboard.

4. Do one of the following:

If you want to... Then...

map the element to a Paragraph Style • Enable the Paragraph option; and

• Select a Paragraph Style from the
Paragraph Styles list.
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If you want to... Then...

Note:

You can also select a Character Style for the
element. In this case, the formatting of the
Character Style will be added to the Paragraph
Style (overruling it in case of conflicts).

map the element to a Character Style • Disable the Paragraph option;

• Select a Character Style from the Character
Styles list.

5. Repeat step 4 for each of the elements you wish to map.
6. Do you want to save the Style Mapping you just defined?

• If you do, proceed to step 7.
• If you do not, proceed to step 8.

7. Click the Save... button and save the Style Mapping settings on your computer or network.

The Style Mappings are saved in a special XML format.
8. Click OK to apply the Style Mapping.

Creating a Location-Based Rule
In this task, you will set up a Style Mapping rule that only apply to elements at a specific location in the
XML tree structure.

1. Choose Style Mapping... in the fly-out menu.

The Style Mapping dialog box appears.
2. Click Add... to create a new rule or Modify... to refine an existing rule.

The Add or Modify dialog box appears.
3. Select the element you want to format with a style from the Element Tag Name list.
4. Select the parent element of the element you want to affect from the Child Element of list.

In the example below the Style Mapping rule will apply only to <span> elements that are found
within a <p> element.
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5. Select a Style from the Paragraph Style and/or Character Style lists.
6. Click OK to save the Style Mapping rule.

The selected style is applied to all the instances of the elements that match your selection.

Creating an Attribute-Based Rule
In this task, you will set up a refined Style Mapping rule that only applies to elements that have a
specific attribute value.

Tip:  Use the [Any Element] option in the Element Tag Name list to create a rule that applies to any
element in the design that has a specific attribute or attribute value. For example, you could apply a red
italic style to all elements that have the attribute value pair status="to_be_reviewed".

1. Choose Style Mapping... in the fly-out menu.

The Style Mapping dialog box appears.
2. Click Add... to create a new rule or Modify... to refine an existing rule.

The Add or Modify dialog box appears.
3. Select the element you want to format with a style from the Element Tag Name list.
4. Select the parent element of the element you want to affect from the Child Element of list.

In the example below the Style Mapping rule will apply only to <span> elements that are found
within a <p> element.
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5. Click the + (Add Attribute) button underneath the attributes list.

Note:  You can only click the Add Attribute button if the XML element you selected in the preceding
steps has one or more attributes.

A new row is added to the attribute list.
6. Double-click in the Attribute column and select the attribute on which you want to base this rule

from the list.
7. Do one of the following:

• If you want the Style Mapping to affect only elements that have a specific value for the attribute
you selected, choose either Is or Contains from the Is/Contains list and enter a value in the Value
column.

• If you want the Style Mapping to affect all elements on which the attribute you selected is found,
regardless of the attribute value, proceed with the next step.

In the example below, only <span> elements that have a class attribute with the value "style1" will
be affected by the Style Mapping rule.
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8. Select a Style from the Paragraph Style and/or Character Style lists.
9. Click OK to save the Style Mapping rule.

Mapping an Element to a Character Style or exact font
In this task you will map an element or attribute to a character style in Illustrator, such as bold, italic or
underlined text, using the Style Mapping feature in Dynamic Content.

If you map an element or attribute to a character style, Dynamic Content will automatically select the
appropriate variant of the font used for the dynamic object. For example, mapping to a “bold” character
style will instruct Dynamic Content to switch to the Bold, Semibold or Black variant of the font in use.

Note:

You can enable or disable the use of Semibold and Black variants in the Dynamic Content Preferences
dialog.

1. Choose Style Mapping... in the fly-out menu.

The Style Mapping dialog box appears.
2. Click Add... to create a new rule or Modify... to refine an existing rule.

The Add or Modify dialog box appears.
3. Create an element- or attribute-based style mapping rule:

• For an element-based rule, select the Element Tag Name and if necessary, further refine by
selecting the parent element from the Child Element of list.

• For an attribute-based rule, add an attribute by clicking the Add button, select the matching
method from the Is/Contains list, and type the Value.
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4. Select to use an exact font, or select the type of character styling you want to apply to the matching
elements:

• Enable Use Typeface and select the exact font to use in the dropdown. Note that selecting an
exact font can't be combined with the character styling options.

• Enable one or more of the Bold, Italic and Underline options; or
• Select a predefined Character Style from the list.

5. Click OK to save the Style Mapping rule.

The presence of a character styling rule is indicated in the Style Mapping dialog with an asterisk.
 

 

Example

This example maps an element <b> that also has the attribute style=”bold” to the Bold character
style.
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When applying that style mapping rule, the following code:

<root> 
   <p>This is a <b style=”bold”>bold</b> word inside a sentence.</p> 
</root>

Would be rendered as:
 

 

Automatic Mapping of tab and line break tags
If the XML data use the standard HTML formatting tags <tab/> (for tabulator) or <br/> (for line break),
it's possible to automatically map these tags to the appropriate formatting in Illustrator.

• Set the Use <br/> element as line break option to use all <br/> tags as a line break
• Set the Use <tab/> element as tabulator option to use all <tab/> tags as a tab in Illustrator.

Automatic Style Mapping from CHILI documents
In the CHILI editor, users can apply formatting like underscore, strikethrough, font type on the edited
text. 

The CHILI documents will then contain attributes, reflecting the user defined formatting. 

While loading the CHILI document, the CHILI plug-in automatically adds new mappings to the Style
Mapping of Dynamic Content, in order to apply the formatting defined in the CHILI document.
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You can freely modify or remove the mappings after loading the CHILI document, as it behaves like
normal mappings being set manually.

3.7.2.  Solving Text Overflow Problems

Text overflow occurs when a text object in Illustrator contains more text than can be displayed.
Dynamic Objects are especially sensitive to text overflow: their contents can be updated regularly - and
all too often without any consideration for the effects the changed content can have for a design.

Luckily, Dynamic Content immediately alerts you to text overflow problems by displaying a special 
Check Alert for every element in which the problem occurs.

1. After updating the contents of an XML file, click Add Filter.
2. In the Filter Type list, select Elements with Text Overflow.

Only elements with text overflow are displayed in the XML Tree.
3. Alt+Click on the Check Alert icon next to the XML element you want to fix.

The view in Illustrator zooms to the Dynamic Object(s) linked to the element. If the element is linked
to multiple Dynamic Objects, you have to select the object with text overflow manually before
proceeding.

4. Do one of the following:

•
Click the  Reflow Text button and scale the Dynamic Object to allow for the additional text.

• Use the Illustrator Type tools to reduce the font size of the text in the Dynamic Object.
5. Repeat steps 3 - 4 for each of the elements with text overflow, until the filtered XML Tree does not

display any more elements.

3.8.  Dynamic Content Preferences

The Dynamic Content Preferences allow you to determine some XML processing settings.

The Dynamic Content Preferences dialog box
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3.8.1.  XML Standard

The XML Standard option determines the default behavior related to the XML standards. If the GS1
standard is selected (default), the new XML files and XML elements created by the Dynamic Content
plug-in and the XML file created by the Export Artwork Response command conform with the GS1
schema. The IPC option changes this bevahior to let these files conform with the IPC XML schema.

3.8.2.  Default Formatting of Dynamic Objects

The Remove Leading, Trailing and Duplicate Spaces from Linked XML option determines how
Dynamic Content treats whitespace in linked XML elements.

If you enable the Remove Leading, Trailing and Duplicate Spaces from Linked XMLoption, Dynamic
Content will remove any whitespace characters preceding or following the text inside an XML element
that is linked to a Dynamic Object

Note:

The space stripping function removes all leading, trailing spaces, except those directly preceding and
following a nested XML element. Otherwise, text in nested elements would be rendered “glued” onto the
preceding and following text.

Example

Consider the following XML snippet:
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If the Remove Leading, Trailing and Duplicate Spaces from Linked XML option is enabled, this text
in any linked Dynamic Objects will be stripped of the extra whitespaces. However, a single space will
be retained before and after the contents of the <b> element (“leading and trailing”). The result:

This text has leading and trailing spaces.

If all spaces surrounding the nested <b> element were also stripped, the element would read:

This text hasleading and trailingspaces.

3.8.3.  Style Mapping Preferences

The following Style Mapping Preferences can be set in the Dynamic Content Preferences dialog:

Preference Description

Allow “semibold” typefaces to be used for
automated bolding

Allows Dynamic Content to select the Semibold
variant of the current typeface, if it is available,
when applying character style mapping.

For example, if this option is enabled, text in the
Minion Pro Regular typeface will be emboldened
using Minion Pro Semibold. If this option is not
set, Minion Pro Bold will be used.

Allow “black” typefaces to be used for
automated bolding

Allows Dynamic Content to select the Black
variant of the current typeface, if it is available,
when applying character style mapping.

For example, if this option is set, text in the
Minion Pro Bold typeface will be emboldened
using Minion Pro Black. If this option is not set,
the Minion Pro Bold will stay untouched.
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Note:

If both these options are disabled, Dynamic Content will only search for Bold variants of typefaces
when applying character style mapping.

3.8.4.  Updating and Relinking

The Use Exact Matching when Updating and Re-linking XML Files option determines how Dynamic
Content links a specific XML element to a Dynamic Object in the Illustrator document. By default, this
option is disabled.

Smart or Exact Matching?
Dynamic Content stores the link between an XML element in the source XML file and the Dynamic
Object in the Illustrator design in an "absolute" path. This absolute path contains the complete XML
tree structure leading up to the XML element in question. This includes all attribute values of all the
elements at a higher level.

By default, Dynamic Content does not use Exact Matching to link an XML element to a Dynamic Object
when you update or replace an XML file. Instead, it uses a "smart" matching algorithm to determine the
most likely candidate for linking. This algorithm takes into account all of the information in the absolute
path, but uses a weighting scheme that allows for small changes in the XML file without breaking all the
links to the Dynamic Objects.

If the Use Exact Matching when Updating and Re-linking XML Files option is enabled, Dynamic
Content will instead require an exact match to the XML element's path. In this case, if any XML
elements in the external file have changed position or received new attribute values, the links to the
Dynamic Objects will be lost. Usually, this is not the desired behavior.

Example

Consider the following basic XML tree:

<CopyElement CopyElementType="Usage">
    <body>
       <p lang="de">Automat 40° 60° 90°</p>
       <p lang="ru">Автоматическая 40° 60° 90°</p>
    </body>
</CopyElement>

If you link the final <p> element (<p style="put_style_here">############## 40° 60° 90°</p>) to
a Dynamic Object, an absolute path to this element is stored. This path includes a reference to the
position of the <p> element relative to its parent, as well as the value for the lang attribute ("ru").

We complete the XML content by adding an additional language:

<CopyElement CopyElementType="Usage">
    <body>
       <p lang="de">Automat 40° 60° 90°</p>
       <p lang="en-us">Washer 40° 60° 90°</p>
       <p lang="ru">Автоматическая 40° 60° 90°</p>
    </body>
</CopyElement>

If we update our Illustrator design:
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• with Exact Matching enabled: the last <p> element's link to the Dynamic Object will be broken,
because the position of this element relative to its parent has changed from being the second
child to third child.

• with the default behavior (Exact Matching is disabled): the last <p> element's link to the Dynamic
Object will be retained. Even though the position of the <p> element has changed, the fact that
its attribute value still matches the original path will result in a weighted, smart match.

Always Match IPC Locales when Updating and Re-linking XML Files
When using the IPC standard, and not using Exact Matching when Updating and Re-linking XML Files,
you can choose this option.

The option is applied when re-linking the XML file. Example: A text object is linked to the Copy element
identified by the CopyElementType="MarketingClaim", ID="XY" and Locale="en-US" attributes. The new
XML file may or may not contain an element with the same identification; Dynamic Content tries to find
and match the element from the new XML file and link it instead the old one - potentially followed by the
content update.

If this options is set, the elements match if Copy Element Type, ID and also Locale attributes are the
same in the old and the new XML file.

If this option is not set, the Locale attribute is not taken into account. It allows re-linking files with the
language variants - e.g. the new XML file can contain the translation to German language and if the
element is identified by CopyElementType="MarketingClaim", ID="XY" and Locale="de-DE", the re-link
will pass and the original English content will be replaced by the German one.

Consider IPC CopySourceRef While Matching
One of the IPC attributes identifying the copy elements is CopySourceRef. If the Consider IPC
CopySourceRef While Matching option is enabled, the CopySourceRef attribute of the original element
and the element in the new XML file must match to let the new element replace the old one. If the
option is disabled, the CopySourceRef attribute is ignored.

Always Update and Mark Changed Dynamic Objects Without Asking
The Always Mark and Update Changed Dynamic Objects Without Asking option controls how
Illustrator responds to differences between dynamic objects and their corresponding XML elements.

If this option is checked, Illustrator checks for consistency between dynamic objects and XML
elements when it opens a file.

If there are changes, Illustrator changes the dynamic objects and marks them as being changed.

If this option is not checked (the default), Illustrator prompts you for action.

3.8.5.  WebCenter Integration

As the options in this section are related to the WebCenter connection, they are only available if the
WebCenter Connector plug-in is available.

The Automatically Check for New Document Version Every X Minutes option sets the timer how often
the WebCenter service will be asked to check if a new version of the XML file is available.

If Download the Full Package for Linked CHILI Documents is enabled, the WebCenter Connector will
always download the full CHILI packaged file with all its resources, instead of extracting only the XML
from the document.
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3.8.6.  Other

The Always Save Links to IPC XML Files in Document XMP Using Absolute Paths option controls
whether Illustrator saves absolute or relative paths to XML files in the document’s XMP data.

An example of an absolute path would be file://networkstorage1/current/2496/
XMLfile.xml. An absolute path contains the complete machine and folder structure for the file
location.

An example of a relative path would be file:../../XMLfile.xml. A relative path contains a
pointer to the XML file location based on the location in which the Illustrator document was last saved.
If the Illustrator document containing this XMP data were opened on another computer with different
drive mapping, the proper XML file would not be found.

The Allow linking MasterCopy data option allows linking GS1 elements with Locale ID, which is defined
as a "Master Copy". If the option is disabled, the Master Copy elements cannot be linked. The Master
Copy Locale ID value defines the particular Locale ID that identifies the Master Copy content elements.
By default this is set to 0, so all GS1 XML elements with Locale ID 0 are taken as a Master Copy element.

The Show nominal values for the number of occurrences (GS1 only) option changes the way the
number of occurrences is diplayed in the Advanced view. See Indication of the number of occurrences
on page 52. If the option is enabled, the Advanced View displays how many times the link is actually
used within the artwork. If disabled, the difference between the actual and the expected number of
occurrences is shown.

3.9.  Appendix: Introduction to XML

This Appendix gives a very brief overview of the basic concepts and terminology of the eXtensible
Markup Language (XML) standard.

3.9.1.  What is XML

XML is a text-based markup language that is fast becoming the standard for data interchange.

As with HTML, you identify data using tags (identifiers enclosed in angle brackets, like this: <...>).
Collectively, the tags are known as "markup".

But unlike HTML, XML tags identify the data, rather than specifying how to display it. Where an
HTML tag says something like "display this data in bold font" ( <b>...</b> ), an XML tag acts like a field
name in your program. It puts a label on a piece of data that identifies it (for example: <message>...</
message> ).

3.9.2.  Semantic Markup

Since identifying the data gives you some sense of what means (how to interpret it, what you should
do with it), XML is sometimes described as a mechanism for specifying thesemantics (meaning) of the
data.
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In the same way that you define the field names for a data structure, you are free to use any XML tags
that make sense for a given application. Naturally, though, for multiple applications to use the same
XML data, they have to agree on the tag names they intend to use.

Here is an example of some XML data you might use for a messaging application:

<message> 
<to>you@yourAddress.com</to> 
<from>me@myAddress.com</from> 
<subject>XML is really cool</subject> 
<text>How many ways is XML cool? Let me count the ways...</text> 
</message>

The tags in this example identify the message as a whole, the destination and sender addresses, the
subject, and the text of the message. As in HTML, the <to> tag has a matching end tag: </to> . The
data between the tag and and its matching end tag defines an element of the XML data. Note, too, that
the content of the <to> tag is entirely contained within the scope of the <message>..</message> tag.
It is this ability for one tag to contain others that gives XML its ability to represent hierarchical data
structures

3.9.3.  Tags and Attributes

Tags can also contain attributes - additional information that is included as part of the tag itself, within
the tag's angle brackets.

The following example shows an email message structure that uses attributes for the "to", "from", and
"subject" fields:

<message to="you@yourAddress.com" from="me@myAddress.com" subject="XML Is Really Cool"> 
<text>How many ways is XML cool? Let me count the ways...</text> 
</message>

Since you could design a data structure like <message> equally well using either attributes or tags, it
can take a considerable amount of thought to figure out which design is best for your purposes.

3.9.4.  What is IPC XML

IPC XML is a flavor of XML that was designed with the specific purpose of content interchange
between brand owners and their suppliers.

It is an open format that borrows concepts from the JDF specification made by the CIP4 organization.
The IPC XML schema was designed by the Intelligent Packaging Consortium, an informal workgroup
consisting of brand owners, retailers, software vendors, consultants and packaging designers.

Dynamic Content can work with various flavors of XML (XHTML, PIM, SPL, …). The plug-in does not
place any restrictions on the XML formats you can use as long as the XML files you add to the palette
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are well-formed. However, because the IPC XML schema is designed specifically for use in packaging,
Dynamic Content has a number of features that make working with IPC-based XML files easier.

3.9.5.  The IPC XML Schema

The root of an IPC XML file is called <CopyContent>. It contains 3 sections: <RevisionHistory>,
<Project> information and a <Copy> section which contains a number of <CopyElement> elements that
contain the actual textual contents.

Understanding a sample file

The following XML file clearly shows the three sections in an IPC XML file. All the content is enclosed
in the root <CopyContent> tag. Following that, you see:

• The <RevisionHistory> element, showing that this document is now at version 1.1, after a revision
by Mr. Jerry Morris.

• The <Project> element informs us that the project is called Diapers Test, and is meant for
the USA region. The project encompasses 5 Pieces of Art (POAs): there will be five Illustrator
documents that use information from this XML file.

• The <Copy> element lists that text content, including CopyElements for the Brand Name
(Pampers), Package Count (ranging from 30 to 50 diapers), and a Generic element that shows how
you can add any other textual content to the IPC XML.

<?xml version="1.0" encoding="UTF-8"?>

<CopyContent xmlns="http://www.esko.com/IPCSchema_1_0" Version="1.0" AgentName="PG ACT"
 AgentVersion="1.0">

 <RevisionHistory RevisionNumber="1.1">
  <Revision Type="Original" Author="Jerry Morris" RevisionNumber="1.0"
 TimeStamp="2007-01-31T12:00:00+01:00" />
  <Revision Type="Change" Author="Jerry Morris" RevisionNumber="1.1"
 TimeStamp="2007-01-31T13:00:00+01:00" />
 </RevisionHistory>

 <Project ProjectName="Diapers Test" ProjectID="P1" Region="USA">
  <POAs>
   <POA ID="Common" Name="Common CopyElements" Locales="en-US es-US"/>
   <POA ID="P1_30" Name="Pampers 30 diapers for US" Locales="en-US es-US" />
   <POA ID="P1_40" Name="Pampers 40 diapers for US" Locales="en-US es-US" />
   <POA ID="P1_50" Name="Pampers 50 diapers for US" Locales="en-US es-US" />
   <POA ID="P1_50_ES" Name="Pampers 50 diapers for US, Spanish only" Locales="es-US" />
  </POAs>
 </Project>

 <Copy>
  <CopyElement ID="CP001" CopyElementType="Brand Name" SourceRef="NamesDict"
 CopySourceRef="21321" POAs="Common">
   <body>Pampers</body>
  </CopyElement>
  <CopyElement ID="CP002" CopyElementType="Package Count" Locale="en-US" Panels="Front
 Back" POAs="P1_30">
   <body>Contains 30 diapers</body>
  </CopyElement>
  <CopyElement ID="CP003" CopyElementType="Package Count" Locale="en-US" Panels="Front
 Back" POAs="P1_40">
   <body>Contains 40 diapers</body>
  </CopyElement>
  <CopyElement ID="CP004" CopyElementType="Package Count" Locale="en-US" Panels="Front
 Back" POAs="P1_50">
   <body>Contains 50 diapers</body>
  </CopyElement>
  <CopyElement ID="CP007" CopyElementType="Package Count" Locale="es-US" Panels="Front
 Back" POAs="P1_50_ES">

101



3 Dynamic Content Essentials

   <body>Contiene 50 pañales</body>
  </CopyElement>
  <CopyElement ID="CP005" CopyElementType="Generic" Locale="en-US" POAs="P1_30 P1_40
 P1_50">
   <body>How are you?</body>
  </CopyElement>
  <CopyElement ID="CP006" CopyElementType="Generic" Locale="es-US" POAs="P1_30 P1_40
 P1_50 P1_50_ES">
   <body>Que tal estas?</body>
  </CopyElement>
 </Copy>

</CopyContent>

3.9.6.  What is GS1 XML

GS1 is an international non-profit association with member organisations in over 100 countries. GS1
is dedicated to the design and implementation of global standards and solutions to improve the
eciency and visibility of supply and demand chains globally and accross sectors. The GS1 system of
standards is the most widely used supply chain standards system in the world.

For more information on GS1 eCom, see http://www.gs1.org/gsmp/kc/ecom

For more information on the BMS XML standard, see http://www.gs1.org/gsmp/kc/ecom/xml/

3.10.  Glossary

This Glossary gives you an overview of some basic concepts and terminology used in this manual, and
what they mean in the specific context of the Dynamic Content plug-in.

Dynamic Object
An Illustrator text object that has been linked to an XML element from an external file by the Dynamic
Content plug-in. Dynamic Objects have a number of special characteristics, which makes them behave
differently than normal Illustrator text.

IPC
The Intelligent Packaging Consortium (IPC) is an informal workgroup consisting of brand owners,
retailers, software vendors, consultants and packaging designers. The IPC workgroup designed the
IPC XML Schema, a standard document structure for exchanging data between brand owners and their
suppliers.

Node
A node is an item in an XML document's tree structure. Node is a generic term - this means nodes can
have different types: XML element nodes, XML attribute nodes, text nodes, ...

XML Attribute
A qualifier on an XML tag that provides additional information. For example, in the tag <slide title="My
Slide">, title is an attribute, and My Slide is its value.
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XML Element
A unit of XML data, delimited by tags. An XML element can enclose other elements. For example, in the
XML structure:

<slideshow>
   <slide>..</slide>
   <slide>..</slide>
</slideshow>

the <slideshow> element contains two <slide> elements.

XML File
A file with contents in the form of XML markup. XML markup is similar to HTML in that it also uses tags
enclosed by angled brackets (example: <element>), but it describes the structure of the data instead of
how it should be presented or rendered in a web browser.

XML Schema
A method for specifying the structure to which an XML document needs to adhere. For example, the
IPC XML schema specifies that documents should contain a root element <CopyContent>, followed by
the child elements <RevisionHistory>, <Project>, <Copy> in this exact order.
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4.  Dynamic Art

4.1.  About the Dynamic Art plug-in

What is “dynamic art”?
The Dynamic Art plug-in allows you to quickly tag the placeholder type objects, table objects and
barcodes that you created in your Illustrator design as “Dynamic Art” objects.

Any object that will receive its final textual content at a later stage in the design process, based on
the content in an XML file, can be turned into a Dynamic Art object. Empty text objects added to the
Dynamic Art palette are automatically filled with dummy text; you cannot have an empty dynamic
text object. If you create a text object in Illustrator with your own text, than that text is added to the
Dynamic Art palette as soon as you convert it to a dynamic object.

All Dynamic Art objects you create in an Adobe Illustrator document are listed in the Dynamic Art
palette.
 

 

Dynamic Art objects are saved in the Illustrator document. This allows one designer to define Dynamic
Art objects, then pass the file on to other designers. These people can then use the same Dynamic Art
objects to link in the final content.

4.2.  Why Use Dynamic Art?

Dynamic Art is used in a Dynamic Content workflow. Dynamic Content is an Esko plug-in for Adobe
Illustrator that allows you to link content from an external XML file to objects (type, tables, barcodes,
Illustrator symbols, and external images) in the Illustrator document.

The suggested workflow for using Dynamic Art in combination with Dynamic Content is the following:
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Phase Description

1 The designer creates a design in Adobe Illustrator. In the design, dummy or
“placeholder” objects are placed where dynamic content will be linked later on in the
production process. These objects can be:

• type objects created with the Illustrator Type tools;

• barcodes created with the Esko Dynamic Barcodes plug-in;

• nutritional and other tables created with the Esko Dynamic Tables plug-in;

• Illustrator symbols;

• External images.

2 Once the design is finalized, the designer selects all the placeholder objects and adds
them to the Dynamic Art palette.

3 Later in the production process, the brand owner supplies the approved textual content
for the design, in the form of an XML file.

4 Using the Esko Dynamic Content plug-in, the designer adds the XML content file to the
Illustrator document and Auto Links the content if possible, or links them manually to
the corresponding content from the XML file.

The file is now ready for final approval and for the next steps in the production process.

4.3.  The Dynamic Art Palette

The Dynamic Art palette can be opened by choosing Window > Esko > Dynamic Art.

 

 

1. Filter buttons: from left to right, these are Show All Dynamic Art, Show Barcode Art, Show Table
Art, Show Type Art, Show Image Artand Show Symbol Art.

2. Dynamic Art list.
3. Unlink Dynamic Art
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4. Select and zoom to object button.
5. New Dynamic Art button.
6. Delete Dynamic Art button.
7. Link indicator indicates how the placeholder is linked. The color of the symbol represents the color

of the XML file used in Dynamic Content.

• XML with a filled circle: all links in the Dynamic Art were applied

• XML with a half-filled circle: some statements in the Dynamic Art were applied when linking to
the XML, others were not found in the XML, so they become orphans

• XML without a circle: a placeholder with just a single text statement, already linked to an XML
element in Dynamic Content.

• CHILI: the placeholder is linked to a CHILI Package.
8. Linked Dynamic Art indicator

•
The Linked icon  indicates the Dynamic Art is linked to a particular object

•
The Unlinked icon  indicates the Dynamic Art is not linked to a particular object, so it's a
virtual placeholder.

9. Selection indicator: a colored dot indicates the object linked to the Dynamic Art is selected in your
Adobe Illustrator document. You can also click the location of the Selection indicator to select the
corresponding objects, when possible.

Tip:  You can drag and drop items within the palette in Show All Dynamic Art view, to keep them in a
logical order (not connected to the order in the Layer palette). When exported to and opened in CHILI,
the text placeholders will be shown in the order set in the Dynamic Art palette.

4.4.  The Content Types palette

The Content Types palette can be opened by choosing Window > Esko > Dynamic Art > Content Types.
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1. Search: typing into the Search field reduces the list of Copy Element Types to those containing the
entered string.

2. Filters: Clicking the + button, you can add optional filters to reduce the Copy Element Types shown
in the list. Each filter can be enabled or disabled using the checkbox.

3. Copy Element Types list. A list of Copy Element Types (reduced by the Search and the Filters) from
which you can select the desired items to assemble the Dynamic Art.

4. Use the Language Index and Instance dropdown to define the Language definition of the future
Dynamic Art and its Instance ID. Those values will be used with the selected Copy Element Types to
assemble the Dynamic Art.

5. The Number of Occurrences indicates how many times the selected GS1 Copy Element with the
specific Language Index and Instance ID is defined within Dynamic Art, regardless if it's linked to an
Adobe Illustrator object or not.
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6. New: if no artwork is selected, the New button will add the Copy Element Type to the Dynamic Art
list as a virtual placeholder. If an object is selected, the Copy Element Type is added to the Dynamic
Art list, and the selected object is converted to the Dynamic Art

7. If a Dynamic Art is selected in the Dynamic Art palette, the Append button in the Content Types
palette can be used to add the selected Copy Element Type with selected Language and Instance ID
to this Dynamic Art.

From the fly-out menu of the Content Types palette you can open the Dynamic Art Preferences. See
Dynamic Art Preferences on page 114

4.5.  Dynamic Art on the Canvas

By default, Dynamic Art highlights the Dynamic Art objects on the Illustrator canvas that you have
added to the Dynamic Art palette. The highlight takes the form of a colored box around the object, with
a heading that represents the type of object, and that provides further information such as intended
content locale and instance.

4.6.  Working with Dynamic Art

4.6.1.  Create a Dynamic Art Object

If it is not yet visible, choose Window > Esko > Dynamic Art > Dynamic Art to display the Dynamic Art
palette, or Window > Esko > Dynamic Art > Content Types to open the Content Types palette.

• To create a linked object directly:
a) On the Illustrator canvas, select the object you want to add as a Dynamic Art object.
b) Click the New Dynamic Art button at the bottom of the palette.

The object is converted into a Dynamic Art object: it is listed in the Dynamic Art palette, and it is
highlighted on the canvas.

• To create a linked object using the Content Types palette:
a) On the Illustrator canvas, select the object you want to add as a Dynamic Art object.
b) In the Content Types palette, select one or more Content Element Types.
c) Select the Language Index and Instance ID
d) Click the New button.

The object is converted into a Dynamic Art object: it is listed in the Dynamic Art palette, and it is
highlighted on the canvas.

Note:  If the Content Type is applied on objects other than text objects, only the selected
Instance ID is applied.

• To create a Virtual placeholder:
a) In the Content Types palette, select one or more Content Element Types.
b) Select the Language Index and Instance ID
c) Click the New button.
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A new Virtual placeholder is created, containing the XML attributes with parameters defined
by the selection, so one or more Copy Element Types with the common Locale and Instance
definition.

Note:  If no Content Type is selected, you will be able to decide what type of Dynamic Art should
be created: Text, Barcode, Table, Symbol or Image. A Virtual placeholder of the selected type
and Instance ID is created.

• To link a Virtual placeholder to an object:
a) On the Illustrator canvas, select the object you want to convert to a Dynamic Art object.
b)

In the Dynamic Art palette, select a Virtual placeholder and click the Unlinked icon 

The object becomes a linked Dynamic Art and the Virtual placeholder changes to a linked
Dynamic Art with the same XML attributes and parameters.

• To unlink Dynamic Art from an object:
a) Select a Dynamic Art in the Dynamic Art palette
b)

Click the Unlink button  at the bottom of the palette, or double-click the Linked icon .

The linked object loses its link to the Dynamic Art and becomes a regular object. The Dynamic
Art stays in the list as a Virtual placeholder.

• To add XML attributes to the Dynamic Art:
a) Select a Dynamic Art in the Dynamic Art palette, either Linked or Virtual.
b) In the Content Types palette, select one or more Content Element Types.
c) Select the Language Index and Instance ID
d) Click the Append button.

The selected XML attributes will be appended to the Dynamic Art.

4.6.2.  Viewing and Navigating to Dynamic Art

Dynamic Art provides more than just a list of Dynamic Art objects. You can:

• Select a specific Dynamic Art object in the document by clicking to the right of its entry in the
Dynamic Art palette, similar to how you select an Illustrator layer in the Layers palette.

• Select a specific Dynamic Art object in the Dynamic Art palette and zoom to it by clicking the Select
and zoom to object button at the bottom of the Dynamic Art palette.

• Filter the list of placeholder objects in the Dynamic Art palette by clicking the appropriate filter
button at the top of the palette:

• Show Barcode Art
• Show Table Art
• Show Type Art
• Show Image Art
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• Show Symbol Art

4.6.3.  Fill Type Objects with Dummy Text

To fill an existing Dynamic Art type object with Lorem Ipsum text, select the object in the Dynamic Art
palette and choose Fill with Dummy Text from the fly-out menu. New empty type objects automatically
get filled with Lorem Ipsum text when you make them Dynamic Art objects.

4.6.4.  Edit and Delete Dynamic Art Objects

• To rename a Dynamic Art object, select it and do one of the following:

• double-click its entry in the Dynamic Art palette. Type a new name and click OK.
• choose Properties from the fly-out menu. Type a new name and click OK.

Note:  This only changes the name of the object in the Dynamic Art palette. It does not affect the
text content of the object in the Illustrator document or the label name of the highlight canvas.

• To delete a Dynamic Art object, select the object in the Dynamic Art palette and either:

• choose Delete from the fly-out menu; or
• click the Delete button at the bottom of the palette.

Note:  This only deletes the Dynamic Art object. The original type, barcode or table object on the
Illustrator canvas is not removed.

4.6.5.  Define Properties for Type Art

For type objects that have been added to the Dynamic Art palette, you can provide some additional
properties.

To change the properties:

1. Double-click the type object in the Dynamic Art palette, or select the entry and choose Properties
from the fly-out menu.

2. Set the Attributes. The parameters are divided in different groups:

• 1. Formatting options. See Formatting Options on page 111.
• 2. The list of Text Statements. See The Text Statements list on page 112
• 3. For every Text Statement in the list, you can set the Statement Settings. See XML Parameters

on page 112
• 4. CHILI Publisher parameters. For more information on the CHILI settings, we refer to the

CHILI documentation. These are only visible if the CHILI Publisher option is enabled in the
Preferences. See Dynamic Art Preferences on page 114.

• 5. Videojet Marking. See Videojet Marking on page 113. These are only visible if the Videojet
Marking option is enabled in the Preferences. See Dynamic Art Preferences on page 114.

3. Click OK
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Formatting Options
In the Formatting options, you can set some formatting options, and set automatic modification of the
Dynamic Object size or the text size within the Dynamic Object.

 

 

Paragraph Settings
In the Paragraph settings you can set

• if paragraphs should be preserved in the XML
• to add a space in between links
• if you want to remove whitespaces from the XML

Fit Text Frame to Contents
If you use Fit Text Frame to Contents, the text box will grow to fit the actual text content, coming from
the XML source. The text box size will be adapted every time the XML source changes.

This option is useful when you're not sure what amount of text will come from the XML, and you want to
avoid text overflow.

• The Direction defines in what direction the text box can grow: down, up, to the left or to the right.

• Using Minimum Height and Maximum Height (or width, depending on the direction) you can define
the minimum and maximum size for the text box.

Note:  This option is only available for Area Text objects, so not for Text on Point or Text on Path

Fit Contents to Text Frame
If you use Fit Contents to Text Frame, the font size will change to fit the text frame.

This option is useful when the space for the text is limited, and font size changes are allowed by the
design rules.

• The Minimum Text Size and Maximum Text Size define the minimum and maximum font size to be
used.

Note:  This option is only available for Area Text objects and Text on Path, so not for Text on Point.
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The Text Statements list
In the Text Statements list you define the text statements you want to use in the selected Dynamic Art

• Add a Text Statement by clicking the + button.
• Remove a Text Statement by clicking the - button.
• Change the order of the Text Statements by clicking the arrow buttons
• Select a Text Statement in the list to change its settings underneath. See XML Parameters on page

112

XML Parameters
For every Text Statement in the list, you can set the Statement Settings.

If you set these properties, Dynamic Content will filter the list of available elements to only show the
matching elements, further simplifying the task of the person linking the Dynamic Art objects to the
XML content.

Dynamic Art will also provide the Auto link feature, allowing the automatic filling of Dynamic Art
placeholders with matching GS1 or IPC XML content.

Note:  In the Preferences, you can choose between the GS1 standard or the IPC standard. You can also
apply Custom CET files. Depending on these settings, the dialog will look differently. See Dynamic Art
Preferences on page 114

1. Define the GS1 or IPC XML Content Type from a file that should be linked to this type object
2. Define the language for use in multilingual GS1 or IPC files

• For the IPC XML standard workflow, define the locale (for example "en-us" for US English) of the
object or the Locale Variable. See also Use Locale Variables for Type Elements (IPC XML standard
only) on page 113

• For the GS1 XML standard, define the Language Index. Language Index represents the GS1
localeSequence tag, whose mapping is defined in the header of the GS1 XML.

3. For the GS1 XML standard, define the  Instance ID , which is used for differentiating multiple objects
of the same content type.

For example, the GS1 XML file can hold the content of the "MARKETING_CLAIM" type in the short
and in the long variant, one for the front package panel, the second for the side panel, and these
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elements then have the same content type (Marketing claim) defined but different Instance ID
(GS1 tag instanceSequence). This unique identification is crucial for further Automatic linking in
Dynamic Content and is one of the main advantages of the GS1 XML standard.

4. Set the Prefix and Sux
This allows you to add static text, line brakes, etc. in between Text Statements.

5. The palette will give an indication of how many times the Content Type has been used in your
document in Linked Dynamic Art, and in Virtual placeholders (i.e. not linked to an actual object in
your document).

Use Locale Variables for Type Elements (IPC XML standard only)
If you are creating multi-region products, instead of assigning a specific locale to text objects, you can
assign locale variables. This way, when you link an multilingual XML content file in Dynamic Content,
the proper language is applied to the text objects.

1. In the Dynamic Art palette, select the type objects to assign a locale variable to and choose
Properties from the fly-out menu.

2. In the Dynamic Art Options dialog box, choose the appropriate Content Type for the data in the
XML content file.

3. Select Assign a specific locale if you want to assign a specifc language and country, or select
Assign a locale variable and enter a variable name (such as L1) in the appropriate field.

4. Click OK.
5. Repeat steps 1 to 4 for objects that will be in other languages, using different languages, or different

variables such as L2 and L3.
6. You can now use Dynamic Content to map the locale variables, add the XML content file, and Auto

Link so that the type objects are filled automatically with the correct text. See the Dynamic Content
User Guide for more information.

Videojet Marking
Using Videojet Marking you can export Dynamic Art placeholders to a specific ZPL (Zebra label printer)
format. All Dynamic Art objects can be tagged to become either Static, Dynamic Text or Dynamic Date
when exporting the ZPL file.

To create the ZPL file, choose Videojet Export in the fly-out menu. All non-text Dynamic Art
placeholders will be exported as PNG images besides the ZPL file.

4.7.  Export XML Template

The Export XML Template can be found in the fly-out menu of the Dynamic Art Panel.

This feature collects information of Dynamic Art text objects. The following will be collected from
Dynamic Art:

• Locale ID (GS1) or Locale / Locale Variable (IPC)
• CopyContent type
• Text content
• Barcode values
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• Paths to linked images
• Symbol/Symbol Library names

Then the XML file is exported, in the format specified by the XML standard (GS1 or IPC) set in the
Preferences. In the XML file, each Dynamic Art text object will be represented by the proper content
elements according to the selected XML standard schema.

Note:  When exporting to IPC, the path to linked images and references to symbols are not included in
the XML file.

This XML Template file can be easily used as a template for future filling by the real content.

4.8.  Saving and Loading Dynamic Art Sets

If multiple similar documents need to have the same set of Dynamic Art, you can use a Dynamic Art
Set.

You can set the Dynamic Art on the first document, and then save the Dynamic Art Set. On the second
document, you can then load the Dynamic Art set, so the Dynamic Art palette is filled with Virtual
placeholders using the same settings as in the first document. You can then easily link those to artwork
objects instead of defining them from scratch.

• From the fly-out menu of the Dynamic Art palette, select Save Dynamic Art Set to save all Dynamic
Art from the list, including all their parameters, in an XML file.

• From the fly-out menu of the Dynamic Art palette, select Load Dynamic Art Set to load all Dynamic
Art saved in an XML file.
If your document already contains Dynamic Art, you will be asked if you want to replace or extend
the existing Dynamic Arts

• Select Replace to remove the existing Dynamic Art before loading the Dynamic Art Set
• Select Extend to append the Dynamic Art Set after the existing Dynamic Art.

4.9.  Dynamic Art Preferences

You can open the Dynamic Art Preferences by choosing Illustrator > Preferences > Esko > Dynamic Art
Preferences

You can choose if you want to see the CHILI Publisher or Videojet Marking options in the Dynamic Art
Options palette. See Define Properties for Type Art on page 110

The  XML Standard option determines the default behavior related to the XML standards. If the GS1
standard is selected (default option), the Dynamic Art Options dialog allows entering the GS1 XML
specific parameters and the Export XML Template exports an XML file valid against the GS1 XML
schema. The IPC option changes the behavior to let these options and files conform with the IPC XML
schema. See Define Properties for Type Art on page 110

Always save links to resources into XMP and XML Template Using Absolute Paths: If this option is
on, links to sources (the XML file loaded in Dynamic Content, and image resources) will be saved as
absolute paths when saving XMP or XML Template.
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If the option is off, paths are saved relative to the Adobe Illustrator document.

The values set in Default Language Index and Default Instance ID will be used as default when creating
a new Dynamic Art link definition, both for virtual placeholders as for Dynamic Art based on a text box.

Note:  Changes in the Default Language Index and Default Instance ID only take effect after restarting
Adobe Illustrator.

Custom CET Files
If no Custom CET Folder is defined, the Content Types are used from the default CET file, included
when installing Dynamic Art.

If the Custom CET Folder contains Custom CET Files, the Content Types from the Custom CET Files are
shown, as well as the default Content Types.

If you enable Use Only Custom CET Files, the default Content Types are no longer shown, only those
defined in the Custom CET Files.
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5.  Dynamic Barcodes

5.1.  What is a barcode ?

A barcode is a machine-readable representation of information in a visual format on a surface.
Barcodes can be read by optical scanners, allowing quick and easy identification of all kind of goods.

Originally barcodes stored data in the widths and spacings of printed parallel lines, but today they also
come in patterns of dots, concentric circles, and hidden in images.

The information contained in a barcode varies from numbers to complete ASCII texts. The drive to
encode ever more information in combination with the space requirements of simple barcodes led to
the development of matrix barcodes or 2D barcode, which do not consist of bars but rather a grid of
square cells.

Barcodes are just the visible part of often quite large systems frequently referred to as automated
identification systems. These systems are increasingly proving to be some of the most cost-effective
management tools, since they enable organizations to keep track of their goods and stocks in all kinds
of situations in a fast, accurate and ecient way.

With the Dynamic Barcodes plug-in, you can add a dynamic barcode to your document without leaving
your application. Dynamic means that your barcode settings can be changed later on, even after you
saved, closed and reopened your document.

5.2.  Getting Started with Dynamic Barcodes

To introduce you to Dynamic Barcodes, here is how to make your first barcode in four simple steps.

1. Create a CMYK Illustrator document and go to Windows > Esko > Dynamic Barcodes.

This opens the Dynamic Barcodes dialog.
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2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no

stroke.
 

 
3. Enter the barcode parameters (Barcode Type, numeric Code...) in the Dynamic Barcodes dialog.

For example, for an EAN 13 barcode, select EAN 13 as Barcode Type and enter a 13 digit Code.
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4. Click the Create button and Dynamic Barcodes will generate the barcode in your document.
 

 

5.3.  Using Dynamic Barcodes in Unlicensed Mode

If you don't have a license for the Dynamic Barcodes plug-in, you still use it in unlicensed mode to
perform limited operations. You can:

• Open documents containing barcodes created by Dynamic Barcodes without warning messages.
• Create barcode placeholders (with no data in them) in your design.

See Creating a Barcode Placeholder Quickly on page 124.

You can also use the regular Illustrator functions to:

• change the barcode's position in your document,
• rotate it by multiples of 90 degrees (using Object > Transform > Rotate),

Tip:  You can rotate several barcodes at once.

• change its fill color (it is not possible to apply a stroke),

Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be dicult to scan).

• copy and paste it.
• delete it.

5.4.  Dynamic Barcodes Basics
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5.4.1.  Creating a Barcode

1. Create a CMYK Illustrator document and go to Windows > Esko > Dynamic Barcodes.

You can also use the Command + Option + 4 shortcut on Mac, or the CTRL + Alt + 4 shortcut on PC.

This opens the Dynamic Barcodes dialog.
 

 
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no

stroke.

Dynamic Barcodes creates bars by generating rectangular objects and assigning the current fill
style to them.
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Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),
• not too light (or the barcode might be dicult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.
4. Enter a Rotation angle for your barcode, or use one of the rotation buttons. Choose the Orientation

of your barcode using one of the buttons or by entering an angle.
5. Enter the barcode's data in the Code field. For most barcodes, you can choose to also show this

data as a (human-readable) number.

Attention:  Make sure the barcode data you enter is valid for the barcode type you chose. If
it isn't, a warning / error will pop up.
 

 

Note:  If you enter a wrong check digit, Dynamic Barcodes can fix it automatically for you.
 

 

6. To fill in other parameters specific to the barcode type you chose, open the Additional parameters
section and see Barcode Types on page 144.
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7. Click the Create button.

• If you have the boostX plug-in installed, Dynamic Barcodes generates your barcode at the
intersection of the boostX crosshair.

• If you don't have the boostX plug-in installed, Dynamic Barcodes generates your barcode in the
center of the view.
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5.4.2.  Editing a Barcode

With Dynamic Barcodes, you can also edit existing barcodes.

1. Open the Dynamic Barcodes.
2. Select the barcode to edit in your Illustrator document.
3. Change its parameters as you wish in the Dynamic Barcodes dialog.

Note:

If you change the Barcode Type and the previous Code is not valid for this barcode type, Dynamic
Barcodes will reset it to the (first) default code for this barcode type.

This is the default code used for placeholder barcodes; you can see it in the preset barcodes dialog
(see Previewing and Creating a Barcode Placeholder on page 125).

You can then either:

• enter your own valid code,

• use this default code to create a placeholder barcode (see Creating a Barcode Placeholder
Quickly on page 124).

4. Click the Apply button to apply your changes to the barcode.

5.4.3.  Setting Barcode Parameters to Default

• To reset all the parameters of the selected barcode to default, click the palette menu  in the
top right corner of the Dynamic Barcodes dialog then click Set Default Parameters.
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Note:  The Bar Width Reduction, Device Compensation and Snap Bars to Output Resolution
parameters are not reverted to the defaults, since these parameters are related to the press
settings, and not related to the selected barcode.

5.4.4.  Barcode Placeholders

If you don't have the exact data to encode in your barcode yet, you can already create a barcode
placeholder in your design.

This placeholder will have the correct symbol type for the barcode type you choose, but will only
contain “empty” or “default” data (for example 0000000000000 for EAN 13).
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Creating a Barcode Placeholder Quickly
1. Open the Dynamic Barcodes dialog from Windows > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no

stroke.
 

 

Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be dicult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.

The Code field is automatically filled out with a nul / default value that has the correct number of
digits for your Barcode Type (for example 0000000000000 for EAN 13).
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4. Click the Create button to create your barcode placeholder.

 

 

Note:  You can also create a barcode placeholder in unlicensed mode (see Using Dynamic Barcodes in
Unlicensed Mode on page 118).

Previewing and Creating a Barcode Placeholder
You can use Dynamic Barcodes to preview different barcode types before creating your barcode
placeholder.

1. Open the Dynamic Barcodes dialog from Window > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no

stroke.
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Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be dicult to scan).

3.

In the Dynamic Barcodes dialog, click the Pre-set barcodes icon .

This opens the Select Barcode dialog.

 

 
4. Select your Barcode Type on the right to see a Preview of it on the left.
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Note:  This shows previews of barcode placeholders. Your actual barcode (with data and specific
parameters affecting its size) may look slightly different. For more information on barcode
parameters, see Barcode Types on page 144.

5. If your barcode data can have several possible lengths (for example EAN 13 can have 13, 15 or 18
digits), choose the length you want to preview in Code Preset.
 

 
6. If your barcode can have a Composite Component (some GS1 barcodes), you can choose to preview

it with or without that component.
 

 
7. Click OK to use the preview parameters (Barcode Type, Code Preset and Composite Component as

applicable) in the Dynamic Barcodes dialog and close the Select Barcode dialog.
8. In the Dynamic Barcodes dialog, click the Create button to create your barcode placeholder.

 

 

5.4.5.  Expand

By using the Expand function, you can replace a barcode by regular objects (rectangles, text, …) in a
group, without any barcode information.
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Note:  Adobe Illustrator also contains an "Expand" function. However, since this does not remove the
barcode metadata, the barcode remains editable.

1. Select the barcode you want to expand
2. From the fly-out menu of the Dynamic Barcodes panel, select Expand

Note:  Barcodes used by Dynamic Marks and Dynamic VDP can't be expanded.

5.5.  Dynamic Barcodes Advanced

5.5.1.  Choosing a Font Standard

You can choose between two font standards for the human-readable characters of your barcodes.

1. Go to Illustrator > Preferences > Esko >  Dynamic Barcodes Preferences... to open the Dynamic
Barcodes Preferences dialog.
 

 
2. Choose either OCR-B Standard or OCR-B Bitstream and click OK.

OCR-B Standard fonts are rounder and
typically used in the Western market.

 

 

OCR-B Bitstream fonts are typically used in
the Asian market.
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Note:  If the OCR-B Bitstream font is not installed on your system, the option will be disabled. Esko
does not provide this font.

5.5.2.  Using Dynamic Content with Dynamic Barcodes

You can use the Dynamic Content plug-in to turn barcodes created with Dynamic Barcodes into XML-
driven objects. These barcodes update automatically when the XML files to which they are linked
change.

For more information, see the Dynamic Content documentation.

5.5.3.  Barcode Protection

Once you create a barcode with Dynamic Barcodes, this barcode is protected. This means that it
won't be possible to edit it with most regular Illustrator tools. This protects the barcode against
modifications that might render it invalid, for example distorting it or modifying its size.

The only transformation allowed is moving or rotating the barcode. When rotating the barcode,
a message is shown in the Messages palette, and the barcode's Rotation parameter is adapted
accordingly.

You can still edit the barcode's parameters at any time through the Dynamic Barcodes dialog.

Protecting a Barcode
You can protect a Dynamic Barcodes barcode that has been unprotected, or a barcode made in a
previous version of Dynamic Barcodes.

1. Open the Dynamic Barcodes plug-in.
2. Select the barcode to protect in your Illustrator document.
3. If necessary, change its parameters in the Dynamic Barcodes dialog.
4. Click the Apply button to apply the parameter changes and protect your barcode.

Tip:  You can use this to fix some invalid barcodes.

Handling a Barcode without Dynamic Barcodes

Opening a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes

When opening a document containing a Dynamic Barcodes barcode in an Illustrator application that
doesn't have the Dynamic Barcodes plug-in, you will get the following warning:
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This doesn't create any problem in your file, and you can continue to work with this file as you normally
would, without editing the Dynamic Barcodes barcode.

If you need to edit the Dynamic Barcodes barcode with your Illustrator application, see Editing a
Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes on page 130.

Editing a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes
If you don't have the Dynamic Barcodes plug-in, you can still use Illustrator to do the following
operations without rendering your barcode invalid.

If you don't have Dynamic Barcodes installed, you will not be able to

• move or scale the object using the Selection tool
• move or distort it (reflect, shear or scale)
• change a color

You will be able to

• expand the bar code
• Rotate by Selection or Free transform - this can lead to inconsistent results so we recommend not

doing this.
• move, rotate and distort by the Transform Each command - this can lead to inconsistent results so

we recommend not doing this.
• enclose it in the Envelope and distort
• delete it
• copy and paste it

If the Dynamic Barcode plugin is installed, but without a valid license, you will be able to do everything
that is allowed by the plugin, except modifying the content. This means for example moving and
rotating is allowed, but due to the bar code protection, any potentially dangerous operations such as
scale, reflect or shear are not allowed. You will also be able to change the color of the bar code.

Unprotecting a Dynamic Barcodes Barcode for Further Editing
You can expand your Dynamic Barcodes barcode to a regular Illustrator group art to be able to edit it
further, but this is not recommended as it will remove the barcode's protection.

Attention:  It will then be possible to make modifications that might render the barcode
invalid.

1. To do this, go to Object > Expand... in the Illustrator menu.
2. Choose the object's characteristics to expand, then click OK.

 

130



5Dynamic Content Essentials

 

This turns your barcode into a regular Illustrator object. You can now for example edit each bar of the
barcode individually.

5.5.4.  Exporting Documents with Barcodes

If you are using other Esko applications, you can export Illustrator documents containing barcodes to
the Esko Normalized PDF format, preserving the barcodes' information and editability.

Viewing Barcode Information in Other Esko Applications
1. Export your Illustrator document to the Esko Normalized PDF format:

• If you have Automation Engine, use Shuttle to launch the document into your chosen workflow.
This converts it to Normalized PDF automatically.

Note:  See the Adobe Illustrator Client documentation for setup information.

• If you don't have Automation Engine, use File > Export and choose Normalized PDF as the export
format.

2. Select (in Automation Engine) or open (in PackEdge / Acrobat) your document and open the XMP
information as explained below:

If you have... go to...

Automation Engine File > Info.

PackEdge File > XMP Info.

the Esko XMP plug-in in Adobe Acrobat Esko > XMP Document Info...

3. Click Barcodes in the Data type column (as below in PackEdge) to show the barcode information.
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For more information, see the Shuttle, Automation Engine, PackEdge or XMP plug-in documentation.

Editing Barcodes in Other Esko Applications
The Dynamic Barcodes functionality is available both as a DeskPack plug-in and in PackEdge.

• To edit your document containing barcodes in PackEdge:
a) Export your Illustrator document to the Esko Normalized PDF format:

• If you have Automation Engine, use Shuttle to launch the document into your chosen
workflow. This converts it to Normalized PDF automatically.

Note:  See the Adobe Illustrator Client documentation for setup information.

• If you don't have Automation Engine, use File > Export and choose Normalized PDF as the
export format.

b) Open your document in PackEdge.
c) Go to Production > Bar Code... to edit your barcode as you would edit it with Dynamic Barcodes.

For more information, see the Shuttle and PackEdge documentation.

5.6.  Barcode Recognition

Barcode Recognition is a new function in Dynamic Barcodes to convert vectorized (contourized)
barcodes and images (e.g. a scanned in barcode) back into live editable barcodes.

1. Choose Window > Esko > Dynamic Barcodes to open the Dynamic Barcodes palette.
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2. Select the objects (lineart or image) that you want to convert.
3. Click the Extract button.

Dynamic Barcode will analyse the selected objects, and when possible a Dynamic Barcode is
generated replacing the selection.

a) Click and hold Hold to View Original to hide the converted barcode and see the original lineart or
image.

b) Change any of the barcode parameters and click Apply to modify the generated barcode.
c) Enable Compare View to show the newly generated barcode semi transparent on top of the

original objects. This allows you to easily change position and parameters of the new barcode to
match the original.

4. When you're happy with the result, click the Finish button.

This will remove the original objects from the document and close the Barcode Recognition
session, leaving you with a barcode object that you can edit as needed.

Note:  You can not do any other barcode recognition as long as the previous session wasn't ended,
either by clicking the Finish or the Cancel button.

5.6.1.  Supported Barcode Types and known limitations

The barcodes that are currently supported for Barcode Recognition are these:

• EAN-13 (including add-ons)
• EAN-8
• UPC-A (including add-ons)
• UPC-E (including add-ons)
• NDC-HRI
• Int. 2 of 5
• ITF-14
• ITF-16
• UPC-SCS
• Code-128
• Code-128 (long)
• HIBC-128
• GS1-128
• QR
• GS1-QR
• PZN
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• PZN8

The barcode parameters that are currently recognized (when possible) are these:

• Barcode type
• Code
• Add-on presence
• Color (only when recognizing line art objects)
• HRI presence (only when recognizing line art objects)
• Height (only when recognizing line art objects)
• Rotation
• Magnification
• BWR (only when recognizing line art objects)
• Characters per unit
• Ratio

Other limitations:

• White Box, Light margin indicators, H gauges for ITF barcodes and HRI text parameters are not
recognized.

• Device Compensation and Bar Width Reduction are both combined in the Bar Width Reduction
• An Int. 2 of 5 needs to have at least 6 digits.
• UPC-SCS with add-on is not recognized.
• If the original is an image, rotation is deduced from the rotation of the image. If the barcode inside

the image is rotated over an angle other than a multiple of 90º, the recognizing will not work.
• Pre-defined barcode sizes for PZN barcodes may not always be recognized.

5.7.  Barcode Types and Parameters

5.7.1.  Supported Barcode Types

General Purpose Barcodes

1D 2D

• Code 39

• Code 93 on page 150

• 2 of 5

• Interleaved 2 of 5

• Codabar

• Code 128

• DataMatrix

• QR

• MicroQR
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1D 2D

• Code 128 (long)

• Klebrand on page 169

• MSI

• SICK Code on page 183

Retail Barcodes

1D 2D

• EAN 13

• EAN 8

• UPC-A

• UPC-E

• GS1 DataBar Omnidirectional

• GS1 DataBar Truncated

• GS1 DataBar Stacked

• GS1 DataBar Stacked Omnidirectional

• GS1 DataBar Limited

• GS1 DataBar Expanded

• GS1 DataBar Expanded Stacked

• GS1 128

• GS1 U.S. Coupon Interim

• M+S 7

• Marks & Spencer

• GS1 DataMatrix

Pharmaceutical, Healthcare and Cosmetic Barcodes

1D

• Bobst on page 145

• NDC / HRI
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1D

• EAN 13 Swissmedic

• Kurandt on page 170

• Laetus Pharma Code

• CLF-8

• HIBC 39

• HIBC 128

• Paraf Italy

• PZN

• PZN8

Shipment Container Barcodes

1D

• ITF-14

• ITF-16

• UPC-SCS

Identity Document Barcode

2D

• PDF417

• MicroPDF417

GS1 Application Identifiers
These are the GS1 Application Identifiers available in Dynamic Barcodes:

AI Data Content Format (*) FNC1 Required
(*****)

00 Serial Shipping Container Code (SSCC) N2+N18

01 Global Trade Item Number (GTIN) N2+N14

02 GTIN of Contained Trade Items N2+N14

10 Batch or Lot Number N2+X..20 (FNC1)

136



5Dynamic Content Essentials

11 (**) Production Date (YYMMDD) N2+N6

12 (**) Due Date (YYMMDD) N2+N6

13 (**) Packaging Date (YYMMDD) N2+N6

15 (**) Best Before Date (YYMMDD) N2+N6

16 (**) Sell By Date (YYMMDD) N2+N6

17 (**) Expiration Date (YYMMDD) N2+N6

20 Internal product variant N2+N2

21 Serial Number N2+X..20 (FNC1)

22 Consumer product variant N2+X..20 (FNC1)

235 Third Party Controlled, Serialised Extension of
GTIN (TPX)

N3+X..28 (FNC1)

240 Additional Item Identification N3+X..30 (FNC1)

241 Customer Part Number N3+X..30 (FNC1)

242 Made-to-Order Variation Number N3+N..6 (FNC1)

243 Packaging Component Number N3+X..20 (FNC1)

250 Secondary Serial Number N3+X..30 (FNC1)

251 Reference to Source Entity N3+X..30 (FNC1)

253 Global Document Type Identifier (GDTI) N3+N13+X..17 (FNC1)

254 GLN Extension Component N3+X..20 (FNC1)

255 Global Coupon Number (GCN) N3+N13+N..12 (FNC1)

30 Variable Count of Items (Variable Measure
Trade Item)

N2+N..8 (FNC1)

310n (***) Net weight, kilograms (Variable Measure
Trade Item)

N4+N6

311n (***) Length or first dimension, metres (Variable
Measure Trade Item)

N4+N6

312n (***) Width, diameter, or second dimension, metres
(Variable Measure Trade Item)

N4+N6

313n (***) Depth, thickness, height, or third dimension,
metres (Variable Measure Trade Item)

N4+N6

314n (***) Area, square metres (Variable Measure Trade
Item)

N4+N6

315n (***) Net volume, litres (Variable Measure Trade
Item)

N4+N6

316n (***) Net volume, cubic metres (Variable Measure
Trade Item)

N4+N6
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320n (***) Net weight, pounds (Variable Measure Trade
Item)

N4+N6

321n (***) Length or first dimension, inches (Variable
Measure Trade Item)

N4+N6

322n (***) Length or first dimension, feet (Variable
Measure Trade Item)

N4+N6

323n (***) Length or first dimension, yards (Variable
Measure Trade Item)

N4+N6

324n (***) Width, diameter, or second dimension, inches
(Variable Measure Trade Item)

N4+N6

325n (***) Width, diameter, or second dimension, feet
(Variable Measure Trade Item)

N4+N6

326n (***) Width, diameter, or second dimension, yards
(Variable Measure Trade Item)

N4+N6

327n (***) Depth, thickness, height, or third dimension,
inches (Variable Measure Trade Item)

N4+N6

328n (***) Depth, thickness, height, or third dimension,
feet (Variable Measure Trade Item)

N4+N6

329n (***) Depth, thickness, height, or third dimension,
yards (Variable Measure Trade Item)

N4+N6

330n (***) Logistic weight, kilograms N4+N6

331n (***) Length or first dimension, metres N4+N6

332n (***) Width, diameter, or second dimension, metres N4+N6

333n (***) Depth, thickness, height, or third dimension,
metres

N4+N6

334n (***) Area, square metres N4+N6

335n (***) Logistic volume, litres N4+N6

336n (***) Logistic volume, cubic metres N4+N6

337n (***) Kilograms per square metre N4+N6

340n (***) Logistic weight, pounds N4+N6

341n (***) Length or first dimension, inches N4+N6

342n (***) Length or first dimension, feet N4+N6

343n (***) Length or first dimension, yards N4+N6

344n (***) Width, diameter, or second dimension, inches N4+N6

345n (***) Width, diameter, or second dimension, feet N4+N6

346n (***) Width, diameter, or second dimension, yard N4+N6

347n (***) Depth, thickness, height, or third dimension,
inches

N4+N6
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348n (***) Depth, thickness, height, or third dimension,
feet

N4+N6

349n (***) Depth, thickness, height, or third dimension,
yards

N4+N6

350n (***) Area, square inches (Variable Measure Trade
Item)

N4+N6

351n (***) Area, square feet (Variable Measure Trade
Item)

N4+N6

352n (***) Area, square yards (Variable Measure Trade
Item)

N4+N6

353n (***) Area, square inches N4+N6

354n (***) Area, square feet N4+N6

355n (***) Area, square yards N4+N6

356n (***) Net weight, troy ounces (Variable Measure
Trade Item)

N4+N6

357n (***) Net weight (or volume), ounces (Variable
Measure Trade Item)

N4+N6

360n (***) Net volume, quarts (Variable Measure Trade
Item)

N4+N6

361n (***) Net volume, gallons U.S. (Variable Measure
Trade Item)

N4+N6

362n (***) Logistic volume, quarts N4+N6

363n (***) Logistic volume, gallons U.S. N4+N6

364n (***) Net volume, cubic inches (Variable Measure
Trade Item)

N4+N6

365n (***) Net volume, cubic feet (Variable Measure
Trade Item)

N4+N6

366n (***) Net volume, cubic yards (Variable Measure
Trade Item)

N4+N6

367n (***) Logistic volume, cubic inches N4+N6

368n (***) Logistic volume, cubic feet N4+N6

369n (***) Logistic volume, cubic yards N4+N6

37 Count of Trade Items N2+N..8 (FNC1)

390n (***) Applicable Amount Payable or Coupon Value,
local currency

N4+N..15 (FNC1)

391n (***) Applicable Amount Payable with ISO Currency
Code

N4+N3+N..15 (FNC1)

392n (***) Applicable Amount Payable, single monetary
area (Variable Measure Trade Item)

N4+N..15 (FNC1)
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393n (***) Applicable Amount Payable with ISO Currency
Code (Variable Measure Trade Item)

N4+N3+N..15 (FNC1)

394n (***) Percentage discount of a coupon N4+N4 (FNC1)

395n (***) Amount payable per unit of measure single
monetary area (variable measure trade item)

N4+N6 (FNC1)

400 Customer's Purchase Order Number N3+X..30 (FNC1)

401 Global Identification Number for Consignment
(GINC)

N3+X..30 (FNC1)

402 Global Shipment Identification Number (GSIN) N3+N17 (FNC1)

403 Routing Code N3+X..30 (FNC1)

410 Ship to - Deliver to Global Location Number N3+N13

411 Bill to - Invoice to Global Location Number N3+N13

412 Purchased from Global Location Number N3+N13

413 Ship for - Deliver for - Forward to Global
Location Number

N3+N13

414 Identification of a Physical Location - Global
Location Number

N3+N13

415 Global Location Number of the Invoicing Party N3+N13

416 GLN of the production or service location N3+N13

417 Party GLN N3+N13

420 Ship to - Deliver to Postal Code Within a Single
Postal Authority

N3+X..20 (FNC1)

421 Ship to - Deliver to Postal Code with ISO
Country Code

N3+N3+X..9 (FNC1)

422 Country of Origin of a Trade Item N3+N3 (FNC1)

423 Country of Initial Processing N3+N3+N..12 (FNC1)

424 Country of Processing N3+N3 (FNC1)

425 Country of Disassembly N3+N3+N..12 (FNC1)

426 Country Covering full Process Chain N3+N3 (FNC1)

427 Country Subdivision of Origin N3+X..3 (FNC1)

4300 Ship-to / Deliver-to company name N4+X..35 (FNC1)

4301 Ship-to / Deliver-to contact N4+X..35 (FNC1)

4302 Ship-to / Deliver-to address line 1 N4+X..70 (FNC1)

4303 Ship-to / Deliver-to address line 2 N4+X..70 (FNC1)

4304 Ship-to / Deliver-to suburb N4+X..70 (FNC1)

4305 Ship-to / Deliver-to locality N4+X..70 (FNC1)

140



5Dynamic Content Essentials

4306 Ship-to / Deliver-to region N4+X..70 (FNC1)

4307 Ship-to / Deliver-to country code N4+X2 (FNC1)

4308 Ship-to / Deliver-to telephone number N4+X..30 (FNC1)

4310 Return-to company name N4+X..35 (FNC1)

4311 Return-to contact N4+X..35 (FNC1)

4312 Return-to address line 1 N4+X..70 (FNC1)

4313 Return-to address line 2 N4+X..70 (FNC1)

4314 Return-to suburb N4+X..70 (FNC1)

4315 Return-to locality N4+X..70 (FNC1)

4316 Return-to region N4+X..70 (FNC1)

4317 Return-to country code N4+X2 (FNC1)

4318 Return-to postal code N4+X..20 (FNC1)

4319 Return-to telephone number N4+X..30 (FNC1)

4320 Service code description N4+X..35 (FNC1)

4321 Dangerous goods flag N4+N1 (FNC1)

4322 Authority to leave N4+N1 (FNC1)

4323 Signature required flag N4+N1 (FNC1)

4324 Not before delivery date time N4+N10 (FNC1)

4325 Not after delivery date time N4+N10 (FNC1)

4326 Release date N4+N6 (FNC1)

7001 NATO Stock Number (NSN) N4+N13 (FNC1)

7002 UN/ECE Meat Carcasses and Cuts
Classification

N4+X..30 (FNC1)

7003 Expiration Date and Time N4+N10 (FNC1)

7004 Active Potency N4+N..4 (FNC1)

7005 Catch Area N4+X..12 (FNC1)

7006 First Freeze Date N4+N6

7007 Harvest Date N4+N6..12 (FNC1)

7008 Species for Fishery Purposes N4+X..3 (FNC1)

7009 Fishing Gear Type N4+N..10 (FNC1)

7010 Production Method N4+X..2 (FNC1)

7020 Refurbishment lot ID N4+X..20 (FNC1)

7021 Functional status N4+X..20 (FNC1)

7022 Revision status N4+X..20 (FNC1)
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7023 Global Individual Asset Identifier (GIAI) of an
assembly

N4+X..30 (FNC1)

703s Number of Processor with ISO Country Code N4+N3+X..27 (FNC1)

7040 GS1 UIC with Extension 1 and Importer index N4+N1X2+X3+X4 (FNC1)

710 National Healthcare Reimbursement Number
(NHRN) – Germany PZN

N3+X..20 (FNC1)

711 National Healthcare Reimbursement Number
(NHRN) – France CIP

N3+X..20 (FNC1)

712 National Healthcare Reimbursement Number
(NHRN) – Spain CN

N3+X..20 (FNC1)

713 National Healthcare Reimbursement Number
(NHRN) – Brasil DRN

N3+X..20 (FNC1)

714 National Healthcare Reimbursement Number
(NHRN) - Portugal AIM

N3+X..20 (FNC1)

723s (****) Certification reference N4+X2+X...28 (FNC1)

7240 Clinical Trial Protocol ID N4+X..20 (FNC1)

8001 Roll Products (Width, Length, Core Diameter,
Direction, Splices)

N4+N14 (FNC1)

8002 Cellular Mobile Telephone Identifier N4+X..20 (FNC1)

8003 Global Returnable Asset Identifier (GRAI) N4+N14+X..16 (FNC1)

8004 Global Individual Asset Identifier (GIAI) N4+X..30 (FNC1)

8005 Price Per Unit of Measure N4+N6 (FNC1)

8006 Identification of the Components of a Trade
Item

N4+N14+N2+N2 (FNC1)

8007 International Bank Account Number (IBAN) N4+X..34 (FNC1)

8008 Date and Time of Production N4+N8+N..4 (FNC1)

8010 Component / Part Identifier (CPID) N4 + X..30 (FNC1)

8011 Component / Part Identifier Serial Number
(CPID SERIAL)

N4 + N..12 (FNC1)

8012 Software version N4+X..20 (FNC1)

8013 Global Model Number (GMN) N4+X..30 (FNC1)

8017 Global Service Relation Number to identify the
relationship between an organisation offering
services and the provider of services

N4+N18 (FNC1)

8018 Global Service Relation Number to identify the
relationship between an organisation offering
services and the recipient of services

N4+N18 (FNC1)

8019 Service Relation Instance Number (SRIN) N4+N..10 (FNC1)
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8020 Payment Slip Reference Number N4+X..25 (FNC1)

8026 ITIP of contained pieces N4+N18

8110 Coupon Code Identification for Use in North
America

N4+X..70 (FNC1)

8111 Loyalty points of a coupon N4+N4 (FNC1)

8112 Paperless coupon code identification for use
in North America

N4+X..70 (FNC1)

8200 Extended Packaging URL N4+X..70 (FNC1)

90 Information Mutually Agreed Between Trading
Partners

N2+X..30 (FNC1)

91 to 99 Company Internal Information N2+X..30 (FNC1)

Notes
• *: The first position indicates the length (number of digits) of the GS1 Application Identifier. The

following value refers to the format of the data content.

The following convention is applied:

n implied decimal point position

N numeric digit

X any character

N3 3 numeric digits, fixed length

N..3 up to 3 numeric digits

X..3 up to 3 characters

• **: If only year and month are available, DD must be filled with two zeroes.

• ***: The fourth digit of this GS1 Application Identifier indicates the implied decimal point position.
Example:

• 3100 Net weight in kg without a decimal point
• 3102 Net weight in kg with two decimal points

• FNC1: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length and shall
be delimited unless this Element String is the last one to be encoded in the symbol. The delimiter
shall be a Function 1 Symbol Character in GS1-128 Symbology, GS1 DataBar Expanded Versions and
GS1 Composite Symbology and should be a Function 1 Symbol Character in GS1 DataMatrix and GS1
QR Code Symbology.

• ****: The fourth digit of this AI indicates the sequence number, allowing multiple occurrences of
this AI

• *****: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length and shall
be delimited unless this Element String is the last one to be encoded in the symbol. The delimiter
shall be a Function 1 Symbol Character in GS1-128 Symbology, GS1 DataBar Expanded Versions and
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GS1 Composite Symbology and should be a Function 1 Symbol Character in GS1 DataMatrix and GS1
QR Code Symbology.

5.7.2.  Barcode Types

To create a barcode of a specific type, select it in the Barcode Type parameter. This displays
parameters specific to this barcode type in the Dynamic Barcodes dialog.

2 of 5

About this Barcode...
2 of 5 is a numeric self-checking barcode, which can have a variable length. This barcode only encodes
data in the bars. It is used for industrial applications, article numbering, photo development and
ticketing.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Box on page 198

• Stroke Weight: Bearer Bars on page 199
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Bobst

About this Barcode...
The Bobst barcode is part of the same "binary" barcode family as the Laetus Pharma Code, Kurandt and
CLF-8. It is used in the pharmaceutical industry.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Wide Bar on page 194

• Gap on page 194

• Decimal Input on page 195

• Box on page 198

CLF-8

About this Barcode...
The CLF-8 barcode is part of the same "binary" barcode family as the Laetus Pharma Code, Kurandt and
Bobst barcode. It is used in the pharmaceutical industry.
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Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Wide Bar on page 194

• Gap on page 194

• Decimal Input on page 195

Codabar

About this Barcode...
The Codabar barcode is commonly used in libraries, blood banks, and the air parcel business. It can
encode up to 126 characters of data and two control characters, using digits and the “-”, “$”, “:”, “/” and
“+” characters.

 

 

Parameters
General Parameters

• Rotation on page 187
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• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Rational (Constant Bar Width): By enabling this option, you can create a "Rational" Codabar bar
code.

• Use “992” Prod. Family in UPC on page 190

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Box on page 198

Code 128

About this Barcode...
Code 128 is a variable length, high density, alphanumeric barcode. It has the second highest density of
all the 1D barcodes (after the GS1 Databar Expanded).

It can contain a set of control characters. These control characters can change the character encoding
type. In the absence of control characters, the encoding type is chosen automatically, to optimize the
content encoding.

To force the usage of the code-set A, precede your data with the [a] control character. To force
the usage of the code-set B, precede your data with the [b] control character. To obtain an optimal
utilization of the code-sets A and B but prevent the usage of the space saving code-set C, use the Code
128 (long) barcode type instead.

You can include FNC characters in your code by entering [F1] for FNC1, [F2] for FNC2 or [F3] for
FNC3

 

 

Parameters
General Parameters

147



5 Dynamic Content Essentials

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Light Margin Indicator on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Narrow Bar on page 194

• Width on page 194

• Box on page 198

• Stroke Weight: Bearer Bars on page 199

Code 128 (long)

About this Barcode...
Code 128 (long) is a version of Code 128 that doesn't use the space-saving “C” character set. This makes
Code 128 (long) barcodes generally longer.

You can include FNC characters in your code by entering [F1] for FNC1, [F2] for FNC2 or [F3] for
FNC3

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188
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• Light Margin Indicator on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Narrow Bar on page 194

• Width on page 194

• Box on page 198

• Stroke Weight: Bearer Bars on page 199

Code 39

About this Barcode...
Code 39 is a popular barcode in industrial barcoding systems, mainly in the U.S.A. It is used in the
non-retail industry, particularly in the manufacturing, military, and health sectors. It can encode
alphanumeric data.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191
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• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Add Check Digit on page 196

• Box on page 198

Code 93

About this Barcode...
Code 93 is a variable length, high density, alphanumeric barcode. It's an enhancement of the Code 93
using spaces as well as bars as a data carrier. It contains two check characters for higher data security.
The Code 93 barcode allows encoding the first 128 characters of the ASCII table.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Narrow Bar on page 194

• Box on page 198
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• Stroke Weight: Bearer Bars on page 199

DataMatrix

About this Barcode...
DataMatrix is used for encoding large amounts of alphanumeric data and / or marking small objects. It
can encode all the standard ASCII and extended ASCII characters.

The DataMatrix symbol size can adjust automatically depending on the amount of data.

Dynamic Barcodes doesn't generate human readable characters for DataMatrix symbols. The data to be
encoded in a DataMatrix symbol can contain an FNC1 character but only at the beginning of the data.

Note:  Dynamic Barcodes always generates DataMatrix symbols with the recommended ECC200 error
correction scheme.

 

 

DataMatrix Macro functions
Using DataMatrix Macro sequences, you can reduce the amount of data to encode by omiting obvious
headers and trailers. The structured data uses control characters, entered using their standard
abbreviations between "<" and ">"

The Macro sequence contains different parts:

• The optional Macro header: [)>. This is optional, and can be omited

• One of the starting sequences: <RS>05<GS> or <RS>06<GS>

• The macro content in a structured format

• The ending sequence: <RS><EOT>

Here are a few examples of a valid Macro function:

• [)><RS>05<GS>PAP16559-2<GS>S0<72>017<GS>IPWP4511<RS><EOT>

• <RS>05<GS>PAP16559-2<GS>S0<72>017<GS>IPWP4511<RS><EOT>

Note that apart from the Macro functions, you can enter all control characters to a DataMatrix code.
These are all accepted codes:

<NUL><SOH><STX><ETX><EOT><ENQ><ACK><BEL><BS><HT><LF><VT><FF><CR><SO><SI><DLE><DC1><DC2><DC3><DC4><NAK><SYN><ETB><CAN><EM><SUB><ESC><FS><GS><RS><US>

Note:  If you want to use one of the control character substitutions literally (e.g. "<EOT>") it can be
escaped by doubling the first character: <<EOT>

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

151



5 Dynamic Content Essentials

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Symbol Type on page 196

• Cell Size on page 196

• Width / Total Height on page 197

• Box on page 198

EAN 8

About this Barcode...
EAN 8 is an abbreviated version of EAN 13, for use on smaller packages. It can encode eight digits, and
can have two or five additional digits.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Light Margin Indicator on page 189

• Add-on Text On Top on page 189

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Height on page 192
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• Snap Bars to Output Resolution on page 195

• Box on page 198

EAN 13

About this Barcode...
European Article Numbering system or EAN is the standard for article numbering in Europe. It is also
used in Japan where it is called JAN.

Note:  EAN is the European equivalent of the UPC system in the U.S.A. and Canada. Both systems
use the same size requirements and a similar encoding scheme. This means that most European and
American retail barcode scanners can read both EAN and UPC barcodes. For more information on UPC,
see UPC-A on page 184.

 

 

An EAN 13 is a numeric barcode of thirteen digits, and can have two or five additional digits.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Light Margin Indicator on page 189

• Add-on Text On Top on page 189

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters
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• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Box on page 198

EAN 13 Swissmedic

About this Barcode...
EAN 13 Swissmedic is an EAN 13 barcode used for items licensed by the Swiss Agency for Theraputic
Products

It always starts with "7680", uses a specific text positioning and adds the text "swissmedic" below the
code.

For EAN 13 Swissmedic barcodes, only the default font settings can be used.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Box on page 198
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GS1 128

About this Barcode...
GS1 128 (formerly EAN 128) is a Code 128 barcode designed primarily to identify products.

It contains one or more FNC1 (GS1 Function Code 1) control characters and Application Identifiers. It
shows parentheses around the human readable interpretation of the Application Identifiers, but those
parentheses are not encoded in the barcode.

 

 

It is alphanumeric and can also contain composite symbols.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

• Composite Component on page 188

Text Parameters

• Add Human Readable Characters on page 188

• Put on Top on page 189

• Multiple Text Lines on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191
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• Device Compensation on page 191

• Height on page 192

• Narrow Bar on page 194

• Snap Bars to Output Resolution on page 195

• Box on page 198

• Stroke Weight: Bearer Bars on page 199

GS1 DataBar Omnidirectional

About this Barcode...
Barcodes of the GS1 DataBar family (formerly Reduced Space Symbols or RSS) can identify small items,
and encode more information than the current EAN or UPC barcodes.

They can include GS1 Application Identifiers such as serial numbers, lot numbers, expiration dates...

Note:  GS1 DataBar codes are expected to replace most common EAN and UPC barcodes from 2010.

GS1 DataBar Omnidirectional encodes Global Trade Item Numbers (GTIN) in a linear symbol that can be
scanned omnidirectionally by suitably programmed slot scanners.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

• Composite Component on page 188

Text Parameters

• Add Human Readable Characters on page 188

• Put on Top on page 189

• Multiple Text Lines on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters
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• Bar Width Reduction on page 191

• Device Compensation on page 191

• Narrow Bar on page 194

• Snap Bars to Output Resolution on page 195

GS1 DataBar Stacked

About this Barcode...
GS1 DataBar Stacked is a variation of the GS1 DataBar barcode, that is stacked in two rows and used
when the normal barcode would be too wide for the product.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

• Composite Component on page 188

Text Parameters

• Add Human Readable Characters on page 188

• Multiple Text Lines on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Narrow Bar on page 194

• Snap Bars to Output Resolution on page 195

GS1 DataBar Stacked Omnidirectional

About this Barcode...
GS1 DataBar14 Stacked Omnidirectional is taller version of GS1 DataBar14 Stacked, that can be read by
omnidirectional scanners.
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Parameters
General Parameters

• Rotation on page 187

• Code on page 187

• Composite Component on page 188

Text Parameters

• Add Human Readable Characters on page 188

• Put on Top on page 189

• Multiple Text Lines on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Narrow Bar on page 194

• Snap Bars to Output Resolution on page 195

GS1 DataBar Truncated

About this Barcode...
GS1 DataBar Truncated (formerly RSS Limited) is similar to GS1 DataBar but the height of its bars is
truncated.

It encodes Global Trade Item Numbers in a smaller symbol for use on small items. It cannot be scanned
omnidirectionally.
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Parameters
General Parameters

• Rotation on page 187

• Code on page 187

• Composite Component on page 188

Text Parameters

• Add Human Readable Characters on page 188

• Put on Top on page 189

• Multiple Text Lines on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Narrow Bar on page 194

• Snap Bars to Output Resolution on page 195

GS1 DataBar Expanded

About this Barcode...
GS1 DataBar Expanded (formerly RSS Expanded) encodes regular barcode data (“primary item
identification” data) and Application Identifiers. It can encode alphanumeric characters.

This barcode can be scanned omnidirectionally by suitably programmed slot scanners.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

• Composite Component on page 188

Text Parameters

• Add Human Readable Characters on page 188
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• Put on Top on page 189

• Multiple Text Lines on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Narrow Bar on page 194

• Snap Bars to Output Resolution on page 195

GS1 DataBar Expanded Stacked

About this Barcode...
GS1 DataBar Expanded Stacked can encode the same amount of data as GS1 DataBar Expanded, but
can also “stack” the barcode into several rows to save space.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

• Composite Component on page 188

Text Parameters

• Add Human Readable Characters on page 188

• Put on Top on page 189

• Multiple Text Lines on page 189

• Font Family, Style and Size on page 190
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• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Max. Row Width on page 190

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Narrow Bar on page 194

• Snap Bars to Output Resolution on page 195

GS1 DataBar Limited

About this Barcode...
GS1 Databar Limited is smaller than the GS1 DataBar barcode and can only encode Global Trade Item
Numbers whose data part starts with “1”.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

• Composite Component on page 188

Text Parameters

• Add Human Readable Characters on page 188

• Put on Top on page 189

• Multiple Text Lines on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Narrow Bar on page 194

• Snap Bars to Output Resolution on page 195
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GS1 DataMatrix

About this Barcode...
The GS1 Data Matrix barcode is a high density, high capacity, scalable 2D barcode. It is used to
concentrate a lot of (alphanumeric) information in a very small space.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Put on Top on page 189

• Multiple Text Lines on page 189

• Light Margin Indicator on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Symbol Type on page 196

• Cell Size on page 196

• Width / Total Height on page 197

• Box on page 198

GS1 QR

About this Barcode...
The GS1 QR barcode is a high density, high capacity, scalable 2D barcode. It is used to assembly
multiple GS1 Application Identifiers to a barcode with limited space needs. The GS1 QR barcode can
contain numbers, 0 - 9, upper case letters A -Z, and nine special characters: space $ % * + - . /

For more technical information on the QR code, see QR on page 180
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Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Put on Top on page 189

• Multiple Text Lines on page 189

• Light Margin Indicator on page 189

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Symbol Type on page 196

• Cell Size on page 196

• Width / Total Height on page 197

• Box on page 198

Specific Parameters
Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you entered in
Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check sums are
added to the barcode) and may limit the maximum length of the encoded data.

Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for the symbol
(Minimum Symbol Size).

163



5 Dynamic Content Essentials

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50 x 50 mm.

GS1 U.S. Coupon Interim

About this Barcode...
GS1 U.S. Coupon Interim is an interim coupon barcode. It is used during the transition between UPC-A
coupons and the new GS1 Databar Expanded Stacked coupons, that can encode more information.

It is made of both an old UPC-A coupon barcode, and a new Databar Expanded Stacked coupon
barcode, to be readable by both old and new scanners.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

Additional Parameters

• Use “992” Prod. Family in UPC on page 190

• Max. Row Width on page 190

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Narrow Bar on page 194

• Gap on page 194

• Vertical alignment on page 194

HIBC 128

About this Barcode...
This barcode is based on the Code 128 symbology.
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It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This
encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are
encoded in one barcode, they are divided by the “/” character.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Narrow Bar on page 194

• Width on page 194

• Box on page 198

• Stroke Weight: Bearer Bars on page 199

HIBC 39

About this Barcode...
This barcode is based on the Code 39 symbology.

It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This
encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are
encoded in one barcode, they are divided by the “/” character.
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Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Box on page 198

ITF-14

About this Barcode...
ITF-14 is a standardized version of the Interleaved 2 of 5 barcode, containing 14 digits, the last being a
check digit.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

166



5Dynamic Content Essentials

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Text Format on page 191

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Total Height on page 197

• Smax / Smin on page 197

• Box on page 198

ITF-16

About this Barcode...
ITF-16 is a standardized version of the Interleaved 2 of 5 barcode, containing 16 digits, the last being a
check digit.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Text Format on page 191
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• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Total Height on page 197

• Smax / Smin on page 197

• Box on page 198

Interleaved 2 of 5

About this Barcode...
Interleaved 2 of 5 (or Int. 2 of 5) is a barcode originally used for transportation packaging, that can have
any even number of digits. Since this type of packaging consists mainly of cardboard boxes printed in
low quality, the Interleaved 2 of 5 barcode is more tolerant to distortion than other barcodes.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Ratio on page 194

• Narrow Bar on page 194
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• Box on page 198

• Stroke Weight: Bearer Bars on page 199

Klebrand

About this Barcode...
Klebrand is a barcode used in the packaging industry. It uses four different bar thicknesess to encode
the data. The barcode uses the quarternal numerical system and each bar thickness represents one of
four numbers allowed in the non-decimal input (0, 1, 2 and 3). It can have up to 30 bars. The input can be
both in decimal and quarternal numerical systems.

• In non-decimal (quarternal) mode all digits are encoded, including any leading zeroes. For example
"0031" is encoded to 4 bars.

• In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The first number
(6) defines the total number of bars, the second (4) defines the value to be encoded. If you you
enter a single number without defining the number of bars, the minimal number of bars needed
for the value is used, and the code is adjusted accordingly. If you for example enter "9", the value
will change to "4/9", as you need at least 4 bars to encode this value. The text below the barcode (if
enabled) only shows the decimal value itself.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Wide Bar on page 194

• Gap on page 194

169



5 Dynamic Content Essentials

• Decimal Input on page 195

• Box on page 198

Kurandt

About this Barcode...
The Kurandt barcode is part of the same "binary" barcode family as the Laetus Pharma Code, Bobst and
CLF-8. It is used in the pharmaceutical industry.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Wide Bar on page 194

• Gap on page 194

• Decimal Input on page 195

• Box on page 198

Laetus Pharma Code

About this Barcode...
The Laetus Pharma Code is part of the same barcode family as the Kurandt, Bobst and CLF-8 barcode.
It was developed specifically to meet the requirements of the pharmaceutical packaging process.
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It has established itself as the worldwide pharmaceutical industry barcode standard. It can encode
numeric or binary data.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Miniature: Use this option to create a miniature version of the bar code

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Wide Bar on page 194

• Gap on page 194

• Decimal Input on page 195

• Box on page 198

M+S 7

About this Barcode...
The M+S 7 barcode is an EAN 8 barcode modified by Marks & Spencer's, for use on own-brand products
sold in their stores.

To make the M+S 7 barcode, the initial “0” is removed and the extra letters “M” and “S” are added to the
human readable characters.

This means that the human readable characters contain seven digits plus the “M” and “S” letters.
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Note:  This doesn't affect the data encoded in the barcode (it still encodes eight digits), so you should
enter eight digits when creating a M+S 7 barcode.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Box on page 198

MSI

About this Barcode...
MSI, also known as Modified Plessey, was developed by the MSI Data Corporation, based on the original
Plessey Code. It is a numeric barcode used primarily to mark retail shelves for inventory control.
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Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Characters per unit on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Box on page 198

Marks & Spencer's

About this Barcode...
The Marks & Spencer's barcode is also an EAN 8 barcode modified by Marks & Spencer's for use on
own-brand products.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters
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• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Box on page 198

NDC / HRI

About this Barcode...
The NDC / HRI barcode is a variant of the UPC barcode with special human readable interpretation
formats compliant to the US National Drug Code definition.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Text Format on page 191

• Bar Width Reduction on page 191
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• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Box on page 198

Paraf Italy

About this Barcode...
This barcode is a variant of Code 39 used by the Italian Health and Cosmetics Industry. It is also called
Code 32.

 

 

Use Code Base32 when your barcode data is encoded in the Base 32 format. This format uses case-
insensitive alphanumeric characters to encode data.

Use Code Base10when your barcode data is in decimal format. Paraf Italy barcodes in decimal format
should start with an “A” (included automatically by Dynamic Barcodes), have 8 digits of data and end
with a check digit (calculated automatically by Dynamic Barcodes).

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Narrow Bar on page 194

• Box on page 198

PDF417

About this Barcode...
PDF417 is a 2D barcode mainly used in security printing (passports, identity cards, driving licences...).

It is a “self-checking” barcode that can have different levels of error correction.
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It can encode data using one of three “compaction” modes: Text (to encode all alphanumeric and
punctuation characters in the ISO-8859-1 character set), Numeric (to encode only numeric characters)
or Binary (to encode 8-bit characters).

It can use the three compaction modes in a single barcode if necessary, but you can choose to disable
the Text and/or Numeric compaction modes.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Narrow Bar on page 194

• Box on page 198

Specific Parameters
Columns
You can give your barcode between 1 and 30 Columns. The number of columns corresponds to the
number of PDF417 codewords.

Rows
You can give your barcode between 3 and 90 Rows.

Truncated
Choose Truncated to make the symbol less wide by truncating the end character (which is not part of
the encoded data) and the end pattern. In the example below, the top PDF417 barcode is not truncated,
and the bottom barcode is truncated (but encodes the same data).
 

 

Initialize in Alpha Submode
Choose this option to generate a “shift to Text mode” character at the beginning of the barcode when
using Text compaction mode. This makes the encoding clear for barcode scanners.

Allow Text Compaction
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Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your
barcode contains text data.

This encodes the text data in your barcode more eciently (it makes that part of your barcode
smaller).

Allow Numeric Compaction

Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your
barcode contains numeric data.

This encodes the numeric data in your barcode more eciently.

Note:

Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains binary
data.

If you don't enable either Allow Text Compaction or Allow Numeric Compaction, Dynamic Barcodes
will only use Binary compaction mode.

Error Correction Level

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose an Error correction level from 0 to 8.

The higher the correction level, the more check sums are added to the barcode and the more incorrect
data can be corrected. Keep in mind that a higher correction level makes the barcode bigger and may
limit the maximum length of the encoded data.

Note:  Level 0 means that there is only one check sum added to the data, so incorrect data can be
detected but not corrected.

You can choose Automatic to let the plug-in pick the best error correction level for the data encoded.

MicroPDF417

About this Barcode...
MicroPDF417 is a 2D multi-row barcode derived from PDF417, for use on smaller areas. It can encode up
to 150 bytes.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191
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• Height on page 192

• Narrow Bar on page 194

• Snap Bars to Output Resolution on page 195

• Box on page 198

Specific Parameters
Columns
You can give your barcode between 1 and 4 Columns.

Rows
You can give your barcode between 4 and 44 Rows.

Allow Text Compaction

Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your
barcode contains text data.

This encodes the text data in your barcode more eciently (it makes that part of your barcode
smaller).

Allow Numeric Compaction

Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your
barcode contains numeric data.

This encodes the numeric data in your barcode more eciently.

Note:

Dynamic Barcodes can always switch to the Binary compaction mode if your barcode contains binary
data.

If you don't enable either Allow Text Compaction or Allow Numeric Compaction, Dynamic Barcodes
will only use Binary compaction mode.

PZN

About this Barcode...
The PZN (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and healthcare
products in Germany. The PZN code is written in the format “PZN-nnnnnnn” but only the numeric part
including the leading dash is encoded.

 

 

Parameters
General Parameters
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• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Size on page 192

• Height on page 192

• Characters per unit on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Box on page 198

PZN8

About this Barcode...
The PZN8 (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and
healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnnn” but only the
numeric part including the leading dash is encoded.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters
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• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Size on page 192

• Height on page 192

• Characters per unit on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Box on page 198

QR

About this Barcode...
The QR barcode is a 2-dimensional barcode used for commercial tracking and convenience-oriented
applications aimed at mobile phone users (known as "mobile tagging").

QR codes storing addresses and URLs may appear in magazines, on signs, buses, business cards, or
other objects... Users with a camera phone equipped with the correct reader application can scan the
QR code to display text, contact information, connect to a wireless network, or open a web page in the
phone's browser.

 

 

QR codes have the following structure:
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•

 Position pattern (required)

•

 Alignment pattern (required)

•

 Timing pattern (required)

•
 Version information

•
 Format information

•
 Data and error correction keys

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Cell Size on page 196

• Width / Total Height on page 197

• Box on page 198

Specific Parameters
Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you entered in
Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.
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• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check sums are
added to the barcode) and may limit the maximum length of the encoded data.

Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for the symbol
(Minimum Symbol Size).

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50 x 50 mm.

MicroQR

About this Barcode...
The Micro QR Code is a very small QR Code for use on smaller spaces (for example to encode the ID of
printed circuit boards and electronics parts).

It works with smaller amounts of data (maximum 35 numeric characters), and uses only one position
pattern.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Cell Size on page 196

• Width / Total Height on page 197

• Box on page 198

Specific Parameters
Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you entered in
Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction
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Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check sums are
added to the barcode) and may limit the maximum length of the encoded data.

Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for the symbol
(Minimum Symbol Size).

For example, a symbol of 15 x 15 cells where each cell is 2 mm gives a Width and Height of 30 x 30 mm.

SICK Code

About this Barcode...
SICK is a bar code used in the German packaging industry. It's a binary bar code, using a thick bar for a
0, and a thin bar for a 1. It can have up to 12 bars. It can encode numeric or binary data.

• In binary mode all digits are encoded including leading zeroes, ie. "0001" is encoded as a three thin
and one thick bar.

• In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The first number (6)
defines  the total number of bars, the second (4) defines the valueto be encoded. If you don't define
the number of bars, in other words if you enter a single number, the minimal number of bars needed
for the value is used, and the code is adjusted accordingly. If you for example enter "9", the value will
change to "4/9", as you need at least 4 bars to encode this value.

• The defaults follow the mostly used standard "Codetype A", for generating the "Codetype B" should
be changed the barcode parameters as following: Narrow Bar to 1.25mm (from 0.5mm), Wide Bar to
3.75mm (from 1.5mm) and Gap to 2.5mm (from 1mm)

By default, the values for the Narrow Bar (0.5mm), Wide Bar (1.5mm) and Gap (1mm) are set for the
mostly used standard "Codetype A". If you want to generate a SICK code using "Codetype B", you should
set the Narrow Bar to 1.25mm, the Wide Bar to 3.75mm and the Gap to 2.5mm

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters
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• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Alignment on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Height on page 192

• Ratio on page 194

• Narrow Bar on page 194

• Wide Bar on page 194

• Gap on page 194

• Decimal Input on page 195

• Box on page 198

UPC-A

About this Barcode...
Universal Product Code or UPC is the standard for article numbering in the U.S.A. and Canada. It is
similar to the EAN system and compatible with it. For more information on EAN, see EAN 13 on page
153.

 

 

UPC-A is a numeric barcode of up to twelve digits, plus two or five additional digits.
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Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Box on page 198

UPC-E

About this Barcode...
UPC-E is an abbreviated version of UPC-A, for use on smaller packages. It is a numeric barcode of
eight digits, with an optional 2 or 5 digits add-on. You can also directly enter the 12-digit code of UPC-A
codes that can be represented in 8 digits.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

185



5 Dynamic Content Essentials

• Vertical Offset on page 190

Additional Parameters

• Bar Width Reduction on page 191

• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Box on page 198

UPC-SCS

About this Barcode...
The UPC–SCS (Shipping Container Symbol) barcode is a version of the Interleaved 2 of 5 barcode that
has a structure very similar to the Universal Product Code's (UPC) and specific formatting of the human
readable interpretation.

 

 

Parameters
General Parameters

• Rotation on page 187

• Code on page 187

Text Parameters

• Add Human Readable Characters on page 188

• Font Family, Style and Size on page 190

• Vertical Offset on page 190

Additional Parameters

• Text Format on page 191

• Bar Width Reduction on page 191
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• Device Compensation on page 191

• Magnification on page 191

• Height on page 192

• Snap Bars to Output Resolution on page 195

• Total Height on page 197

• Box on page 198

• Stroke Weight: Bearer Bars on page 199

5.7.3.  Barcode Parameters

Rotation
To rotate your barcode by 90, 180 or 270 degrees, use the Rotation buttons.

 

 

To rotate it by any other angle, enter that angle in the Rotation field.

Code
Enter the data to encode in your bar code.

Dynamic Barcodes checks that the data you have entered is valid for your chosen Barcode Type. If it
isn't, a warning / error will pop up.

Code for GS1 Bar Codes
When entering data to be encoded in GS1 bar codes, you can either enter Application Identifiers (AI)
including the brackets, or you can enter the code without brackets, using FNC1 code at the end of
each variable-length element in the data. The FNC1 code will be represented by [F1] when entering the
code (with an exception for the GS1 DataMatrix barcode, which also allows the ASCII 29 <GS> control
character as a seprator).While entering GS1 data, following remarks should be taken into account:

• Do not add the mandatory FNC1 character at the beginning of the data. Dynamic Barcodes will add it
automatically.

• For GS1 bar codes intended for encoding AI (01) only, AI has to be omitted, i.e. don't enter '01' at the
beginning. It doesn't matter if entered with or without brackets.

• The Composite Component can be created using the same rules for using brackets and [F1]. It's not
necessary to keep the same way of entering the Composite Component and the main code.

• If you don't use brackets for entering AI, type [F1] at the end of each variable-length element in the
data, to represent a FNC1 terminating character, except when the variable-length element is placed
at the end of the whole code.
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• You don't need to type [F1] at the end of fixed-length elements.

• Do not mix using [F1] as terminators of variable AI and entering brackets around the AI.

 

 

Dynamic Barcodes also checks the validity of the Application Identifiers you enter in the Code and / or
in the Composite Component of GS1 bar codes.

Composite Component
A Composite Component is a 2D symbol placed on top of a GS1 barcode, that encodes extra
information (batch number, expiration date...).

If you want your barcode to have a Composite Component, enter the (alphanumeric) data to encode in
this field.

Note:  Dynamic Barcodes checks the data you enter for the Composite Component (for example to see
if the Application Identifiers you entered are correct), and displays a warning if it is invalid.
 

 

Add Human Readable Characters
This parameter adds “human readable” characters (numeric or alphanumeric characters) under your
barcode.

This is the same barcode with and without human readable characters:
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Put on Top
This parameter allows you to put the Human Readable Characters above instead of below the barcode
bars.

Multiple Text Lines
Select this parameter if you want the human readable characters to be printed on multiple lines below
the barcode. Dynamic Barcodes will start a new line for every element of the barcode data (starting
with the Application Identifier).

 

 

Note:  When opening your document in PackEdge, the characters will be placed back on a single line.

Light Margin Indicator
This parameter adds “<“ and “>” signs (or only “>” depending on the barcode type) at the bottom of your
barcode. This indicates the width the barcode should have for optimal reading.

 

 

Note:  When creating a bar code, the current Light Margin Indicator setting is stored for the specific
barcode type. This means that the next time you select the same barcode type (e.g. when creating a
new barcode of that same type) the Light Margin Indicator setting will be adjusted.

Add-on Text On Top
This parameter allows you to put the add-on HRI text above instead of below the barcode bars. By
default, this option is enabled.
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Font Family, Style and Size
These options can be used to define the font family, style and size to be used for the human readable
characters. By choosing [default font], all other Text Parameters are disabled, as the default values
are used.

Note:  If the font used in a bar code is not available when opening the file, Adobe Illustrator will warn
about a missing font. You can however only fix the problem using the Dynamic Barcode palette, since
Adobe Illustrator's "Find Font" feature can not be used.

Alignment
When using human readable characters, in combination with custom font settings, you can set text
alignment to Left, Center or Right.

Vertical Offset
This parameter allows you to add extra space between your barcode bars and the human readable
characters.

 

 

Note:  When opening your document in PackEdge, the characters will be placed just below the bars
again.

Use “992” Prod. Family in UPC
Enable this parameter to use the special “992” product family in your barcode (for specific offers like
discounts on the customer's next purchase or on variable weight items...).

Max. Row Width
Use this parameter to define how many segments of data (groups of bars encoding several digits) can
fit in one row. If the barcode contains more segments, they will be stacked.

In the example below, the first barcode has a Max. Row Width of 8 segments. When reducing this to
4 segments, the segments that don't fit in the row width anymore are stacked, forming a second row
(second barcode).
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The GS1 Max Row Width parameter applies to the GS1 Databar Expanded Stacked component of the GS1
U.S. Coupon Interim barcode.

Text Format
Choose a text format for the human readable characters of your barcode.

For NDC/HRI barcodes, you can choose a variant of the U.S. National Drug Code.

For ITF-14, ITF-16 and UPC-SCS barcodes, you can choose a variant of the Shipping Container Symbol.

Bar Width Reduction
Use this to adjust the width of barcode bars, in order to compensate for ink bleeding when printing on
your substrate.

Your printer or customer will usually provide you with the value to use. For example if your printer tells
you that the line width will increase by 0.01mm, you should use a Bar Width Reduction value of 0.01
mm.

You can enter the Bar Width Reduction in microns, milliinches (“mil”), millimeters or inches.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Device Compensation
Use this if your printer gave you a separate device bleed value. This parameter adjusts the bar's width
to compensate for bleed caused by the plate or film making process.

You can enter the Device Compensation in microns, milliinches (“mil”), millimeters or inches.

Note:  If you use both a Bar Width Reduction and a Device Compensation value, Dynamic Barcodes will
add them to adjust the bar's width.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Magnification
Use this parameter to increase or decrease the barcode size proportionally.

In the example below, you can see the same barcode at 80%, 100% and 120% magnification.
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Size
Choose to give your PZN barcode a Small, Normal or Large size. Those are predefined sizes for this
barcode. The actual Height, Characters per unit, Ratio and Narrow Bar values are shown underneath.

By selecting Custom, you can manually edit these four parameters.

Height
Enter the height to give to your barcode's bars. They need to be tall enough to be read easily by barcode
scanners.

Code 128
In Dynamic Barcodes, you can create Code 128 barcodes shorter than the minimum height. Dynamic
Barcodes will just display a warning, but if you export the document to EPF and open it in PackEdge,
PackEdge will extend the barcode to its minimum required height.

 

 

Bars and Digits
For:

• EAN 8 & 13
• HIBC 128 and 39
• M+S 7, and Marks & Spencer's
• NDC / HRI
• UPC-A and UPC-E

For the bar codes listed above, the height you enter is the combined height of the bars and the human
readable characters). Your barcode needs to be tall enough to be read easily by barcode scanners.

Attention:  Do not change the Height of the barcode before entering a Magnification value.
The Height will change again according to the Magnification factor you define.

Characters per unit
This parameter allows you to define your barcode's width based on the encoding of (numeric or
alphanumeric) characters.

You can choose the unit to use: micron, mil (milliinches), mm or inch.
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For example, choose mm and use 1 Character per unit in the Dynamic Barcodes dialog if you want the
bars needed to encode one character to take up 1 mm.

 

 

Increase the Characters per unit value to make the barcode narrower, or decrease it to make the
barcode wider. For example, if you choose 0.5 Character per unit, the bars needed to encode one
character will take up 2 mm.

 

 

Note:  Barcodes like Interleaved 2 of 5 encode two characters together in a group of black and white
bars. For these barcodes, Dynamic Barcodes takes half of the group of black and white bars to measure
one character.
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Ratio
The Ratio is the factor between the width of the narrow bar and the width of the wide bar in your
barcode. For example, enter 3 if you want your wide bar to be three times as wide as your narrow bar.

Narrow Bar
This parameter determines the width of the narrowest bar of your barcode. In some cases (for example
GS1 DataBar barcodes) this affects the size (height and width) of your barcode proportionally.

Width
This parameter determines the width of the barcode from the leftmost bar to the rightmost bar.
Changing the Width will update the Narrow Bar and Characters per unit settings to achieve the desired
size.

The Light Margin Indicators and Box are not included.

Wide Bar
This parameter determines the width of the widest bar of your barcode.

Gap
Enter the width of the white space between the bars.

Note:  The Ratio influences the Gap size: increasing the Ratio also increases the Gap size.

Vertical alignment
Dynamic Barcodes allows you to resize either the UPC-A or the GS1 Databar Expanded Stacked coupon
barcode, so they are aligned vertically with each other. You can choose:
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• None to keep the original size of both the UPC and the GS1 barcodes,
 

 

• Resize UPC to GS1 to resize the UPC barcode so it has the same height as the GS1 barcode,
 

 

• Resize GS1 to UPC to resize the GS1 barcode so it has the same height as the UPC barcode.
 

 

Snap Bars to Output Resolution
Use this to adjust the barcode size parameters (Bar Width Reduction, Device Compensation and
Magnification) so that the bars' width and height take up a complete number of pixels or dots.

Enable Snap Bars to Output Resolution and enter the resolution you will use to print your barcode in
ppi.

Decimal Input
Use this parameter to change the type of data you can enter in the Code field.

• Disable it to enter the data to encode in binary format.

• Enable it to enter the data in decimal instead of binary format.
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Note:  When using binary format for the Laetus Pharma Code, CLF-8, Bobst or Kurandt barcode data,
you need to use a special "Pharma" binary format.

To convert a decimal number into a Pharma binary number, do the following:

1. Add 1 to your decimal number.
2. Convert the result to a binary number using a regular binary conversion algorithm.
3. Remove the first digit (which is 1).

You now have your Pharma binary input for the Laetus Pharma Code, CLF-8, Bobst or Kurandt barcode.

For example, you want to encode the number 3.

1. 3+1=4
2. 4 in binary is 100.
3. Without the first digit, it's 00.

Enter 00 in the Code field of your Laetus Pharma Code, CLF-8, Bobst or Kurandt barcode.

Add Check Digit
Use this parameter to add a check digit to your barcode data.

Note:  Code 39 doesn't usually contain a check digit but it can be required in some cases.

Symbol Type
Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you entered in
Code, Dynamic Barcodes will display an error.
 

 

You can choose Best Fit to make Dynamic Barcodes automatically adapt the number of cells to the
amount of data you entered in Code.

Cell Size
Enter the size you want to give to each cell of the symbol. This affects the size of the whole symbol.

The unit used is the one you chose as Illustrator's General unit in the Units & Display Performance
Preferences.
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In the example below, the first symbol has a 1 mm cell size (cells sides are 1 mm), and the second one a 2
mm cell size.

 

 

Width / Total Height
The Width and Total Height parameters depend on the Cell Size and the number of cells used for the
symbol (Symbol Type).

In the example below, a symbol of 10 x 10 cells where each cell is 3 mm gives a Width and Total Height of
30 x 30 mm.

 

 

Total Height
Enter the total height you want to give to your barcode. This is the combined height of the bars, the
human readable characters and the box. If your barcode doesn't contain human readable characters or
a box, the Total Height is the same as the bars' Height.

Smax / Smin
Use these parameters to define the width of the printability gauges (“H” marks) either side of your
barcode. Smax defines the width of the left “H”, Smin defines the width of the right “H”. Enter 0 in both
fields if you don't want printability gauges.

In the example below, the top barcode has a value of 0 for both Smax and Smin, the middle one has a
value of 4 and the bottom one has a value of 8 (the maximum).
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Box
Use this parameter to create an opaque white box under your barcode.

 

 

Use the Top, Bottom, Left and Right fields to add a white margin around your barcode and make the
box bigger.
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By default, Dynamic Barcodes links the four margins' values so that when you change one of them, the
other ones are updated automatically.

 

 

If you want to change them independently, click the link symbol to make it look detached  .

For ITF, UCP and UPC-SCS bar codes, the box will be transparent.

Note:  When creating a bar code, the current Box parameters are stored for the specific barcode type.
This means that the next time you select the same barcode type (e.g. when creating a new barcode of
that type) the Box parameters will be adjusted.

Stroke Weight: Bearer Bars
For ITF-14, ITF-16 and UPC-SCS barcodes, enabling the Box option will create a transparent box, always
with bearer bars around it. The Stroke Weight parameter defines the width of the bearer bars. In this
case, it can't be set to zero.

For 2 of 5, Code 128,Code 128 long, Code 93,GS1 128, HIBC 128 and Int 2 of 5 barcodes, the Stroke
Weight defines the width of the bearer bars, but also define if bearer bars should be added: if the value
is set to zero, no bearer bars are added, even if Box is enabled. If the value is not zero, bearer bars will
be added, even if the Box option is disabled.

The bearer bars are positioned at the outside of the defined box, taking into account the margins (even
if the box option is disabled for the barcode types mentioned above). See also Box on page 198.

The option Only Top and Bottom Bars limits the bearer bars to only the top and bottom line.

5.8.  Barcode Parameters from the Job Folder

Automation Engine stores information related to the printing jobs within the Job Folder. Each Job
Folder can hold various job-related technical information, including barcode parameters.

The following barcode parameters can be set in Automation Engine Pilot:

Parameter Note Link

Type The type of barcode. You can't have two different
bar codes of the same type in one job.

Sub Type The size of the symbol for Datamatrix barcodes. Symbol Type on page
196

Code The encoded value including check digits. Code on page 187

199



5 Dynamic Content Essentials

Parameter Note Link

Composite Code For barcodes with a Composite Component -
mainly GS1 Databar codes

Composite Component
on page 188

Output Resolution Snap Bars to Output
Resolution on page 195

Bar Width Reduction Bar Width Reduction on
page 191

Device Compensation Device Compensation on
page 191

Narrow Bar Main size parameter for Code 128, Code 39,
Interleaved 2 of 5, Codabar or MSI based
barcodes, for GS1 DataBar barcodes, and for
binary barcodes. For 2D barcodes such as
DataMatrix, the parameter is used to set the Cell
Size.

Narrow Bar on page
194 and Cell Size on
page 196

Magnification Main proportional size parameter for EAN and UPC
based barcodes

Magnification on page
191

Ratio Used for Int2of5 barcodes Ratio on page 194

Important:  Automation Engine does not check the parameters. All listed parameters are available for
all barcode types, even if they are not valid for the given barcode type. Make sure you're entering the
valid inputs, including a correct Code with its check digit.

Note:  It is not necessary to have the parameters already set on the Job Setup when creating
barcodes: as soon as the Job Setup contains the settings for connected barcodes, these barcode
parameters will be applied. This allows you to create templates or placeholders before the actual data
(code for the barcode, etc) is available.

5.8.1.  Connecting to a Job Folder

In order to take parameters from an Automation Engine Job Folder, you need to be connected to an
Automation Engine, and open the file from the Automation Engine Job Folder. For easy locating the file
on the server, you can use File > Job Folder > Open from Job folder
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For more information on how to connect to Automation Engine, and on opening from a Job Folder, we
refer to the Esko DataExchange documentation. See http://help.esko.com/products/Esko%20Data
%20Exchange%20for%20Adobe%20Illustrator

5.8.2.  Connect Dynamic Barcodes to Job Setup

To use the Barcode properties from the Job Folder, enable the Get Properties from Job Setup.

When enabled, the icon on the right will indicate the status:

• Gray: the feature is disabled
• Green: the connection is established
• Red: the file is not in a Job Folder, or the connection is down.

5.8.3.  Use Barcode parameters from Job Setup

To use the barcode parameters from Job Setup, select a barcode type from the Barcode Type list that
is defined in the Job setup. You can recognize these barcode types by the green icon in front.
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As soon as you select one of the barcode types defined in the Job Setup, all parameters that are
defined in the job setup will be entered (and no longer be editable), indicated by the same green icon.
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In the example above, only the Code is defined in the Job Setup. All other parameters can be entered
freely.

5.8.4.  Updating barcode parameters from Job Setup

If a barcode is connected to the Job Setup, any changes to the barcode parameters in the Job Setup,
whether it is a changed parameter or a newly added parameter, will automatically and immediately be
taken into account in Dynamic Barcodes.

When opening a file, all barcodes with the Get Properties from Job Setup option enabled will be
updated automatically

If a barcode type is removed from the Job Setup, the corresponding barcodes in the job will no longer
be connected, so the Get Properties from Job Setup option is disabled.

A barcode will also be disconnected and the Get Properties from Job Setup option will be disabled
in case the barcode parameters in the Job Setup are invalid for the given barcode type. You will need
to change the parameters in the Job Setup. Note that after correcting the parameters, you need to
manually reconnect the barcode by enabling Get Properties from Job Setup.
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6.  Free Form Tables

6.1.  Introduction

Free Form Tables can be used for creation of tabular artwork - nutrition tables or other - according to
the table and data definition in the XML file.

The raw table can be freely re-arranged using the native Adobe Illustrator tools.

Its data content can be changed by the XML update, while maintaining your own table formatting. It can
also maintain the formatting after applying minor table geometry changes defined in the new XML.

6.2.  Free Form Table XML language

A Free From Table is created from XML files using a specific format.

The XML format used is a standard "GS1 XML Artwork Content Message", so it is the XML file used when
Dynamic Content is switched to GS1 mode.

The file consist of two parts:

• The standard GS1 part containing the nutrition content in the way GS1 describes the tables (using
structuredCopyElement)

• the Layout section describing the table layout

The Layout section part uses the specific name space egt. Its root node is egt:freeFormTables,
which is on the same level as the artworkContentStructuredCopyElement element, under the
artworkContentPieceOfArt element.

The Layout section can define multiple table layouts. The layouts are distinguished by their unique GS1
instanceSequence number. Each layout can also have its own ID.

6.2.1.  XML definition of the Layout section

Key Type Definition

artworkContentPieceOfArt The GS1 POA
container may contain
egt:freeFormTables
elements that define the
free form tables.

element egt:freeFormTables Array (Optional) A collection
of one or more table
definitions.
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egt:freeFormTables

element egt:generator Dictionary (Optional) A table layout
generator.

element egt:freeFormTable Dictionary (Optional) A table
definition.

egt:generator

element name String (Required) The generator
identifier

element version String (Optional) The generator
version identifier

egt:freeFormTable

attribute id String (Required) The name
of the table layout
definition.

element egt:sourceReference Dictionary (Required) A reference to
the table data, located
within the current
artworkContentPieceOfArt.

element egt:concatenationStrategyDictionary (Optional) The generic
concatenation strategy
in the table cells. It can
be locally overridden for
each table cell.

element egt:layout Dictionary (Required) The layout of
the table.

egt:sourceReference

element egt:structuredElementTypeNameString (Required) The name
of the structured
element containing
data. The value has to be
"FREE_FORM".

element egt:instanceSequence Integer (Required) The instance
sequence of the
structured element
containing data.

egt:concatenationStrategy

element egt:name String (Required) The name
of the concatenation
strategy.

element egt:delimiter String (Required) The delimiter
used to concatenate
data from multiple
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sources described by
egt:copyElementRef
into a single cell.

egt:layout

element egt:table Array (Required, at least 1
entry) The root of the
table layout definition.
A collection of table row
definitions.

egt:table

element egt:tr Array (Required, at least 1
entry) A definition of one
table row. A collection of
table cell definitions.

egt:tr

element egt:td Dictionary (Required) The definition
of one cell in the row.

The number of egt:td
elements shall be equal
in each eg:tr element,
unless the colspan
attribute is used.

egt:td

attribute colspan Integer (Optional) The definition
of the cell span range,
a positive integer. The
default value is 1.

This attribute defines
the number of table
cells over which this
eg:td element spans.
The sum of all values
(including the default
ones) of this attribute
over all eq:td elements
within a single eg:tr
element shall be the
same for all eg:tr
elements.

element egt:concatenationStrategyDictionary (Optional) The
concatenation strategy
for this table cell. The
value is inherited from

206



6Dynamic Content Essentials

egt:freeFormTable
when not specified.

The strategy is applied
to the whole egt:td
element.

element egt:copyElementRef Dictionary (Required, it can be
repeated) The definition
of the cell data content.
Each occurrence
contains one GS1 triplet
reference. If more than
one is present, the
content is delimited by
egt:delimiter.

egt:copyElementRef

element egt:copyElementTypeCodeString (Required) The copy
element type code of
the referred GS1 content
element.

element egt:instanceSequence Integer (Required) The instance
sequence number of the
referred GS1 content
element.

element egt:localeSequence Integer (Required) The locale
sequence number of the
referred GS1 content
element.

6.2.2.  Link between the data and the layout

The table cells defined by the Layout section refer to GS1 content elements using GS1 triplets, so a
combination of a copyElementTypeCode, instanceSequence and localeSequence element.

If the table cell refers to an element that doesn't exist, or if the referred content element doesn't
contain any data, no cell object is created.

The structuredCopyElement must contain the "FREE_FORM" in the structuredCopyElementTypeCode
element and the matching instanceSequence number to be connected with the freeFormTable
section.

6.2.3.  Namespace 'egt' and language versioning

The namespace definition is this:

xmlns:egt=http://ns.esko-graphics.com/egt/1.0/
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This also encodes the important information about the Layout section language version (in the
example it's "1.0"). This version number may change with newer generator versions and is compared
against the actual version supported by the plug-in. If it doesn't match, you will see a message. The file
can still be used, but the layout may look differently than intended, since the current plug-in version
may not understand the new features used to describe the table layout. In that case, the unknown
commands will be ignored.

6.3.  Creating a Free Form Table

The easiest way to create a Free Form Table, is to use the Dynamic Content palette in Smart View. In
that case, if no object is selected, the only listed records there will be the Free Form Tables. By clicking
the button next to the record, the table is created.

 

 

In Advanced View, you can get the Free Form Table Layout section by choosing Simplified view on
XML Shema - GS1-XML. The list of Layouts available in the XML file may look like this:
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In the example above, the Layout section of the XML contains two table layouts.
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To create the Free Form Table, select the freeFormTable element and click the Make Dynamic Object
button.

• If there is only one table layout, you can select the common freeFormTables element to create the
table

• Dynamic Art placeholders can't be used when creating a Free Form Table, and the Auto Link feature
has no effect on Free Form Tables.

The table is created using default formatting and in the center of the actual view.

• All cells are generated as text area objects.
• If a cell is defined using the colspan=x attribute, the cell object will span over multiple columns as a

single object.

• Default text style is used, with default color and formatting

• All cells are placed with a fixed 10 point spacing.
• Cells are created with a maximum of 3 lines
• The maximum column width is 100 points
• The cell width is set to the width of the widest cell in the column.
• The cell height for all cells in a row is set to the height of the cell with the highest number of lines
• The width of a cell with the "colspan" attribute is a sum of widths of all spanned cells.
• Cells with no content will not be generated
• If the cell definition refers to multiple data sources (concatenated elements), the cell size is not

affected and behaves as having a single source only.
• The table is generated as a group of all cell objects.
• The content can't be edited like other dynamic text objects, but the text area and the text

formatting can be modified using the normal Adobe Illustrator tools.
• Even though the cells indicate any text overflow, text threading is disabled to cell text objects.
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6.3.1.  Element Concatenation

According to the FFT XML definition, the Layout section can contain the concatenation definition.
This allows to define how multiple GS1 data elements will be joined together in a single Free Form Table
cell. The concatenation definition can be set for each Free Form Table, either globally for the whole
table, or per cell. The global settings are applied on cells within the current Free Form Table that don't
have a concatenation strategy defined.

Concatenation Strategy
The Free Form Table cell may refer to multiple GS1 data elements. The concatenation strategy defines
how those elements will be assembled together in the cell. Each layout language version understands a
fixed set of strategies (see Namespace 'egt' and language versioning on page 207).

• At this moment, only the DefaultOptimized strategy is supported, which puts elements one after
another with the delimiter (see below) in between.

• The Delimiter element defines the string, which will be used by the current strategy.
• If no concatenationStartegy is defined on cell level or on the global level, the elements are

concatenated without a delimiter.
• If the strategy name is not on the list of supported stategies, no concatenationStrategy is defined.

6.3.2.  Cell Protection

Inside the Free Form Table, the cell is protected against content changes.

When the cell is copied and pasted outside the FFT group, the text object loses its protection and
becomes editable.

When a cell is deleted from the Free Form Table, a warning message appears. During the next
synchronization of the XML content the cell will be regenerated within the Free Form Table as a new
cell.

6.4.  Updating a Free Form Table

After generating the Free Form Table, you can redesign the table

• You can resize cells
• You can reposition cells
• You can change the text style of the cells

In general, the intention is to keep the formatting after the XML update, either by updating the source
XML file or re-linking the file to another one.

When the cell text content is changed, the formatting is preserved as for other dynamic text.

When the table geometry is changed, the result depends on what changes were made:

1. The cell data assignment - the change of the reference within the cell definition in the Layout
section
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• If the GS1 triplet is already referred to by another cell, the formatting of that instance is copied
and applied to the new cell.

• If the GS1 triplet is newly used and is not yet referred to by another cell, the new text takes over
the existing formatting of the cell.

• If both of these changes happen to the existing cell, the cell size and position is not affected.
2. The table geometry changes: the number of rows or columns in the Layout section changes

• If the position of the new row or column can be detected, it will be added in between the others.
If it's not possible to find its place, the new row or column is added at the bottom or right side of
the table.

• The size of the added row or column is deducted from the existing table layout.
• If a newly created cell refers to data used by an existing cell in the table, the new cell takes the

formatting of the existing cell
• If a newly created cell refers to data that isn't used anywhere in the table yet, the cell takes over

the formatting of the closest cell (first the cell on its left, if nothing can be found there the cell
above, and so on clockwise).
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